


  

P E R E N C A N A A N 
STRUKTUR BANGUNAN INDUSTRI 

LENGKAP DENGAN CRANE



  

Sanksi Pelanggaran Hak Cipta
UNDANG-UNDANG REPUBLIK INDONESIA

NOMOR 28 TAHUN 2014 TENTANG HAK CIPTA

Ketentuan Pidana
Pasal 113
1) Setiap Orang yang dengan tanpa hak melakukan 

pelanggaran hak ekonomi sebagaimana dimaksud 
dalam Pasal 9 ayat (1) huruf i untuk Penggunaan 
Secara Komersial dipidana dengan pidana penjara 
paling lama 1 (satu) tahun dan/atau pidana denda 
paling banyak Rp100.000.000 (seratus juta rupiah). 

2) Setiap Orang yang dengan tanpa hak dan/atau tanpa 
izin Pencipta atau pemegang Hak Cipta melakukan 
pelanggaran hak ekonomi Pencipta sebagaimana 
dimaksud dalam Pasal 9 ayat (1) huruf c, huruf d, 
huruf f, dan/atau huruf h untuk Penggunaan Secara 
Komersial dipidana dengan pidana penjara paling 
lama 3 (tiga) tahun dan/atau pidana denda paling 
banyak Rp500.000.000,00 (lima ratus juta rupiah).

3) Setiap Orang yang dengan tanpa hak dan/atau tanpa 
izin Pencipta atau pemegang Hak Cipta melakukan 
pelanggaran hak ekonomi Pencipta sebagaimana 
dimaksud dalam Pasal 9 ayat (1) huruf a, huruf 
b, huruf e, dan/atau huruf g untuk Penggunaan 
Secara Komersial dipidana dengan pidana penjara 
paling lama 4 (empat) tahun dan/atau pidana 
denda paling banyak Rp1.000.000.000,00 (satu 
miliar rupiah).

4) Setiap Orang yang memenuhi unsur sebagaimana 
dimaksud pada ayat (3) yang dilakukan dalam 
bentuk pembajakan, dipidana dengan pidana 
penjara paling lama 10 (sepuluh) tahun dan/atau 
pidana denda paling banyak Rp4.000.000.000,00 
(empat miliar rupiah).



  

Diterbitkan oleh
PT. Nas Media Indonesia

Tahun 2023

P E R E N C A N A A N 
STRUKTUR BANGUNAN INDUSTRI 

LENGKAP DENGAN CRANE

Ir. Totok Andi Prasetyo, ST. M.T.
Naufal Yasir, S.T.



      
  

  

Copyright © T. A. Prasetyo, N. Yasir 2023
All rights reserved

Layout  : Risma Amanda Putri
Desain Cover  : Tim Penulis

Cetakan Pertama, Desember 2023

Diterbitkan oleh Penerbit Nasmedia
PT. Nas Media Indonesia
Anggota IKAPI
No. 018/SSL/2018
Jl. Sidorejo, Prambanan, Klaten 55584
Jl. Batua Raya No. 3, Makassar 90233
Telp. 0812-1313-3800
redaksi@nasmedia.id
www.nasmedia.id
Instagram: @nasmedia.id
Fanspage: nasmedia.id
Youtube: nasmedia entertainment

Ir. Totok Andi Prasetyo, S.T, M.T.
Naufal Yasir, S.T.

ISBN 978-623-155-404-8
E-ISBN 978-623-155-405-5 (PDF)

Perencanaan Struktur Bangunan Industri Lengkap dengan Crane

xxviii + 228 hlm; 15.5 x 21 cm



Perencanaan Struktur Bangunan Industri dengan Crane  v 

Puji syukur penyusun panjatkan kepada Tuhan Yang Maha Esa karena atas rahmat dan 

hidayah-Nya penulis dapat menyelesaikan buku yang berjudul ‘Perencanaan Struktur Bangunan 

Industri dengan Crane.’ Perkembangan industri yang masif di Indonesia perlu ditopang dengan 

infrastruktur penunjang industri yang memadai. Berbagai kawasan industri kini mulai dikembangkan 

untuk menciptakan kawasan industri yang terpusat dan terpadu. Pembangunan bangunan industri juga 

ikut mengalami perkembangan yang masif seiring digenjotnya berbagai sektor industri mulai dari 

manufaktur, garmen hingga otomotif. Atas dasar tersebut, maka diperlukan panduan praktis dalam 

perencanaan struktur bangunan industri. Tidak banyak buku teks berbahasa Indonesia yang 

membahas tahapan perencanaan struktur baja terutama untuk bangunan industri. 

Buku ini menjelaskan tahapan perencanaan struktur bangunan industri dengan tambahan 

beban crane menggunakan program ETABS. Berbagai tahapan desain mulai dari penentuan material, 

beban dan kombinasi beban, pemodelan struktur, hingga desain struktur diulas secara ringkas 

berdasarkan standar-standar yang berlaku. Penentuan beban mati, hidup, beban angin dan beban 

gempa juga diuraikan secara lengkap berdasarkan SNI 1726-2019 dan SNI 1727-2020. Proses 

perencanaan struktur runway beam crane juga diurai secara terperinci mulai dari penentuan beban 

roda maksimum hingga desain fatik. 

Penyusun menyadari bahwa buku yang disusun ini masih terdapat kekurangan. Oleh karena 

itu penyusun mengharapkan kritik dan saran yang sifatnya membangun. Akhir kata, penulis berharap 

agar buku yang telah penulis susun ini dapat bermanfaat dan berkontribusi aktif terhadap 

perkembangan ilmu pengetahuan khususnya pada bidang struktur baja. 

  

 

Bekasi, 07 Desember 2023 

 

Totok Andi Prasetyo 

Naufal Yasir 
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Bagian 2 yang menyajikan contoh penerapannya secara step-by-step 

dengan program ETABS sangat mengesankan saya. Bab ini sunguh 

amat berguna bagi para konsultan perancang struktur baja dan para 

mahasiswa teknik sipil yang perlu memahami dasar-dasar 

perancangan bangunan industri. 

Namun perlu dicatat bahwa sistem struktur bangunan industri yang 

nyata jauh lebih rumit dari segi bentuk, fungsi dan pembebanannya. 

Oleh karenanya, pembaca perlu mengembangkan sendiri secara hati-

hati sistem struktur nyata yang dihadapinya dengan berpedoman 

pada struktur ideal yang disajikan dalam buku ini. 

Akhir kata, selamat untuk Mas Totok dan tetaplah semangat untuk 

melanjutkan menulis buku-buku panduan teknik sipil. Good luck! 

Ir. Suradjin Sutjipto., M.T., - Ahli Teknik Bangunan Gedung 

Jenjang 9 (HAKI), Presiden Direktur Suradjin Sutjipto, Inc. (SSI), 

Dosen Jurusan Teknik Sipil FTSP Universitas Trisakti 

 

Dalam perkembangan dunia konstruksi saat ini dan perubahan code 

yang begitu cepat, tidaklah mudah untuk meluangkan waktu menulis 

sebuah buku panduan perencanaan. Buku seperti ini akan sangat 

membantu para mahasiswa dan juga praktisi dalam dunia konstruksi. 

Dr. Nathan Madutujuh, ESRC, Bandung 
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Saat ini terdapat beberapa buku mengenai struktur baja berbahasa 

Indonesia yang ditulis oleh akademisi dari berbagai perguruan 

tinggi, yang berisi aspek-aspek teoritis, perilaku, dan prosedur 

desain struktur baja. Walaupun begitu, belum ada buku struktur baja 

berbahasa Indonesia yang ditulis oleh seorang insinyur praktisi baja 

yang menceritakan bukan hanya teori tetapi praktek bagaimana 

desain struktur baja dilakukan. Oleh karena itu saya sebagai seorang 

akademisi menyambut buku ini dengan sangat senang karena 

memenuhi kekosongan tersebut. Saya yakin buku ini akan sangat 

bermanfaat bagi para praktisi, khususnya insinyur muda yang 

berprofesi sebagai structural engineer, dan bagi para akademisi, 

khususnya mahasiswa program studi teknik sipil yang sedang belajar 

desain struktur baja dan yang akan mengerjakan tugas besar 

(capstone design) berupa perencanaan bangunan baja, dan dosen-

dosen dalam bidang struktur baja. Apresiasi yang sebesar-besarnya 

kepada penulis buku ini karena di tengah kesibukannya sebagai 

seorang structural engineer dan pimpinan Perusahaan Konsultan 

TAP, masih menyempatkan waktunya untuk berbagi 

pengalamannya melalui penulisan buku ini. 

Wong Foek Tjong, S.T., M.T., Ph.D. - Dosen Desain Struktur Baja 

dan Peneliti dalam Bidang Metode Elemen Hingga, Universitas 

Kristen Petra, Surabaya 

 

Tidak banyak referensi mengenai bangunan industrial dengan 

konstruksi baja yang dilengkapi crane di Indonesia, terlebih lagi 

yang ditulis praktisi handal. Kami sangat yakin buku akan 

menambah pengetahuan dan kompetensi yang membantu para 

engineer muda di dalam dunia teknik sipil. Terima kasih kepada 

Penulis sudah berbagi ilmu dengan kami para praktisi bidang jasa 

konstruksi di Indonesia. Semoga Tuhan selalu memberkati Pak 

Totok Andi Prasetyo.  

Ir. Herman Sapar - Dosen Senior FTSP UNTAN, Pengurus DP 

HAKI dan Ketua LSP ASBSI, Ahli Teknik Bangunan Gedung 

Jenjang 9 (HAKI) 
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Buku seperti ini yang ditunggu-tunggu bagi para praktisi, khususnya 

praktisi untuk bangunan industri dengan crane. Hal ini akan 

memberikan kontribusi positif bagi dunia konstruksi baja di 

Indonesia. Penjelasannya sangat detail disertai dengan contoh dan 

dilengkapi tahapan-tahapan dalam software computer. Apresiasi 

yang setinggi-tingginya untuk penulis, di tengah kesibukan yang luar 

biasa, masih mau menyempatkan waktunya untuk berbagi dengan 

menulis buku yang lengkap dan detail seperti ini.  

Ir. Joni Irawan., M.T., - Ahli Teknik Bangunan Gedung Jenjang 9 

(HAKI). Dosen Senior Struktur Baja Politeknik Negeri Banjarmasin, 

Assesor LSP ASBSI HAKI, Tim Profesi Ahli (TPA) Kalimantan 

Selatan, Konsultan Struktur 

 

Di tengah kelangkaan literatur struktur baja, buku ini merupakan 

pelepas dahaga baru bagi mahasiswa, praktisi di bidang struktur 

baja.  Hal ini sangat menggembirakan, di mana saat ini kebutuhan 

bangunan industri meningkat pesat dengan berkembang pesatnya 

berbagai sektor industri di tanah air.  

Materi buku ini cukup lengkap yang dimulai dari pengantar tentang 

bangunan industri, kelebihan dan kekurangannya, jenis dan macam 

struktur Bangunan Industri.  Desain crane dalam buku ini, 

merupakan kelebihan dari buku ini.   

Nilai lebih lain dari buku ini adalah dengan diberikannya contoh 

analisis di dalamnya yang memudahkan para pembacanya untuk 

lebih memahami proses desain.  Pemberian standar yang digunakan 

dalam desain juga sangat membantu untuk mengetahui dari mana 

sumber parameter yang digunakan dalam menentukan nilai-nilai 

yang diambil. 

Kami menyambut baik karya ilmiah ini, yang dibuat oleh generasi 

muda dalam bidang struktur ini dengan membaktikan sebagian dari 

ilmunya yang spesifik dengan karyanya yang sangat berguna dalam 

pengembangan ilmu teknik sipil, khususnya struktur baja di tanah 

air. Kami berharapkan lebih banyak lagi mahasiswa dan praktisi 

yang akan berkarya di bidang ini. 

Ir. Sjafei Amri, Dipl. E.Eng. - Pendiri PT. Binanusa Pracetak & 

Rekayasa, Konsultan 
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Alhamdulillah Pak Ir. Totok Andi Prasetyo M.T., Subhanallah, luar 

biasa. Buku yang berjudul perencanaan bangunan industri dengan 

crane ini sangat bagus untuk menjadi salah satu referensi dalam 

analisis struktur baja khususnya dalam bangunan industri. Kemudian 

juga dapat menjadi bahan untuk meningkatkan kompetensi 

profesional sesuai SKKNI sebagai dasar kompetensi SKK Alhi 

Teknik Bangunan Gedung yang berlaku sesuai bidang nya.  

Selamat dan sukses untuk penulis atas terbitnya buku ini, semoga 

bertambah manfaat, ilmu, dan barrakah  

Aamiin ya robbal ' alamiiin. Salam semangat dan sukses. 

Ir. Moch Arif Toto.R, M- Eng, A-Ut, ACPE - Dosen STR SV 

UGM; Tim Profesi Ahli (TPA) Kota Yogyakarta; Kabid Keuangan 

dan Asesor LSP ASBSI; Koord. Bid. Anggota DPP HAKI; Pengurus 

Komda HAKI Yogyakarta; Konsultan Struktur 

 

Buku Perencanaan Struktur Bangunan Industri dengan Crane akan 

sangat bermanfaat bagi praktisi dan akademisi bagi perencana di 

bidang struktur. Buku ini juga dapat menjadi literatur bagi 

mahasiswa yang tertarik menggeluti bidang struktur baja, khususnya 

bangunan industri. Sebuah penghargaan bagi penulis yang telah 

menyempatkan untuk menulis buku ini. Semoga buku Perencanaan 

Struktur Bangunan Industri dengan Crane dapat menambah 

khazanah pengetahuan di bidang teknik sipil. 

Ir. Ismono Kusmaryono, S.T., M.T., - Kaprodi Teknik Sipil 

Institut Sains dan Teknologi Nasional (ISTN) Jakarta 

 

Buku “Perencanaan Struktur Bangunan Industri dengan Crane” ini 

bisa menjadi referensi bagi para perencana struktur bangunan 

industri, yang memang sangat jarang kita temukan referensinya. Isi 

buku ini cukup lengkap dan terinci dengan baik. Semoga bisa turut 

melengkapi buku-buku teknik sipil berbahasa Indonesia, teristimewa 

yang membahas tentang struktur baja. Saya merekomendasikan 

buku ini untuk dimiliki dan dipelajari para praktisi dan mahasiswa 

Teknik Sipil. Untuk penulis, tetap berkarya dan tetap bersemangat, 

selalu siap berbagi ilmu kepada siapa pun juga yang membutuhkan, 

sebagai bagian dari amal ibadah. Amin.  

Ir. Willy Wungo - Ahli Teknik Bangunan Gedung Jenjang 9 

(HAKI), Direktur PT. Tribuana Bhirawa Yudha 
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Buku ini adalah paket komplit yang isinya sangat bermanfaat bagi 

para praktisi dan akademisi dalam bidang perencanaan struktur baja, 

terutama bangunan industri. Buku ini juga sangat dinantikan bagi 

para structural engineer Indonesia, karena saat ini masih jarang 

sekali buku perencanaan struktur baja yang ada di Indonesia. 

Semoga buku ini bisa menginspirasi para Insinyur Indonesia untuk 

semakin memajukan industri konstruksi baja di Indonesia. 

Ir. Faishol Arif, S.T., M.T., - Ahli Teknik Bangunan Gedung 

Jenjang 9 (HAKI), Dosen Senior Universitas Pakuan Bogor, 

Anggota Tim Profesi Ahli DKI Jakarta 

 

Selamat atas terbitnya buku Perencanaan Struktur Bangunan 

Industri dengan Crane. Tidak banyak literatur mengenai bangunan 

warehouse di Indonesia, terlebih lagi dari praktisi handal. Kami 

sangat yakin buku akan menambah pengetahuan dan membantu 

para engineer muda di dalam dunia teknik sipil. Terima kasih Pak 

Totok sudah berbagi ilmu dengan kami. Semoga Tuhan selalu 

memberkati Bapak. Kami tunggu karya Bapak selanjutnya. 

Ir. Christ Kendro - Design Manager PT. Tatamulia Indah 

Nusantara 

 

 

Apresiasi kepada penulis yang telah menyusun buku ini. Masih 

sedikit buku literatur baja dengan spesifik bangunan tertentu. Bila 

sudah selesai, buku ini bermanfaat dan diperlukan sekali untuk 

menambah dan melengkapi referensi bagi para praktis dalam 

merancang struktur bangunan di industri dengan crane. Tetap 

Semangat, semoga bisa menjadi amal jariah penulis yang tiada 

henti. 

Ir. Budi Antara – Kabid Mutu LSP ASBSI HAKI, Assesor LSP 

ASBSI HAKI, Ahli Teknik Bangunan Jenjang 9, Konsultan 

Struktur 
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Pertama-tama saya sangat mengapresiasi penulis buku ini yang 

telah bersedia membagikan ilmu dan pengetahuan konstruksi baja 

industri dengan alat crane yang sangat berguna bagi para praktisi 

umumnya dilapangan dan mahasiswa khususnya dalam mencari 

referensi konstruksi baja untuk menyelesaikan  tugas-tugasnya di 

kampus, dimana hal tersebut masih sedikit keberadaannya. Sekali 

lagi saya apresiasi untuk Pak Ir. Totok Andi Prasetyo, MT. 

Buku ini memberikan pula contoh konkret yg sangat aktual jadi 

dapat menjadi salah satu pedoman atau handbook.Terima kasih. 

KRAT RM Endro Gijanto R., Ir., IPU, SH Med., MBA, MM 

• Asesor LSP ASBSI 

• Wakil Ketua HAKI Jawa Tengah 

• Ahli Teknik Bangunan Gedung Jenjang 9 

• Ahli Teknik Jembatan Jenjang 9 

• Pengurus HATTI Jawa Tengah 

• Anggota PII 

• SKIP PII Ahli Madya 

• Member of American Concrete Institute 

• Konsultan Struktur 

• Konsultan Pengawas 

• Tim Profesi Ahli Kota Semarang   (2022) 

• Staf Pengajar Unika  

Soegijapranata(1981-2020) 

 

Berbeda dengan buku struktur baja pada umumnya ini adalah buku 

yang ditulis dengan langgam bahasa praktisi oleh praktisi untuk 

praktisi. 

Buku ini sangat layak dikoleksi. 

Ir. Effendy Johan. M.T. - Ahli Tenik Bangunan Gedung Jenjang 

9, Direktur PT. Perentjana Djaja 
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BAGIAN   

A. PENGENALAN BANGUNAN INDUSTRI 

Bangunan industrial mulai mengalami perkembangan seiring dengan perkembangan 

ekonomi di Indonesia. Proses percepatan investasi dalam negeri yang terus didorong membuat 

berbagai macam sektor industri semakin maju. Perusahaan-perusahaan ternama dunia mulai 

melebarkan sayap industrinya di Indonesia. Hal tersebut tentu perlu ditopang dengan kondisi 

operasional perusahaan yang mumpuni. Dari situlah kemudian sebagian besar perusahaan mulai 

mendirikan bangunan industrial baik untuk proses produksi, manufaktur ataupun penyimpanan 

biasa. 

Bangunan industrial merupakan bangunan dengan komponen arsitektural dan struktural 

yang relatif sederhana dibandingkan dengan tipe bangunan lain seperti, perhotelan, perkantoran 

dan lain sebagainya, yang tentu lebih mementingkan aspek estetika. Bangunan industrial lebih 

mengutamakan fungsi bangunan sebagai penunjang proses produksi dan operasional.  

Umumnya bangunan industrial dibangun menggunakan material baja sebagai struktur 

utama. Struktur baja dapat menciptakan ruang luas terbuka yang efisien yang dibutuhkan oleh 

sebagian besar bangunan industrial. Biasanya struktur baja dipilih atas alasan keberlanjutan, di 

mana apabila terdapat rencana pengembangan bangunan, struktur baja dapat dengan mudah 

beradaptasi. Namun tidak menutup kemungkinan bahwa bangunan industri dibangun dengan 

kombinasi beberapa material lain seperti struktur beton bertulang, dan struktur baja canai 

dingin. 

Dengan fungsi sebagai bangunan penunjang proses produksi dan operasional, biasanya 

bangunan industrial dibangun dengan skala luasan yang besar. Atas dasar itulah, proses 

perancangan bangunan industrial sangat dipengaruhi oleh biaya yang efisien. Bangunan 

industrial juga dibangun dengan biaya operasional yang minimum dengan tingkat keberlajutan 

yang tinggi untuk mengurangi konsumsi energi yang berdampak pada biaya operasional 

bangunan. 

Berdasarkan apa yang dirangkum oleh Newman (2004), bangunan industri pertama 

yang berdiri adalah Ditherington Flax Mill yang dibangun di Inggris pada Tahun 1796. 

Bangunan ini terdiri dari kolom-kolom logam yang didirkan untuk menggantikan material kayu 

yang biasa digunakan di Inggris. Ide untuk membangunan fasilitas manufaktur terbangun 

karena banyaknya bangunan pabrik kapas yang terbakar karena menggunakan material kayu. 

Begitu sifat tahan api pada material logam ditemukan, perkembangan bangunan industri dengan 

material logam mulai jamak digunakan di dataran Britania Raya. 

1 
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Gambar 1.1. Contoh Struktur Bangunan Industri dengan Crane 

(Sumber: Dokumentasi Pribadi) 

Bangunan industri yang didesain dengan struktur baja memiliki beberapa kelebihan, 

antara lain sebagai berikut; 

- Struktur baja mampu mengakomodir bentang yang cukup panjang. Struktur rangka 

payon (gable frame) dapat mencapai bentang hingga 30 m. Kemampuan untuk 

memberikan bentang yang panjang menjadikan struktur baja sebagai material yang 

ekonomis untuk digunakan pada bangunan industri 

- Pengerjaan struktur baja untuk bangunan industri relatif cepat. Dengan elemen-elemen 

yang sudah difabrikasi di workshop, proses instalasi struktur baja di lapangan jadi lebih 

cepat. Dari beberapa referensi, proses pekerjaan bangunan industri yang dibangun 

dengan struktur baja memakan durasi yang tiga kali lebih cepat ketimbang dengan 

material lain. 

- Efisiensi biaya. Dengan sistem prafabrikasi di workshop yang menghasilkan durasi 

pekerjaan yang lebih cepat, kebutuhan jumlah pekerja dapat menjadi lebih sedikit 

sehingga biaya upah pekerja dapat dipangkas. Selain itu, sistem prafabrikasi yang 

presisi dapat menghasilkan produk yang minim cacat sehingga waste dapat 

diminimalisir. 

- Kemudahan pengembangan. Bangunan industri seringkali dibangun dalam beberapa 

fase. Dengan struktur baja, penambahan massa bangunan akan mudah dilaksanakan 

karena proses pembongkaran bangunan eksisting dapat dilakukan secara mudah. Selain 

itu, struktur baja eksisting juga dapat digunakan kembali untuk bangunan baru. 

- Proses pemeliharaan yang ringan. Pada tipikal bangunan industri yang menggunakan 

atap metal sheet yang mudah dirawat, biaya operasional untuk pemeliharaan yang 

dikeluarkan dapat lebih sedikit. Selain itu biaya pemeliharaan untuk struktur juga tidak 

relatif besar, apalagi untuk struktur baja yang telah dilapisi dengan lapisan anti korosi. 

- Proses konstruksi bangunan industri umumnya tidak terlalu rumit dan membutuhkan 

banyak stakeholder sehingga tidak membutuhkan terlalu banyak vendor. Stakeholder 

yang tidak terlalu banyak membuat owner akan dengan mudah melacak 

pertanggungjawaban dari produk konstruksi yang dihasilkan oleh masing-masing 



Perencanaan Struktur Bangunan Industri dengan Crane  3 

stakeholder. Selain itu, apabila terjadi masalah maupun saat masa perawatan, owner 

juga akan mudah untuk meminta penjelasan kepada stakeholder terkait. 

1. Komponen-komponen pada Bangunan Industri 

Elemen paling mendasar yang jamak digunakan pada bangunan industri terdiri 

dari kolom dan balok. Sistem mendasar ini kemudian dimodifikasi dengan cara-cara 

tertentu untuk menghasilkan struktur yang efisien. Tipe struktur yang paling sering 

digunakan adalah portal frame baik yang bertipe gable frame maupun monoslope. 

Sistem struktur ini memiliki stabilitas searah bidang yang cukup. Namun stabilitas pada 

arah luar bidang perlu diantisipasi dengan bantuan bracing. Dalam suatu bangunan 

industri semua komponen bersatu menjadi satu komponen yang membentuk suatu 

sistem utuh. Terdapat beberapa komponen yang hampir selalu ada pada bangunan 

industri seperti rangka utama, purlin, girts, bracings, nok atap, dan kolom post. Pada 

gambar di bawah disajikan secara lengkap gambaran bagaimana komponen bangunan 

industri membentuk suatu sistem yang utuh. 

 

Gambar 1.2. Komponen pada Bangunan Industri 

(Sumber: Newman, 2003) 

 

2. Struktur Utama (Main Frame) 

Di Indonesia, bangunan industri sangat jamak menggunkan sistem struktur 

portal karena alasan efisiensi dan kemudahan fungsi. Berbagai jenis tipe portal dapat 

didesain dengan sistem utama yang hampir serupa, bisa berbentuk gable frame, curved 

frame, gable frame dua bentang dan lain sebagainya. Struktur portal menyediakan ruang 

dengan bentang yang lebar yang akan memudahkan proses operasional dari bangunan 

industri. Umumnya sistem struktur portal ini didesain dengan profil wide flange dari 

baja canai panas, dengan variasi profil baja canai dingin sebagai secondary framing 

(purlin, girts, dan lain sebagainya). Di Eropa dan juga beberapa proyek di Indonesia, 
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sistem struktur portal dikembangkan menggunakan variasi profil lain seperti, 

honeycomb dan cellular beam. Tentu pemilihan profil yang digunakan menyesuaikan 

kebutuhan serta pembebanan yang ada. Sistem struktur portal cocok digunakan untuk 

bentang sedang 25-40 m. 

Selain struktur portal, sistem lain yang sering digunakan sebagai struktur utama 

bangunan industri adalah sistem truss 2d. Sistem ini dapat dibentuk dengan 

menggunakan profil T, wide flange, pipa, atau kanal. Dua di antara sistem struktur truss 

untuk atap yang paling sering digunakan adalah truss tipe W dan tipe N. Design Guide 

7: Design for Industrial Building, memberikan rekomendasi konfigurasi truss yang 

ekonomis untuk digunakan. Untuk tinggi truss kurang dari 1,5 m direkomendasikan 

menggunakan truss tipe N, sementara untuk tinggi truss di atas 1,5 m direkomendasikan 

menggunakan truss tipe W. Selain itu penggunaan profil T juga lebih ekonomis karena 

dapat mengeliminasi penggunaan gusset untuk batang vertikal dan diaogonal. Sebagai 

acuan awal, umumnya rasio tinggi truss terhadap bentang diambil sekitar 1/15 hingga 

1/20 karena dapat menghasilkan struktur yang ekonomis. Sistem struktur rangka atap 

truss dapat dikombinasikan baik dengan kolom baja biasa, kolom baja truss, maupun 

kolom beton. Semuanya tentu dengan pertimbangan biaya yang dapat diakomodir oleh 

owner. 

 

Gambar 1.3. Rekomendasi Konfigurasi Truss untuk Atap 

(Sumber: Design Guide 7 AISC: Industrial Building Design, 2019) 

 

  Sistem struktur lain yang bisa digunakan untuk bangunan industri dengan 

bentang yang ekstra lebar adalah sistem struktur suspended. Struktur ini ditopang 

dengan batang-batang tarik dari struktur kabel. Struktur tersuspensi dapat dirancang 

dengan memperpanjang kolom di luar gedung untuk penyangga batang tarik. Contoh 

penggunaan struktur tersuspensi di Indonesia ada pada Terminal Induk Pulogebang. 
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Gambar 1.4. Contoh Sistem Struktur Suspended (Terminal Pulogebang) 

3. Struktur Pendukung (Secondary Frame) 

Sistem struktur pendukung pada bangunan industri terdiri dari purlin dan girts. 

Purlin pada bangunan industri dapat didesain baik menggunakan baja canai panas dan 

baja canai dingin. Purlin yang berasar dari baja canai dingin biasa dibuat dari profil C 

dan Z. Purlin dengan tinggi profil 20 hingga 30 kaki dapat mengakomodir bentang 7,5 

hingga 9 m. Purlin dengan profil C atau Z normalnya terbuat dari baja mutu tinggi 

seperti ASTM A 570 atau A 607. Sementara untuk purlin yang berasan dari baja canai 

panas bisa dibuat dari profil CNP, box CNP, Square Hollow Section, maupun 

Rectangular Hollow Section. 

 

Gambar 1.5. Profil Baja Canai Dingin C dan Z untuk Purlin 

(Sumber: Newman, 2003) 

 

Koneksi antara purlin dengan rafter dapat dibuat secara menerus (continious) 

maupun tertumpu secara sederhanna (simply supported beam). Untuk membuat purlin 
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dengan sistem menerus, dibutuhkan lap splice yang lebih panjang, umumnya sekitar 120 

cm untuk purlin di bentang pertama dan 60 cm untuk purlin pada bentang yang lain. 

Sementara untuk purlin yang tertumpu sederhana hanya dibutuhkan 10 cm lap splice. 

 

Gambar 1.6. Koneksi Antara Purlin ke Rafter 

(Sumber: Newman, 2003) 

 

Sementara itu, bagian lain yang merupakan rangka sekunder pada bangunan 

industri adalah girt. Girt bisa digunakan dari profil baja canai dingin seperti profil C dan 

Z, juga bisa digunakan dari profil baja canai panas seperti profil kanal. Belakangan, 

profil hollow square section juga mulai banyak digunakan sebagai girt untuk 

mengeliminasi bracing eksternal yang menghubungkan girt dengan rangka kolom. 

Profil baja canai dingin dapat digunakan apabila faktor ekomomi menjadi pertimbangan. 

Girt dari profil baja canai dingin biasanya tidak membutuhkan sag rod tambahan. 

Dinding metal juga dapat dihubungkan dengan girt dengan screw yang relatif murah. 

Sementara, profil baja canai panas digunakan sebagai struktur girt apabila lingkungan 

sekitar lokasi rawan mengakibatkan korosi. Selain itu, untuk sistem dinding tertentu 

yang berat, girt harus didesain dengan baja canai dingin yang relatif lebih kuat. 

Proses desain struktur girt dapat dilakukan dengan beberapa tahapan sebagai 

berikut: 

- Dimensi girt ditentukan berdasarkan beban eksternal baik dari berat sendiri dinding 

atau beban angin 

- Tentukan kebutuhan sag rod berdasarkan kriteria defleksi dan tegangan momen di 

sumbu lemah girt 

- Periksa beban internal hisap pada girt berdasarkan Spesifikasi AISC Bab F 

- Jika dimensi girt tidak cukup kuat, tingkatkan dimensi girt atau tambahkan sag rod 

- Cek kriteria kemampulayanan girt 

- Cek kapasitas sag rod untuk menahan puntir akibat beban hisap. 
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B. STANDAR DAN PERATURAN YANG DIGUNAKAN 

Dalam perencanaan struktur bangunan industri, standar dan peraturan yang jamak 

diadopsi antara lain sebagai berikut: 

- Tata cara Perencanaan Ketahanan Gempa untuk Struktur Bangunan Gedung dan Non 

Gedung, SNI 1726-2019  

- Beban Minimium untuk Perancangan Bangunan Gedung dan Struktur Lain, SNI 1727-

2020 

- Spesifikasi untuk Bangunan Gedung Baja Struktural, SNI 1729-2020 

- Persyaratan Beton Struktural untuk Bangunan Gedung dan Penjelasan, SNI 2847-2019 

- Building Code Requirements for Structural Concrete, ACI 318-14 

- Minimum Design Loads and Associated Criteria for Buildings and Other Structures, ASCE 

7-16 

- Specification for Structural Steel Buildings, AISC 360-16 

C. ALUR BEBAN PADA STRUKTUR BANGUNAN INDUSTRI 

Pemahaman mengenai proses alur beban pada suatu struktur menjadi sesuatu yang 

fundamental. Semua elemen struktur yang didesain perlu memiliki kekuatan yang cukup untuk 

mengakomodir beban yang ada. Beban dapat bekerja baik secara gravitasi maupun secara 

lateral. Pada struktur baja beban lain yang perlu dipertimbangkan adalah ekspansi termal.  

Pada bangunan industri alur beban umumnya dimulai dari atap. Atap akan menahan 

beban vertikal yang terdiri dari berat sendiri struktur, beban mati tambahan pada atap, beban 

hujan, serta beban hidup untuk proses perawatan bangunan. Dalam perkembangan yang ada, 

atap pada bangunan industri juga mulai didesain untuk menahan solar panel sehingga beban-

beban tambahan seperti walkway perlu dipertimbangkan. Beban lain yang bekerja pada atap 

adalah beban angin. Pada atap dengan sudut yang tidak besar, umumnya terjadi angin hisap 

yang mengakibatkan gaya angkat pada atap. Di kawasan yang berpotensi mengalami risiko 

tekanan angin yang tinggi, atap perlu didesain dengan kekuatan yang memadai. 

 

Gambar 1.7. Beban yang Terjadi pada Bangunan Industri 

 

Selain bekerja pada atap, beban angin juga bekerja pada kolom sebagai bagian dari 

portal penahan gaya utama. Besaran bebannya variatif dan bergantung pada kecepatan angin 

serta konfigurasi bangunan. Beban angin perlu ditinjau baik yang datang dari arah transversal 
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maupun longitudinal. Beban angin yang datang pada arah transversal akan ditahan oleh struktur 

portal yang kokoh, namun beban angin pada arah longitudinal akan menerpa sumbu lemah 

bangunan. Bangunan industri umumnya memiliki stabilitas lateral pada arah longitudinal yang 

rendah sehingga apabila dikenai beban angin rawan terjadi keruntuhan. Atas dasar tersebut, 

penggunaan X-bracing direkomendasikan untuk menambah kekuatan di sumbu lemah 

bangunan. 

Selain beban angin, beban horizontal lain yang bekerja pada struktur bangunan industri 

adalah beban gempa. Pada arah transversal beban gempa akan ditahan oleh portal rangka yang 

terdiri dari kolom dan rafter. Sementara pada arah longitudinal beban gempa akan ditahan oleh 

sistem rangka dengan tambahan X-bracing. Sistem penahan gaya lateral yang jamak digunakan 

pada struktur bangunan industri adalah sistem rangka pemikul momen biasa pada arah 

transversal dan sistem rangka dengan breising konsentris biasa pada arah longitudinal. 

 

Gambar 1.8. Beban Horizontal yang Terjadi pada Portal Utama 

(Sumber: Newman, 2003) 

 

Pada struktur bangunan industri yang didesain dengan beban crane, beban lateral akibat 

roda juga perlu dipertimbangkan. Beban lateral tersebut akan ditahan oleh runway beam dan 

dibantu dengan backing truss untuk mengantisipasi lendutan horizontal pada runway serta 

buckling di bagian top flange. Beban lateral ini ditransfer ke kolom melelalui backing truss atau 

tambatan lateral setempat di setiap kolom yang menopang runway beam. Selain beban lateral, 

crane juga memberikan beban gravitasi yang cukup besar pada bangunan. Beban angkat crane 

serta berat sendiri girder crane plus trolley dan hoist perlu dipertimbangkan dengan matang. 

Runway beam crane perlu didesain dengan inersia sumbu kuat yang besar untuk mengantisipasi 

lendutan vertikal akibat beban angkat dan berat sendiri crane. 

Beban lain yang perlu dipertimbangkan adalah beban dinding. Pada bangunan industri 

beban dinding akan ditopang oleh girt yang merangka pada kolom-kolom bangunan. Girt juga 

perlu didesain kuat menahan tekanan akibat beban angin horizontal yang didesain berdasarkan 

beban angin untuk komponen dan klading. Desain untuk struktur girt dapat dilakukan secara 

terpisah dari model struktur utama bangunan namun bebannya harus tetap dipertimbangkan 

karena akan berpengaruh pada perhitungan massa gempa efektif. 
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Gambar 1.9. Tipikal Bangunan Industri dengan X-bracing pada Sumbu Lemah Bangunan 

(Sumber: Newman, 2003) 

 

D. PENGENALAN SISTEM CRANE 

Pada bangunan industri, crane menjadi instrumen yang jamak digunakan untuk 

memindahkan suatu barang dari satu tempat ke tempat yang lain. Crane menjadi solusi yang 

efisien mengingat sebagai peralatan yang digunakan pada proses industri sangat berat dan tidak 

memungkinkan untuk diangkat secara mekanik dengan bantuan forklift. Umumnya suatu crane 

merupakan gabungan dari beberapa elemen mekanik yang digabung menjadi satu kesatuan. 

Beberapa elemen crane dapat dilihat sebagaimana gambar di bawah. 

 

Gambar 1.10. Komponen-komponen Overhead Crane 

(Sumber: Demag Standard Cranes) 

Umumnya crane yang digunakan pada bangunan industri terdapat 4 jenis yaitu: single-

girder crane dengan single I-girder, single-girder crane dengan box steel girder, suspension 
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cranes, dan double-girder crane dengan box steel girder. Masing-masing jenis crane tersebut 

diperuntukan sesuai jenis beban yang dapat diangkat. Beberapa data teknis terkait safe working 

load, bentang crane serta kecepatan crane dari masing-masing jenis crane dapat dilihat pada 

tabel sebagai berikut. 

Tabel 1.1. 

Tipikal Jenis Crane dengan Spesifikasinya 

Tipe crane 
Kapasitas 

Bentang 

Crane 

Kecepatan 

crane pada 

arah 

memanjang 

Kecepatan 

hoist pada 

arah 

melintang 

Kecepatan 

lifting 

ton m m/min m/min m/min 

Single-girder cranes 

with box section 

girders 

12,5 30 40 30 12,5 

Single-girder cranes 

with rolled I-beam 

girder 

12,5 18 40 30 12,5 

Suspension cranes 8 25 40 30 12,5 

Double-girder 

cranes with box 

section girders 

50 35 40 30 12,5 

(Sumber: Demag Standard Cranes) 

Penjelasan dari masing-masing tipe girder crane adalah sebagai berikut: 

- Single-girder Crane dengan Box Steel Girder 

Single-girder crane dengan box steel girder cocok dipilih untuk mengakomodir beban 

angkat yang cukup tinggi dengan bentang yang besar. Crane jenis ini memiliki tingkat 

kekauan yang tinggi dengan inersia dari box steel girder yang tinggi. 

- Single-girder Crane dengan Single I-girder 

Single-girder crane dengan single I-girder merupakan pilihan tipe crane dengan tingkat 

keekonomisan paling tinggi. Bangunan industri yang membutuhkan crane dengan 

kapasitas angkut yang relatif ringan dengan bentang yang tidak terlalu lebar cocok 

menggunakan crane dengan tipe single-girder crane dengan single I-girder.  

- Suspension Cranes 

Suspension cranes merupakan crane yang dapat dipasang pada struktur atap eksisting 

yang kokoh tanpa memerlukan struktur penopang tambahan seperti kolom baru. Crane 

berjenis ini sangat ekonomis karena tidak memerlukan kolom tambahan. Namun 

suspension crane hanya dapat mengangkut beban angkut dengan kapasitas kecil sekitar 8 

ton.  

- Double Girder Crane dengan Box Steel Girder 

Double girder crane dengan box section girder merupakan tipe crane yang dapat dipilih 

untuk beban angkut dengan kapasitas yang besar dan bentang yang lebar. Crane berjenis 

ini biasa digunakan untuk mengangkat mesin-mesin besar pada bangunan industri. 
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Gambar 1.11. Berbagai Tipe Overhead Crane 

(Sumber: Demag Standard Cranes) 

1. Klasifikasi Crane Menurut AIST TR-13 dan CMAA 

Umumnya crane diklasifikasikan berdasarkan jumlah repetisi beban serta siklus 

beban selama masa layan bangunan. Klasifikasi ini dibutuhkan untuk menentukan kriteria 

struktur penunjang yang dapat menopang struktur crane dengan beban angkut tertentu.  

Ketetapan mengenai klasifikasi crane tercantum pada Guide for the Design and 

Construction of Mill Buildings, AIST TR-13 serta Top Running Bridge and Gantry Type 

Multiple Girder Electric Overhead Crane Traveling Cranes – No. 70 (CMAA). 

AIST TR-13 mengklasifikasikan bangunan dengan overhead crane menjadi 4 kelas 

sebagai berikut: 

- Bangunan dengan Kelas A merupakan bangunan yang mana dapat mengalami 500.000 

hingga 2.000.000 repetisi beban atau lebih dari 2.000.000 repitisi beban dalam perkiraan 

masa layan bangunan sekitar 50 tahun.  

- Bangunan dengan Kelas B merupakan bangunan yang mana dapat mengalami repetisi 

beban 100.000 hingga 500.000 dengan siklus pembebanan tertentu atau 5 hingga 25 

repetisi beban per hari selama masa layan bangunan kurang lebih 50 tahun. 

- Bangunan dengan Kelas C adalah bangunan yang mana dapat mengalami repetisi beban 

20.000 hingga 100.000 dengan siklus pembebanan tertentu selama perkiraan umur suatu 

struktur, atau satu sampai lima kali repetisi beban per hari selama masa layan bangunan 

sekitar 50 tahun. 

- Bangunan dengan Kelas D adalah bangunan yang mana tidak mengalami lebih dari 

20.000 repetisi beban tertentu selama umur yang diharapkan dari suatu struktur. 

Sementara itu CMAA, mengklasifikasikan bangunan dengan crane menjadi 6 tipe 

berdasarkan kondisi layanan yang diberikan. Masing-masing kondisi dipaparkan secara 

ringkas sebagai berikut: 
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- Kelas A (Kondisi Layanan Tidak Menentu) 

Kelas layanan dengan tipe ini membutuhkan crane yang digunakan pada waktu tertentu 

saja bilamana dibutuhkan. Kondisi layanan Kelas A biasa digunakan pada powerhouse, 

tempat publik, ruang turbin dan tempat-tempat lain di mana waktu operasional 

pengangkatan sangat jarang.  

- Kelas B (Layanan Ringan) 

Kelas layanan dengan tipe ini membutuhkan crane untuk operasi pengangkatan yang 

relatif ringan. Kondisi layanan Kelas B biasa digunakan pada warehouse skala kecil di 

mana kebutuhan layanan pengangkatan dengan crane relatif ringan dengan kecepatan 

yang lambat. Rata-rata kondisi layanan Kelas B melayani 2 hingga 5 pengangkatan per 

jam. 

- Kelas C (Layanan Sedang) 

Kelas layanan dengan tipe ini biasa digunakan untuk melayani kondisi pengangkatan 

yang relatif sedang baik secara frekuensi maupun beban. Kondisi layanan Kelas C rata-

rata mengangkat beban 50% dari kapasitas angkat maksimum yang tersedia dengan rata-

rata jumlah pengangkatan 5 hingga 10 kali per jam. 

- Kelas D (Layanan Berat) 

Kondisi layanan dengan tipe ini biasa digunakan untuk melayani kondisi pengangkatan 

yang relatif berat baik secara frekuensi maupun beban. Kondisi layanan Kelas D 

melayani tipe bangunan yang membutuhkan layanan pengangkatan yang sering dengan 

beban yang berat seperti bengkel mesin, pengecoran logam, pabrik fabrikasi, gudang 

baja, tempat penyimpanan kontainer, pabrik kayu, dan lain sebagainya. Crane pada 

kelas layanan ini melayani rata-rata beban pengangkatan yang mendekati 50% dari 

kapasitas maksimum yang tersedia secara konstan. Kecepatan pengangkatan yang tinggi 

dibutuhkan pada kondisi layanan Kelas D dengan rata-rata pengangkatan 10 hingga 20 

kali per jam. Beban pengangkatan tidak lebih dari 65% dari kapasitas pengangkatan 

crane yang tersedia. 

- Kelas E  

Crane dengan tipe ini melayani kondisi pengangkatan dengan beban angkat yang 

hampir mendekati kapasitas mamsimumnya. Crane Kelas E rata-rata mampu 

melakukan lebih dari 20 kali pengangkatan per jam atau mendekati kapasitas 

maksimumnya. 

- Kelas F 

Kondisi layanan kelas F memerlukan crane yang mampu melakukan pangangkatan 

dengan beban yang mendekati kapasitas maksimumnya secara terus menerus selama 

masa pakainya. Crane pada kelas layanan ini perlu menyediakan tingkat keandalan yang 

tinggi dengan kemudahan perawatan operasional. 

Klasifikasi layanan kelas crane menurut CMAA dahulu dapat dikorelasikan 

langsung dengan siklus pembebanan selama masa layanan bangunan berdasarkan AISC 

1989 yang berguna untuk analisis fatik. Meskipun pada peraturan AISC yang terbaru, 

klasifikasi layanan kelas crane versi CMAA tidak lagi berlaku, tabel korelasi tersebut 

masih bisa digunakan sebagai acuan awal apabila rencana siklus pembebanan selama masa 

layan bangunan belum didapatkan. Tabel korelasi tersebut dapat dilihat sebagai berikut. 
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Tabel 1.2. 

Korelasi Kelas Layanan Crane CMAA dengan Spesifikasi Kondisi Pembebanan Menurut 

AISC 1989 

Klasifikasi Crane 

Menurut CMAA 

1989 AISC Specification 

Loading Condition 

Loading Cycles 

Dari Hingga 

A, B 1 20.000a 100.000b 

C, D 2 100000 500.000c 

E 3 500.000 2000.000d 

F 4 Di atas 2.000.000 

a-Kurang lebih setara dengan 2 kali penggunaan crane setiap hari dalam 25 tahun 

b-Kurang lebih setara dengan 10 kali penggunaan crane setiap hari dalam 25 tahun 

c-Kurang lebih setara dengan 50 kali penggunaan crane setiap hari dalam 25 tahun 

d-Kurang lebih setara dengan 200 kali penggunaan crane setiap hari dalam 25 tahun 

(Sumber: Design Guide 7 AISC: Industrial Building Design, 2019) 

E. BEBAN-BEBAN PADA STRUKTUR 

1. Beban Mati (Dead Load dan Collateral Load) 

Beban mati merupakan beban yang merepresentasikan berat sendiri struktur dan 

komponen penunjangnya. Dalam suatu bangunan industri, biasanya beban mati juga terdiri 

dari beban peralatan yang ditempatkan secara permanen pada struktur. Beban mati dapat 

diaplikasikan baik sebagai beban garis maupun beban merata. Pada titik-titik tertentu di 

mana efek akibat beban terjadi secara lokal, analisis khusus secara terpisah perlu untuk 

dipertimbangkan.  

a. Berat Sendiri Elemen Struktur 

Beban mati akibat berat sendiri elemen struktur terdiri atas berat dari material 

struktur yang digunakan. Beberapa berat jenis dari material struktur yang sering 

digunakan pada bangunan industri adalah baja dengan berat jenis 7850 kg/m^3 dan 

beton dengan berat jenis 2400 kg/m^3. Umumnya berat sendiri struktur secara 

otomatis dapat dihitung secara otomatis oleh program bantu analisis struktur seperti 

ETABS. 

Tabel 1.3. 

Berat Jenis untuk Bahan Bangunan 

No. Material Berat (kg/m^3) Keterangan 

1. Baja 7850  

2. Batu alam 2600  

3. Batu belah, batu bulat, batu 

gunung 

1500 Berat tumpuk 

4. Batu karang 700 Berat tumpuk 
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No. Material Berat (kg/m^3) Keterangan 

5. Batu pecah 1450  

6. Besi tuang 7250  

7. Beton 2200  

8. Beton bertulang 2400  

9. Kayu 1000 Kelas I 

10. Kerikil, koral 1650 Kering udara 

sampai lembab, 

tanpa diayak 

11. Pasangan bata merah 1700  

12. Pasangan batu belah, batu 

bulat, batu gunung 

2200  

13. Pasangan batu cetak 2200  

14. Pasangan batu karang 1450  

15. Pasir 1600 Kering udara 

sampai lembab 

16. Pasir 1800 Jenuh air 

17. Pasir kerikil, koral 1850 Kering udara 

sampai lembab 

(Sumber: Pedoman Perencanaan Pembebanan untuk Rumah dan Gedung, 1987) 

b. Beban Mati Tambahan (Superimposed Dead Load) 

Beban Mati Tambahan merupakan berat komponen nonstruktural (arsitektural 

dan MEP) yang sifatnya tetap pada struktur bangunan. Secara tipikal Metal Building 

System Manual memberikan rekomendasi beban SIDL tipikal yang dapat dijadikan 

acuan pada perencanaan bangunan industri sebagaimana pada tabel berikut. 

Tabel 1.4.  

Tipikal Beban SIDL untuk Bangunan Industri 

 
(Sumber: Metal Building System Manual, 2019) 

 
 
 

Beban SIDL, 

kN/m^2

Ceiling

Suspended Acoustical Fiber Tile 0,05

Suspended Gypsum Board - 1/2" 0,10

Suspended Gypsum Board - 5/8" 0,14

Insulation

Glass Fiber Blanket Dapat diabaikan

Cellular Plastic, per inch of insulation 0,01

Lighting 0,005-0,05

HVAC Ducts, Office/Commercial 0,05

Sprinkler

Dry 0,07

Wet 0,14

Material
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2. Beban Hidup Atap (Roof Live Load) 

Beban hidup (live load) adalah beban yang tejadi akibat penggunaan struktur atau 

akibat beban yang sifatnya sementara (tidak tetap). Pada atap, beban hidup 

dipertimbangkan untuk mengakomodir kegiatan pemeliharaan bilamana suatu terjadi 

kerusakan pada atap. SNI 1727-2020 pada Tabel 4-1 merekomendasikan penggunaan atap 

sebesar 0,96 kN/m^2 (96 kg/m^2). Beban atap ini dizinkan untuk direduksi dengan faktor 

reduksi 0,6 sehingga berdasarkan SNI 1727:2020 Pasal 4.8.2 disyaratkan bahwa beban 

hidup yang bekerja pada atap harus diambil minimum sebesar 0.58 kN/m^2 (60 kg/m^2). 

 

Gambar 1.12. Ketentuan Beban Hidup untuk Atap Berdasarkan SNI 1727-2020 

(Sumber: SNI 1727-2020) 

3. Beban Hujan (R) 

Atap perlu didesain agar dapat menahan beban genangan air hujan apabila sistem 

drainase primer pada atap tertutup. Pedoman Perencanaan Pembebanan untuk rumah dan 

gedung, 1987, memberikan rekomendasi perhitungan beban air hujan berdasarkan sudut 

kemiringan atap dengan persamaan sebagai berikut: 

𝑅 = 40 − 0,8 ∗ 𝛼 

Di mana: 

R = Beban hujan (kg/m^2) 

α = Sudut atap (derajat) 

Beban atap ini tidak perlu diambil lebih besar dari 20 kg/m^2. 

Sebagai alternatif lain, SNI 1727-2020 juga memberikan rekomendasi beban yang dapat 

diberikan pada atap akibat genangan air hujan dengan persamaan sebagai berikut: 

𝑅 = 0,0098 ∗ (𝑑𝑠 + 𝑑𝑛) 

R =  Beban hujan (kN/m^2) 

ds =  Kedalaman air pada atap yang tidak melendut meningkat ke lubang masuk sistem 

drainase sekunder apabila sistem drainase primer tertutup (tinggi statis), dalam in. 

(mm) 

dn =  Tambahan kedalaman air pada atap yan tidak melendut di atas lubang masuk 

sistem drainase sekunder pada aliran air rencana (tinggi hidrolik), dalam in. (mm). 

4. Beban Angin (Wind Load) 

Beban angin diambil berdasarkan geometri bangunan karena beban angin 

merupakan beban yang paling dominan bekerja pada sebuah stuktur seperti bangunan 

industri. Menurut SNI 1727-2020 Pasal 26 yang mengadopsi ASCE 7-16, bangunan 
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industri seperti warehouse masuk dalam kategori Sistem Penahan Gaya Angin Utama 

(SPGAU) serta seluruh Komponen dan Klading (K&K) dalam SNI atau MWFRS and C&C 

dalam ASCE 7-16. Dasar perencanaan beban angin untuk Sistem Penahan Gaya Angin 

Utama terdapat pada SNI 1727 2020 Pasal 27. 

Tekanan angin desain untuk SPGAU bangunan gedung pada semua ketinggian 

lb/ft^2 (N/m^2) harus ditentukan dengan persamaan sebagai berikut: 

𝑝 = 𝑞 ∗ 𝐺 ∗ 𝐶𝑝 − 𝑞𝑖 ∗ (𝐺 ∗ 𝐶𝑝𝑖) 

Di mana: 

q = qz untuk dinding di sisi angin datang yang diukur pada ketinggian z di atas 

permukaan tanah 

q = qh untuk dinding di sisi angin pergi, dinding samping, dan atap yang diukur 

pada ketinggian h 

qi = qh untuk dinding di sisi angin datang, dinding samping, dinding di sisi angin 

pergi, dan atap bagunan gedung tertutup, dan untuk mengevaluasi tekanan 

internal negatif pada angunan gedung tertutup sebagian 

qi = qz untuk mengevaluasi tekanan internal positif pada bangunan gedung 

tertutup sebagian bila tinggi z ditentukan sebagai level dari bukaan tertinggi 

pada bangunan gedung yang dapat mempengaruhi tekanan internal positif. 

Untuk bangunan gedung yang terletak di wilayah puing terbawa angin, kaca 

yang tidak tahan impak atau dilindungi dengan penutup tahan impak, harus 

diperlakukan sebagai bukaan sesuai dengan Pasal 26.12.3. Untuk menghitung 

tekanan internal positif, qi secara konservatif boleh dihitung pada ketinggian 

h (qi= qh) 

G = faktor efek-hembusan angin, lihat Pasal 26.11. Untuk bangunan gedung 

fleksibel, Gf yang ditentukan menurut Pasal 26.11.5 harus menggantikan G 

Cp = koefisien tekanan eksternal dari Gambar 27.3-1, 27.3-2 dan 27.3-3 

GCpi = koefisien tekanan internal dari Tabel 26.13-1 

SNI 1727-2020 memberikan langkah - langkah dalam menentukan beban angin 

SPGAU untuk bangunan gedung tertutup, tertutup sebagian, dan terbuka dari semua 

ketinggian. Langkah-langkah dalam penentuan beban angin adalah sebagai berikut: 

1. Menentukan Kategori Risiko Bangunan Gedung 

Kategori risiko bangunan gedung yang direncanakan terhadap beban angin dapat 

ditinjau berdasarkan Tabel 1.5-1 SNI 1727-2020. Terdapat empat kategori risiko 

bangunan gedung, di mana semakin tinggi tingkatan, fungsi bangunan menjadi lebih 

penting. 
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Tabel 1.5. 

Kategori Risiko Bangunan Dan Struktur Lainnya Untuk Beban Banjir, Angin, 

Salju, Gempa, Dan Es 

 

2. Menentukan Kecepatan Angin Dasar, V (Pasal 26.5) 

Dalam TPKB Jakarta, kecepatan angin dasar Vs = 39,1 m/s untuk strength design dan 

Vs = 32 m/s untuk serviceability design. Sedangkan menurut HB 212-2002 Design 

wind speeds for Asia – Pacific Region report from AS/NZS merekomendasikan 

menggunakan Vs = 32 untuk serviceability design dan Vs = 40 m/s untuk ultimate 

design in Indonesian region. Acuan kecepatan angin berdasarkan konsensus TPKB 

Jakarta dapat digunakan sebagai landasan desain apabila kecepatan angin pada lokasi 

yang ditinjau tidak diketahui secara spesifik. 

3. Menentukan Parameter Beban Angin. 

Parameter beban angin untuk sistem SPGAU ditentukan menurut Pasal 26, yaitu 

sebagai berikut: 

- Faktor arah angin, Kd (Pasal 26.6) 

Faktor arah angin ditentukan berdasarkan tabel sebagai berikut. 
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Tabel 1.6. 

Faktor Arah Angin 

 

- Kategori kekasaran permukaan, (Pasal 26.7) 

Kekasaran Permukaan tanah harus ditentukan untuk tujuan menetapkan suatu 

kategori eksposur seperti yang didefinisikan sebagai berikut: 

Kekasaran Permukaan B: Daerah perkotaan dan pinggiran kota, daerah 

berhutan, atau daerah lain dengan penghalang berjarak dekat yang banyak 

memiliki ukuran dari tempat tinggal keluarga. 

Kekasaran Permukaan C: Dataran terbuka dengan penghalang tersebar yang 

memiliki tinggi umumnya kurang dari 30 ft (9,1 m). Kategori ini mencakup daerah 

terbuka datar dan padang rumput. 

Kekasaran Permukaan D: Area datar, area tidak terhalang dan permukaan air. 

Kategori ini berisi lumpur halus, padang garam, dan es tak terputus. 

- Kategori eksposur, (Pasal 26.7) 

Untuk setiap arah angin yang diperhitungkan, eksposur lawan angin didasarkan 

pada kekasaran permukaan tanah yang ditentukan dari topografi alam, vegetasi, 

dan fasilitas dibangun. 

Eksposur B: Untuk bangunan gedung dengan tinggi atap rata-rata kurang dari 

atau sama dengan 30 ft (9,1 m), Eksposur B berlaku bilamana kekasaran 

permukaan tanah, sebagaimana ditentukan oleh Kekasaran Permukaan B, berlaku 

diarah lawan angin untuk jarak yang lebih besar dari 1.500 ft (457 m). Untuk 

bangunan dengan tinggi atap rata-rata lebih besar dari 30 ft (9,1 m), Eksposur B 

berlaku bilamana Kekasaran Permukaan B berada dalam arah lawan angin untuk 

jarak lebih besar dari 2.600 ft (792 m) atau 20 kali tinggi bangunan, pilih yang 

terbesar. 

Eksposur C: Eksposur C berlaku untuk semua kasus saat Eksposur B atau D tidak 

berlaku. 

Eksposur D: Eksposur D berlaku bilamana kekasaran permukaan tanah, 

ditentukan oleh Kekasaran Permukaan D, berlaku diarah lawan angin untuk jarak 

yang lebih besar dari 5.000 ft (1.524 m) atau 20 kali tinggi bangunan, pilih yang 

terbesar. Eksposur D juga berlaku bilamana kekasaran permukaan tanah lawan 
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angin dari situs B atau C, dan situs yang berada dalam jarak 600 ft (183 m) atau 

20 kali tinggi bangunan, mana yang terbesar, dari kondisi Eksposur D 

sebagaimana ditentukan dalam kalimat sebelumnya. 

- Faktor topografi, Kzt (Pasal 26.8) 

Efek peningkatan kecepatan angin pada bukit, bukit memanjang, dan tebing curam 

yang terisolasi akan menimbulkan perubahan mendadak dalam topografi umum, 

terletak dalam setiap kategori eksposur, dimasukkan dalam perhitungan beban 

angin. 

Di mana faktor topografi: 

𝐾𝑧𝑡 = (1 + 𝐾1 ∗ 𝐾2 ∗ 𝐾3)2 

Di mana faktor ini khusus Kategori Eksposur C dapat menggunakan Tabel 2.5, 

dengan parameter mengikuti sesuai kasus pada Gambar 2.3 dan Gambar 2.4. Jika 

kondisi situs dan lokasi gedung dann bangunan lain tidak memenuhi semua 

kondisi yang disyaratkan, maka Kzt = 1.0.  

 

 

Gambar 1.13. Faktor Topografi 

(Sumber: SNI 1727-2020) 

Di mana faktor ini khusus Kategori Eksposur C dapat menggunakan Tabel 2.5, 

dengan parameter mengikuti sesuai kasus pada Gambar 2.3 dan Gambar 2.4. Jika 

kondisi situs dan lokasi gedung dann bangunan lain tidak memenuhi semua 

kondisi yang disyaratkan, maka Kzt = 1.0.  

- Efek Tiupan Angin 

Faktor Efek Tiupan Angin (G) 

Faktor efek-tiupan angin untuk suatu bangunan gedung dan struktur lain yang kaku 

boleh diambil sebesar 0,85. 

- Faktor elevasi permukaan tanah, Ke (Pasal 26.9) 

Faktor elevasi dasar untuk menyesuaikan dengan densitas udara, Ke, di mana 

dapat ditentukan berdasarkan elevasi. Secara konservatif faktor elevasi dasar untuk 

seluruh eleveasi dapat diambil, Ke = 1. 

- Koefisien tekanan internal, GCpi (Pasal 26-13) 

Koefisien tekanan internal, Gcpi dapat ditentukan berdasarkan klasifikasi 

ketertutupan bangunan yang direncanakan. Koefisien tekanan internal bisa 

didapatkan pada Tabel 26.13-1 SNI 1727-2020 yang juga tercantum sebagai 

berikut: 
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Tabel 1.7. 

Koefisien Tekanan Internal, Gcpi untuk Berbagai Klasifikasi Ketertutupan Bangunan 

 

4. Menentukan Koefisien Eksposur Tekanan Velositas, Kz dan Kh (Pasal 26.10) 

Berdasarkan kategori eksposur yang ditentukan dalam tabel berikut, koefisien 

eksposur tekanan velositas Kz atau Kh, sebagaimana yang berlaku. Untuk situs yang 

terletak pada zona transisi antara kategori eksposur yang dekat terhadap perubahan 

oleh akibat kekasaran permukaan tanah, diizinkan untuk menggunakan nilai konversi 

dari Kz atau Kh. 

Tabel 1.8. 

Koefisien Eksposur Tekanan Velositas, Kh dan Kz 
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Koefisien eksposur tekanan velositas Kz dapat ditentukan dari formula berikut: 

Untuk 15 ft ≤ z ≤ zg = 𝐾𝑧 = 2,01 ∗ (
𝑧

𝑧𝑔
)

2

𝛼
 

Untuk z < 15 ft  = 𝐾𝑧 = 2,01 ∗ (
15

𝑧𝑔
)

2

𝛼
 

Di mana, untuk nilai zg dan α dapat diambil dari tabel berikut ini. 

Tabel 1.9. 

Koefisien Eksposur Daratan 

 

5. Menentukan Tekanan Velositas qz dan qh 

Tekanan velositas, qz, dievaluasi pada ketinggian z dihitung dengan persamaan 

berikut: 

𝑞𝑧 = 0,613 ∗ 𝐾𝑧 ∗ 𝐾𝑧𝑡 ∗ 𝐾𝑑 ∗ 𝐾𝑒 ∗ 𝑉2 

Di mana: 

qz = Tekanan kecepatan pada ketinggian z (N/m2) 

Kz = Koefisien papan tekanan kecepatan = variatif 

Kzt = Faktor topografi 

Kd = Faktor arah angin 

Ke = Faktor elevasi dasar tanah 

VC = Kecepatan angin rencana 

G = faktor efek-tiupan angin 

6. Menentukan Koefisien Tekanan Eksternal Cp atau Cn 

Koefisien tekanan eksternal untuk atap pelana, atap perisai, atap miring sepihak, dan 

atap mansard yang biasa digunakan pada bangunan industri bisa didapatkan pada 

Gambar 27.3-1 SNI 1727-2020 sebagai berikut. 



22        Perencanaan Struktur Bangunan Industri dengan Crane 
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Gambar 1.14.  Sistem Penahan Gaya Angin Utama, Bagian 1 (Seluruh Ketinggian) 

Koefisien Tekanan Eksternal, Cp, Untuk Bangunan Tertutup Dan Bangunan 

Tertutup Sebagian Dinding Dan Atap 

(Sumber: SNI 1727-2020) 

 

7. Menentukan Tekanan Angin untuk Bangunan Gedung 

Tekanan angin desain untuk semua ketinggian ditentukan persamaan berikut: 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − (+/−𝐺𝐶𝑝𝑖)]  (kPa) 

Di mana: 

q = qz, untuk dinding di sisi angin datang yang diukur pada ketinggian z di atas 

permukaan tanah 

q = qh, untuk dinding di sisi angin pergi, sisi, dan atap, yang diukur pada 

ketinggian h di atas permukaan tanah 
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qi = qz, untuk tekanan internal bangunan gedung tertutup dan tekanan internal 

negatif bangunan tertutup sebagian 

qi  = qh, untuk tekanan internal positif pada bangunan gedung tertutup sebagian 

bila tinggi z ditentukan sebagai level bukaan tertinggi pada bangunan 

gedung 

G = Faktor efek tiupan angin 

Cp  =  Koefisien tekanan eksternal. 

5. Beban Gempa (Seismic Load) 

Langkah-langkah dalam penentuan beban gempa harus dilakukan sesuai SNI 

1726:2019 yaitu sebagai berikut: 

a. Peta Zonasi Gempa Indonesia 

Wilayah Indonesia dipetakan berdasarkan tingkat risiko gempanya, yang 

ditentukan atas dasar besarnya percepatan puncak batuan dasar (Peak Ground 

Acceleration, PGA). Berdasarkan SNI 1726:2019, pengaruh beban gempa rencana 

yang harus ditinjau dalam perencanaan ditetapkan sebagai gempa dengan 

kemungkinan terlampaui besarannya selama umur struktur bangunan 50 tahun adalah 

sebesar 2%. Beban gempa ditentukan berdasarkan peta gempa maksimum yang 

dipertimbangkan risiko-tertarget (Maximum Considered Earthquake, MCER) dengan 

parameter-parameter gerak tanah Ss dan S1. Ss adalah parameter nilai percepatan 

respons spektral gempa MCER pada periode pendek, teredam 5%, dan S1 adalah 

parameter nilai percepatan respons spektral gempa MCER pada periode 1 detik, 

teredam 5%, seperti yang ditunjukkan pada gambar berikut: 

 

Gambar 1.15.  Parameter Gerak Tanah Ss, Gempa Maksimum yang Dipertimbangkan 

Risiko-Tertarget (MCER) Wilayah Indonesia Untuk Spektrum Respons 0,2-

Detik (Redaman Kritis 5 %) 

(Sumber: SNI 1726-2019) 
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Gambar 1.16.  Parameter Gerak Tanah, S1, Gempa Maksimum yang Dipertimbangkan 

Risiko-Tertarget (MCER) Wilayah Indonesia Untuk Spektrum Respons 1- 

Detik (Redaman Kritis 5 %) 

(Sumber: SNI 1726-2019) 

 

b. Kategori Risiko dan Faktor Keutamaan Gempa, Ie 

Dalam SNI 1726-2019, struktur bangunan dibedakan berdasarkan tingkat 

risiko yang ditentukan berdasarkan fungsi dari bangunan tersebut. Kategori risiko 

bangunan dibagi dalam 4 tingkatan risiko yang menentuan besarnya faktor keutamaan 

gempa (Ie) yang akan digunakan. Penentuan kategori risiko dan faktor keutamaan 

gempa (Ie) dapat dilihat pada tabel sebagai berikut: 

Tabel 1.10. 

Kategori Risiko bangunan gedung dan nongedung 
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Tabel 1.11. 

Faktor Keutamaan Gempa, Ie 

 

c. Kelas Situs dan Koefisien Situs, Fa dan Fv 

Klasifikasi kelas situs ditentukan berdasarkan beberapa paremeter tanah pada 

kedalaman 30 m dari tanah asli, seperti hasil pengujian kecepatan rambat gelombang 

geser rata-rata pada regangan geser yang kecil (v̅s), hasil pengujian penetrasi standar 

rata-rata (N̅) atau hasil pengujian penetrasi standar rata-rata tanah nonkohesif (N̅ch) 

dari data N-SPT, dan data kuat geser niralir rata-rata (s̅u) dari uji triaksial. Berdasarkan 

Pasal 5.3.3 SNI 1726-2019 untuk penetapan kelas situs tanah keras (SC), tanah sedang 

(SD), dan tanah lunak (SE) harus ditentukan berdasarkan dua dari tiga parameter 

tersebut. Sehingga, apabila hanya digunakan satu parameter dan kelas situs termasuk 

dalam kriteria yang dimaksud pada pasal tersebut. Maka, kelas situs yang 

diperhitungkan adalah kelas situs terendah pada pasal tersebut, yaitu kelas situs tanah 

lunak (SE). Ketentuan mengenai kelas situs diatur pada Tabel 5 SNI 1726-2019 

tentang Klasifikasi Situs. 

Tabel 1.12. 

Klasifikasi Situs 
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Tabel 1.13. 

Koefisien Situs, Fa 

 
Tabel 1.14. 

Koefisien Situs, Fv 

 
 

d. Kategori Desain Seismik (KDS) 

Penentuan Kategori Desain Seismik dilakukan berdasarkan Kategori Risiko 

serta parameter respons spektral desain, SDS dan SD1 seperti ditunjukkan pada tabel 

berikut: 

Tabel 1.15. 

Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan Periode Pendek 

 
Tabel 1.16. 

Kategori Desain Seismik Berdasarkan Parameter Respons Percepatan Periode 1 Detik 
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6. Beban Crane (Crane Load) 

a. Beban Roda (Wheel Load) 

Pada perencanaan struktur penunjang crane, beban roda menjadi hal yang perlu 

dipertimbangkan secara teliti. Berdasarkan SNI 1727-2020 dijelaskan bahwa, beban 

roda maksimum perlu diambil dari berat girder crane atau bridge, berat trolley dan 

hoist crane serta berat angkut crane. Beban roda perlu dipertimbangkan berdasarkan 

reaksi maksimum yang dapat dihasilkan dari sekian kondisi pengangkatan yang 

dimungkinkan. Umumnya reaksi maksimum dari crane akan diberikan oleh vendor. 

Namun pada kondisi di mana reaksi maksimum dari crane masih belum didapatkan, 

beban roda dapat diestimasikan dengan persamaan sebagai berikut. 

𝑊𝐿 =
𝑅𝐶 + 𝐻𝑇 + 0,5 ∗ 𝐶𝑊

𝑁𝑊𝑏
 

Di mana: 

WL = Beban roda maksimum 

RC = Kapasitas angkut crane 

HT = Berat hoist + trolley 

CW = Berat sendiri crane (tidak termasuk hoist + trolley) 

NWb = Jumlah roda pada salah satu sisi crane. 

b. Beban Impak Vertikal 

Selama masa operasional crane, beban pada struktur akan terus mengalami 

variasi perbedaan karena beban crane merupakan beban dinamis. Efek beban crane 

pada struktur pendukung merupakan fungsi dari laju percepatan dan perlambatan dari 

crane, massa dan beban crane yang diangkat, tingkat redaman struktur dan lain 

sebagainya. Atas dasar ketidakpastian beban tersebut, maka beban roda maksimum 

yang digunakan pada desain runway beam, termasuk monorel, sambungan dan braket 

(corbel) penyangganya harus ditingkatkan persentasenya, umumnya sebesar 25%. SNI 

1727-2020 yang mengadopsi ASCE 7-16 memberikan panduan mengenai besaran 

faktor impak yang perlu diberikan pada beban roda maksimum sebagaimana 

didetailkan pada tabel berikut. 

Tabel 1.17. 

Beban Impak Vertikal pada Crane 

Tipe Crane Faktor Impak 

Derek tunggal (dengan tenaga) 25% 

Kabin dengan operator atau derek jembatan dioperasikan 

secara remote (dengan tenaga) 
25% 

Derek jembatan dioperasikan dengan gantungan (dengan 

tenaga) 
10% 

Derek jembatan atau derek rel tunggal dengan jembatan gigi 

berkendali tangan, troli, dan alat pengangkat 
0% 

(Sumber: SNI 1727-2020) 
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c. Gaya Lateral 

Beban lateral yang terjadi pada runway crane umumnya disebabkan oleh beberapa 

faktor sebagai berikut: 

1. Ketidaksejajaran runway 

2. Pemasangan crane yang miring 

3. Percepatan trolley 

4. Gaya rem trolley 

5. Penggerak crane 

Beban lateral akibat dorongan ke samping umumnya dihitung sebesar 20% dari 

total kapasitas angkut crane + berat dari trolley dan hoist. Semua beban tersebut dapat 

diambil dari spesifikasi teknis yang dikeluarkan oleh vendor crane. Faktor beban yang 

direkomendasikan oleh Design Guide 7: Design for Industrial Building AISC untuk 

analisis LRFD adalah 1,6. 

𝐻𝑐𝑟𝑎𝑛𝑒 = 20% ∗ 𝑃𝑙𝑖𝑓𝑡𝑒𝑑 + 𝑃𝑡𝑟𝑜𝑙𝑙𝑒𝑦 𝑎𝑛𝑑 ℎ𝑜𝑖𝑠𝑡 

Di mana: 

Plifted  =  Kapasitas angkat crane 

Ptrolley+hoist =  Berat trolley dan hoist 

d. Gaya Longitudinal 

Gaya longitudinal pada struktur penunjang crane dihitung sebesar 10% dari 

beban roda maksium crane. Menurut SNI 1727-2020, gaya longitudinal crane perlu 

diasumsikan bekerja pada permukaan traksi balok landasan pacu dalam arah sejajar 

balok. Baik SNI 1727-2020 maupun ASCE 7-16 tidak merekomendasikan faktor 

beban untuk gaya longitudinal. Design Guide 7: Design for Industrial Building 

merekomendasikan faktor beban 1,6. 

e. Kondisi Pembebanan Crane 

Berbagai macam kondisi pembebanan yang dapat mengakibatkan reaksi roda 

paling maksimum perlu dipertimbangkan. Menurut Metal Building System Manual, 

terdapat 4 kondisi yang perlu dipertimbangkan untuk mendapatkan reaksi roda paling 

maksimum. 

1) Beban roda maksimum pada ujung kiri crane dan beban roda minimum pada ujung 

kanan crane, beban roda maksimum bekerja bersamaan dengan gaya lateral yang 

bekerja ke kiri 

2) Beban roda maksimum pada ujung kiri crane dan beban roda minimum pada ujung 

kanan crane, beban roda maksimum bekerja bersamaan dengan gaya lateral yang 

bekerja ke kanan 

3) Beban roda maksimum pada ujung kanan crane dan beban roda minimum pada 

ujung kiri crane, beban roda maksimum bekerja bersamaan dengan gaya lateral 

yang bekerja ke kiri 

4) Beban roda maksimum pada ujung kanan crane dan beban roda minimum pada 

ujung kiri crane, beban roda maksimum bekerja bersamaan dengan gaya lateral 

yang bekerja ke kanan. 
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Gambar 1.17. Kondisi Pembebanan Crane 

(Sumber: Metal Building System Manual, 2019) 

F. KOMBINASI PEMBEBANAN 

Kombinasi pembebanan digunakan untuk menentukan gaya dalam yang bekerja pada 

seluruh elemen struktur, seperti pelat lantai, balok, kolom, dan tangga dengan menggunakan 

metode LRFD (Load and Resistance Factor Design). Berbagai kondisi yang mungkin terjadi 

pada struktur yaitu kombinasi dari beban mati (dead load), beban hidup (live load), beban angin 

(wind load), dan beban gempa (earthquake load). Kombinasi pembebanan yang digunakan 

didasarkan pada SNI 1726-2019. Kombinasi pembebanan tersebut adalah sebagai berikut: 

1. 1.4D 

2. 1.2D + 1.6L + 0.5 (Lr atau R) 

3. 1.2D + 1.6 (Lr atau R) + (L atau 0.5W) 

4. 1.2D + 1.0W + L + 0.5 (Lr atau R) 

5. 0.9D + 1.0W 

6. 1.2D + 1.0Ev + 1.0Eh + L 

7. 0.9D + 1.0Ev + 1.0Eh 

Keterangan: 

D =  Beban mati + Beban mati tambahan 

L  =  Beban hidup lantai 

Lr =  Beban hidup atap 

ρ  = Faktor Redundansi 

Pengaruh beban seismik horizontal, Eh , harus ditentukan sesuai Eh = ρQe 

Pengaruh beban seismik horizontal, Ev , harus ditentukan sesuai Ev = 0,2SDSD 

G. BATAS LENDUTAN 

1. Atap (Roofing) 

Fokus pengecekan lendutan pada atap ada 3 bagian yaitu: 

1. Tengah bentang atap 

2. Ujung atap 

3. Daerah yang berpotensi mengalami rembesan 
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Terdapat dua jenis atap yang umum digunakan, yaitu atap membran dan atap metal. 

Lendutan yang diizinkan di atap berdasarkan beban yang bekerja dapat dilihat pada Tabel 

di bawah ini. 

 

Tabel 1.18. 

Batasan Lendutan Izin pada Atap 

Struktur atap: Hidup Angin 
Mati + 

Hidup 

Elemen Struktur 

Atap 

      

Menopang ceiling 

dengan plaster 

L/360 L/360 L/240 

Menopang ceiling 

dengan tanpa 

plaster 

L/240 L/240 L/180 

Tidak menopang 

ceiling 

L/180 L/180 L/120 

Struktur atap 

menopang metal 

roofing 

L/150   L/60 

Struktur penopang 

lantai 

L/360   L/240 

Struktur penopang 

dinding dan partisi 

interior 

      

Dengan finishing 

yang rapuh 

  L/240   

Dengan finishing 

yang fleksibel 

  L/120   

Struktur penopang 

dinding sekunder 

yang menopang 

penutup logam 

  L/90   

(Sumber: Design Guide 3: Serviceability Design Consideration for Steel Building, 2003) 

a. Lendutan Vertikal  

Defleksi vertikal yang berlebih dan penyimpangan (misalignment) yang 

muncul terutama dari tiga sumber: (1) beban gravitasi (DL+LL), (2) efek temperatur, 

rangkak, dan perbedaan penurunan, dan (3) toleransi dan kesalahan konstruksi. Secara 

historis, batas defleksi izin untuk komponen horizontal adalah 1/360 dari bentang yang 

memikul beban hidup nominal penuh dan 1/240 dari bentang untuk komponen atap. 

Defleksi sebesar 1/300 dari bentang (untuk kantilever, 1/150 dari panjang) dapat 

terlihat dan menyebabkan kerusakan arsitektur secara umum atau kebocoran pada 

klading. 

b. Lendutan Lateral (Drift) 

Mengutip dari SNI 1727 2020 adopsi dari ASCE 7-10, drift (defleksi lateral) 

yang menjadi perhatian dalam pemeriksaan kemampuan layan akibat beban angin. 
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Batasan yang diizinkan yaitu pada rentang L/600 hingga L/400. Wast and Fisher 

(2003) memberikan rekomendasi untuk batas drift yang lebih tinggi dan telah berhasil 

digunakan pada bangunan gedung bertingkat rendah dengan alat kran (crane). 

c. Lendutan Vertikal dan Horizontal Izin Akibat Beban Crane 

CMAA mengklasifikasikan crane menjadi beberapa kelas dengan kriteria 

lendutan vertikal yang berbeda-beda tergantung kelasnya. Lendutan vertikal dan 

horizontal izin untuk masing-masing kelas crane terangkum pada tabel di bawah ini. 

Tabel 1.19. 

Lendutan Vertikal dan Horizontal Izin untuk Runway Beam 

CMAA Crane 

Classification 

Lendutan 

Vertikal 

Izin 

Lendutan 

Horizontal 

Izin  
A L/600 

L/400 

 

B L/600  

C L/600  

D L/800  

E L/1000  

F L/1000  

(Sumber: Design Guide 7: Industrial Building Design, 2019) 

 

H. PENGECEKAN TERHADAP ASPEK KEGEMPAAN 

1. Bentuk dan Jumlah Ragam 

Ragam getar harus berbetuk tranlasional untuk dua arah ortogonal dan rotasi 

terhadap sumbu vertikal. Ragam getar ini dapat dianalisis dengan menggunakan software 

metode elemen hingga. Partisipasi massa ragam juga harus dicek persentasenya terhadap 

SNI 1726-2019. Pada peraturan tersebut, tepatnya pada Pasal 7.9.1.1 ditentukan bahwa 

partisipasi massa ragam harus 100% dari massa struktur. Namun, terdapat pengecualian 

bahwa analisis diizinkan untuk mencapai paling sedikit 90% dari massa aktual dalam arah 

horizontal ortogonal dari model. 

 

Gambar 1.18. Derajat Kebebasan pada Tiap Lantai 

(Sumber: Imam Satyarno. dkk, 2012) 

Jumlah ragam dapat diasumsikan secara konservatif sebesar tiga kali jumlah lantai. 

Hal ini didasari ketentuan bahwa setiap lantai memiliki tiga derajat kebebasan yaitu 

translasi arah-x, translasi arah-y, dan rotasi. Jumlah ragam tersebut tentunya harus kembali 

dicek terhadap syarat partisipasi massa ragam. 
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2. Simpangan Antar Tingkat 

Gaya gempa lateral akan menyebabkan simpangan struktur pada arah lateral di 

masing-masing lantai. SNI 1726-2019 memberikan pembatasan simpangan lateral antar 

tingkat untuk menjamin stabilitas struktur, dan mencegah kerusakan elemen non struktural. 

Simpangan antar tingkat ditentukan berdasarkan perbedaan simpangan pada pusat massa 

di tingkat yang ditinjau dengan tingkat di bawahnya. Adapun persamaan simpangan pada 

pusat massa yang digunakan adalah sebagai berikut: 

𝛿𝑥 =
𝐶𝑑 × 𝛿𝑥𝑒

𝐼𝑒
 

Dengan: 

Cd =  Faktor pembesaran defleksi 

δxe                   =  Simpangan di lantai yang ditinjau yang diakibatkan oleh gaya gempa 

lateral  (biasanya ditentukan dengan menggunakan program) 

Ie  =  Faktor keutamaan gempa 

 

Gambar 1.19. Penentuan Simpangan Antar Tingkat 

(Sumber: SNI 1726-2019) 

Simpangan antar tingkat yang dihitung tidak boleh melebihi batas simpangan antar 

tingkat izin (Δa) yang ditentukan oleh SNI 1726-2019 pada tabel di bawah. 

Tabel 1.20. 

Simpangan Antar Tingkat Izin 

Struktur 
Kategori Resiko 

I atau II III IV 

Struktur, selain dari struktur dinding geser 

batu bata, 4 tingkat atau kurang dengan 

dinding interior, partisi, langit langit dan 

sistem dinding eksterior yang telah didesain 

untuk mengakomodasi simpangan antar lantai 

tingkat. 

0,025hsx
c 0,020hsx 0,015hsx 
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Struktur 
Kategori Resiko 

I atau II III IV 

Struktur dinding geser kantilever batu batad. 0,010hsx 0,010hsx 0,010hsx 

Struktur dinding geser batu bata lainnya. 0,007hsx 0,007hsx 0,007hsx 

Semua struktur lainnya. 0,020hsx 0,015hsx 0,010hsx 

 

Catatan: 

a hsx adalah tinggi tingkat di bawah tingkat-x 

b Untuk sistem pemikul gaya seismik yang terdiri dari hanya rangka momen b dalam 

kategori desain seismik D, E, dan F, simpangan antar tingkat izin  

b harus sesuai dengan Pasal 7.12.1.1 SNI 1726-2019 

c Tidak boleh ada batasan simpangan antar tingkat untuk struktur satu tingkat dengan 

dinding interior, partisi, langit-langit, dan sistem dinding eksterior yang telah 

didesain untuk mengakomodasi simpangan antar tingkat. Persyaratan pemisahan 

struktur dalam 7.12.3 tidak diabaikan. 

d Struktur di mana sistem struktur dasar terdiri dari dinding geser batu bata yang 

didesain sebagai elemen vertikal kantilever dari dasar atau pendukung fondasinya 

yang dikontruksikan sedemikian agar penyaluran momen di antara dinding geser 

(kopel) dapat diabaikan. 

Terdapat ketentuan lain pada Pasal 7.12.1.1 yang menjelaskan bahwa untuk sistem 

pemikul gaya seismik yang terdiri dari hanya rangka momen pada struktur yang didesain 

untuk kategori desain seismik D, E, atau F, simpangan antar tingkat desain (Δ) tidak boleh 

melebihi Δa/ρ untuk semua tingkat, nilai ρ harus ditentukan berdasarkan Pasal 7.3.4.2 SNI 

1726-2019. 

3. Pengecekan P-Delta 

P-Delta merupakan pengaruh yang ditimbulkan oleh pergerakan lateral kolom 

akibat pengaruh beban aksial dan horizontal. Pergerakan lateral ini akan menimbulkan 

momen sekunder pada daerah sekitar balok dan kolom, serta penambahan simpangan 

lantai. P-Delta berpengaruh pada geser dan momen yang dihasilkan pada masing-masing 

tingkat, momen elemen struktur, dan simpangan antar tingkat. P-Delta bisa diabaikan 

dengan syarat koefisien stabilitas (θ) kurang dari atau sama dengan 0,1. 

𝜃 = (𝑃𝑥 × ∆ × 𝐼𝑒)/ ( 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑) 

Dengan: 

𝜃 =  Koefisien stabilitas 

Px = Beban desain vertikal total pada dan di atas tingkat x, bila menghitung 

Px faktor beban individu < 1,0 

∆ =  Simpangan antar lantai tingkat desain, terjadi secara serentak dengan 

Vx 

Ie =  Faktor keutamaan gempa 
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Vx =  Gaya geser seismik yang bekerja antara tingkat x dan x-1 

hsx =  Tinggi tingkat di bawah tingkat x 

Cd =  Faktor pembesaran defleksi 

Koefisien stabilitas juga harus dicek terhadap nilai maksimal yang ditentukan 

berdasarkan persamaan sebagai berikut: 

Dengan: 

𝜃 =  Koefisien stabilitas 

θmax = Koefisien stabilitas maksimal 

Px = Beban desain vertikal total pada dan di atas tingkat x, bila menghitung 

Px faktor beban individu < 1,0 

𝛽 =  Rasio kebutuhan geser terhadap kapasitas geser untuk tingkat x dan x-

1. Rasio ini diizinkan secara konservatif diambil sebesar 1,0 

Cd =  Faktor pembesaran defleksi 

Untuk koefisien stabilitas 0,1 < θ < θmax, faktor peningkatan akibat P-Delta 

ditentukan berdasarkan analisis rasional. Faktor pengali perpindahan dan gaya komponen 

struktur ditentukan dengan 1/(1- θ). Untuk struktur dengan θ > θmax, perlu didesain ulang 

karena struktur tidak cukup stabil. 
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BAGIAN    

 

A. PERANGKAT LUNAK ETABS 

Dalam proses perencanaan struktur ETABS jamak digunakan oleh para insinyur karena 

kemudahan pemakaian dan keandalannya. Program ETABS ini pertama kali dikembangkan 

oleh perusahaan perangkat lunak terkemuka, Computers and Structures, di California, Amerika 

Serikat. Perkembangan program ini lahir dari riset yang diinisiasi oleh Dr. Edward L. Wilson 

pada tahun 1970 di University of California, Berkeley. 

 

Gambar 2.1. Software ETABS 

Elemen-elemen struktur pada suatu bangunan diidealisasikan oleh ETABS sebagai 

elemen garis (frame), elemen luasan (area), dan elemen titik (joint). Elemen-elemen tersebut 

merepresentasikan elemen aslinya seperti balok, kolom, dinding lantai, pengaku dan lain 

sebagainya. Elemen-elemen ini kemudian dirangkai menjadi satu-kesatuan dan dianalisis 

melalui metode elemen hingga yang digunakan program untuk menganalisis matriks kekakuan 

struktur.  

B. DATA UMUM BANGUNAN 

Struktur bangunan yang didesain memiliki data-data penunjang sebagai berikut: 

Lebar bangunan, B  = 30 m 

Panjang bangunan, L  = 90 m 

Jarak antar portal  = 6 m 

Tinggi kolom   = 9 m 

Tipe struktur   = Gable frame 

Jarak antar kolom post = 10 m 

Sudut atap   = 10 derajat 

Fungsi bangunan  = Pabrik 

Kapasitas crane  = 10 ton 

2 
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Gambar 2.10. Model 3d Warehouse yang Dirancang 

C. MEMBUAT FILE BARU 

Langkah awal permodelan dengan software ETABS adalah dengan membuat file baru 

dengan cara klik File – New Model atau bisa dilakukan melalui shortcut Ctrl+N.  

 

Gambar 2.11. Pembuatan Model Baru pada ETABS 

Sesuaikan parameter-parameter sesuai code yang digunakan. Untuk proyek di 

Indonesia, peraturan yang digunakan biasanya mengacu pada peraturan di Amerika. 

SNI 1729-2020 → AISC 360-16 

SNI 2847-2019 → ACI 318-14/19 
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Gambar 2.12. Pemilihan Jenis Satuan dan Kode yang Ingin Digunakan 

Pada menu New Model Quick Template → pilih Blank. Terdapat beberapa pilihan lain 

seperti Grid Only yang dapat digunakan untuk membuat template dengan grid sesuai story 

dimension yang dimasukkan. 

 

Gambar 2.13. Tampilan Quick Model 
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Gambar 2.14. Tampilan Awal Model ETABS 

Untuk memudahkan proses pemodelan, atur beberapa template unit yang biasa 

digunakan dengan cara klik pada area pojok kanan bawah → Units → Consistent Units → atur 

satuan panjang dan gaya yang diinginkan.  

 

Gambar 2.15. Klik Units 
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Gambar 2.16. Klik Units 

 

Gambar 2.17. Atur Satuan Panjang dan Gaya 

Lalu simpan satuan yang telah diatur dengan cara klik kembali pada pojok kanan bawah 

→ Units → Show Units Form → simpan dan beri nama set satuan yang telah diatur. 

 

Gambar 2.18. Display Units 

Simpan set 
satuan yang 
sudah diatur 
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Gambar 2.19. Simpan Unit Sets 

 

Gambar 2.20. Units Sets Sudah Muncul pada Units 
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D. MEMBUAT GRID 

Selanjutnya untuk membuat Grid dan Story Data, klik Edit → Edit Stories and Grid 

Systems → Modify. Atur Jarak grid dan ketinggian yang digunakan. Cara lain untuk mengedit 

grid adalah dengan klik kanan → Add/Modify Grid System. 

 

Gambar 2.21. Edit → Edit Stories and Grid Systems 

 

Gambar 2.22. Klik Kanan → Add/Modify Grid 

Lalu tambahkan sistem grid baru dengan klik → Add New Grid System. 
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Gambar 2.23. Add New Grid System 

Grid untuk arah x dan y dapat ditambahkan dengan dua cara, memasukkan ordinat grid 

atau dengan cara memasukkan jarak antar grid. Akan dicoba cara input grid melalui ordinat. 

Bangunan warehouse akan memiliki luas 30 m x 90 m dengan jarak antar kolom pada arah 

memanjang 6 m, sementara pada arah melintang terdapat kolom post dengan jarak antar kolom 

10 m. 
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Gambar 2.24. Pengaturan Grid pada Arah X dan Y 

Untuk grid arah vertikal bisa diatur pada opsi Modify/Show Story Data. Grid pada arah 

vertikal di-input berdasarkan elevasi kolom pedestal, top kolom baja, serta apex haunch. 

 

Gambar 2.25. Modify/Show Story Data 

Jarak antar 
kolom pada 
arah 
memanjang = 
6 m. 
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Gambar 2.26. Input Elevasi yang Dibutuhkan 

 

Gambar 2.27. Grid yang Telah Dibuat 

 

 

 

 

 

 

 

 

 

 



54        Perencanaan Struktur Bangunan Industri dengan Crane 

E. PENENTUAN PROPERTI MATERIAL 

Langkah selanjutnya ada penentuan material struktur. Material yang digunakan dalam 

perencanaan struktur menggunakan material beton, baja tulangan dan baja profil. Penentuan 

material dapat dilakukan dengan cara klik Define → Materials. 

 

 

Gambar 2.28. Define Materials 

Penentuan masing-masing properti material sebagai berikut: 

1. Material Beton 

Data: 

Mutu Beton, fc’   = 25 MPa 

Berat Jenis Beton Bertulang  = 2400 kg/m3 

Nilai modulus elastisitas beton ditentukan berdasarkan Pasal 19.2.2.1 SNI 2847-2019 sebagai 

berikut: 

Modulus Elastisitas Beton, Ec = 4700 √(fc') = 4700 x √25 

     = 23500 MPa 

Nisbah Poison, μ   = 0.2 



Perencanaan Struktur Bangunan Industri dengan Crane  55 

 

 

 

Gambar 2.29. Penentuan Material Beton 
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2. Material Baja Tulangan 

Berdasarkan SNI 2847:2019, spesifikasi material baja tulangan memenuhi 

persyaratan pasal 20.2.5 adalah baja tulangan tulangan kelas BJTS 420B. Spesifikasi teknis 

dari baja tulangan kelas BJTS 420B dapat diketahui berdasarkan Tabel 6 SNI 2052-2017 

dengan sebagai berikut: 

Tabel 2.1. 

Sifat Mekanis Baja Tulangan Berdasarkan SNI 2052-2017 

 

Berdasarkan data dari tabel di atas diketahui sifat mekanis BJTS 420B sebagai berikut: 

Mutu Baja Tulangan  = BJTD 420B 

Berat Jenis Tulangan  = 7850 kg/m3 

Modulus Elastisitas Baja, Es = 200.000 MPa 

Tegangan Leleh, Fy  = 420 MPa 

Tegangan Putus, Fu  = 525 MPa 

Expected yield strength, Fye dan expected tensile strength, Fue untuk material baja tulangan 

bisa didapatkan berdasarkan Tabel 6-4 FEMA 356. Faktor konversi yang diberikan untuk 

kuat leleh dan yang diekspektasikan pada baja tulangan adalah 1,25. 
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Tabel 2.2. 

Faktor Konversi untuk Kuat Leleh dan Putus yang Diekspektasikan pada Baja Tulangan 

Berdasarkan FEMA 356 

 

Expected Yield Strength. Fye = 1.25 x 420 MPa = 525 MPa 

Expected Tensile Strength, Fue = 1.25 x 545 MPa = 681,25 MPa 
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Gambar 2.30. Penentuan Material Baja Tulangan 

3. Material Baja Profil Canai Panas 

Material baja profil yang digunakan adalah sebagai berikut: 

Data: 

Mutu Baja Profil   = BJ37/A36 

Berat Jenis Baja   = 7850 kg/m3 

Modulus Elastisitas Baja, Es = 200.000 MPa 

Tegangan Leleh, Fy  = 240 MPa 

Tegangan Putus, Fu  = 370 MPa 

Expected yield strength, Fye dan expected tensile strength, Fue untuk material baja canai 

panas bisa didapatkan berdasarkan Tabel A.3-1 SNI 7860-2020. Faktor untuk 

mengkonversi kuat leleh menjadi untuk kuat leleh terekspektasi untuk baja canai panas 

A36 adalah 1,5, sementara untuk kuat putus baja, nilai konversi yang diberikan adalah 1,2. 

Tabel 2.3. 

Faktor Konversi untuk Kuat Leleh dan Putus yang Diekspektasikan pada Baja Canai Panas 

Berdasarkan SNI 7860-2020 

 

Expected Yield Strength, Fye = 1,5 x 240 MPa = 360 MPa 

Expected Tensile Strength, Fue = 1,2 x 370 MPa = 444 MPa 
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Gambar 2.31. Penentuan Material Baja Canai Panas 
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F. PENENTUAN PROPERTI PENAMPANG 

Ukuran penampang yang digunakan untuk elemen struktur yang direncanakan yaitu 

sebagai berikut: 

1. Kolom 

WF 600   = WF.600X200X11/17 

2. Rafter 

HC 675   = HC.675X200X9/14 

3. Purlin 

CNP 150  = CNP.150X50X20X2,3 

4. Ring Beam (Regel) dan Nok Atap 

WF 300   = WF.300X150X6,5X9 

5. Kolom Post 

WF 450   = WF.450X200X9/14 

6. Bracing 

2L70   = 2L.70X70X7 

7. Runway Beam Crane 

WF 500   = WF.500X200X10/16 

8. Kolom Pedestal Utama 

K60X80   = 600X800 mm2 

9. Kolom Pedestal Post 

K40X70   = 400X700 mm2 

10. Wind Bracing  = Rod 25 mm 

Penentuan dimensi penampang/profil baja dilakukan dengan cara klik Define – Section 

Properties – Frame Sections – Add New Property. Tentukan tipe profil baja pada pilihan 

Section Type seperti sebagai berikut: 
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Gambar 2.32. Define – Section Properties – Frame Sections – Add New Property 

Terdapat empat template pilihan profil untuk baja, yaitu, profil I/Wide Flange Section 

yang dapat digunakan untuk pemodelan profil I-WF (I-Wide Flange) dan HB (H-Beam), 

Channel Section yang dapat digunakan untuk pemodelan profil UNP, Tube Section yang dapat 

digunakan untuk pemodelan profil RHS (Rectangular Hollow Section) atau SHS (Square 

Hollow Section), serta profil Pipe Section yang dapat digunakan untuk pemodelan profil pipa. 

ETABS juga mengakomodir profil-profil lain seperti Double Angle Equal Section dan lain 

sebagainya. 

 

Gambar 2.33. Beberapa Template Bentuk Profil yang Diakomodir ETABS 
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Gambar 2.34. Pemodelan WF.600X200X11/17 

 

Gambar 2.35. Pemodelan WF.500X200X10/16 
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Gambar 2.36. Pemodelan WF.450X200X9/14 

 

Gambar 2.37. Pemodelan WF.300X150X6,5/9 
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Gambar 2.38. Pemodelan HC.675X200X9/14 

Momen inersia sumbu kuat (Ix) dari profil HC yang dimodelkan dengan profil WF, perlu 

dimodifikasi dengan stiffness modifier 0,9 (untuk I33). Hal ini dilakukan karena rasio momen 

inersia HC.676X200X9/14 dengan WF.675X200X9/14 adalah 0,9. 

 

Gambar 2.39. Stiffness Modifier untuk HC.675X200X9/14 
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Gambar 2.40. Pemodelan CNP.150X50X20X2,3 

 

Gambar 2.41. Pemodelan 2L.70X70X7 
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Gambar 2.42. Pemodelan 2L.50X50X5 

 

Gambar 2.43. Pemodelan Rod 25 mm 

Kolom beton bertulang dibutuhkan untuk menopang kolom baja utama dan kolom post. 

Untuk struktur beton bertulang, kekakuan struktur perlu direduksi dengan beberapa faktor 

berdasarkan Tabel 6.6.3.1.1(a) atau Tabel 6.6.3.1.1(b) SNI 2847-2019. Secara konservatif 

faktor reduksi penampang dapat diambil berdasarkan Tabel 6.6.3.1.1(a) SNI 2847-2019 sebagai 

berikut: 
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Tabel 2.4. 

Momen Inersia dan Luas Penampang yang Diizinkan Untuk 

Analisis Elastis Pada Level Beban Terfaktor 

Bagian dan Kondisi 
Momen 

Inersia 

Luas 

Penampang 

Kolom 0.7 Ig 

1.0 Ag 
Dinding 

Tidak Retak 0.7 Ig 

Retak 0.35 Ig 

Balok 0.35 Ig 

Pelat datar dan slab datar 0.25 Ig 

 

Penentuan properti penampang kolom dapat dilakukan dengan Define – Section Properties – 

Frame Sections – Add New Property – Concrete Rectangular. Properti penampang dapat 

ditentukan sebagai berikut. 

Properti Kolom K60X80 

Mutu Material  =  K-300 (fc’ = 25 MPa) 

Mutu Baja Tulangan = BJTS420B 

Di awal jumlah tulangan untuk kolom diasumsikan sebesar 1%Ag, sehingga: 

Tinggi kolom, c1  = 800 mm 

Lebar kolom, c2  = 600 mm 

Luas kolom, Ag  = c1 x c2 = 480000 mm2 

Rasio penulangan, ρ  = 1%  

Luas tulangan yang dibutuhkan  As = 1%Ag 

As = 4800 mm2 

Dimensi tulangan    db = 19  

Luas tulangan     As1 = 283,5 mm2 

Jumlah tulangan    n = 18  

Faktor modifikasi kekakuan    = 0,7 
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Gambar 2.44. Pemodelan Penampang Kolom K60X80 
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Gambar 2.45. Modifikasi Kekakuan untuk K60X80 

Properti Kolom K40X70 

Mutu Material  =  K-300 (fc’ = 25 MPa) 

Mutu Baja Tulangan = BJTS420B 

Di awal jumlah tulangan untuk kolom diasumsikan sebesar 1%Ag, sehingga: 

Tinggi kolom, c1  = 700 mm 

Lebar kolom, c2  = 400 mm 

Luas kolom, Ag  = c1 x c2 = 280000 mm2 

Rasio penulangan, ρ  = 1%  

Luas tulangan yang dibutuhkan  As = 1%Ag 

As = 2800 mm2 

Dimensi tulangan    db = 16  

Luas tulangan     As1 = 201,1 mm2 

Jumlah tulangan    n = 14  

Faktor modifikasi kekakuan    = 0,7 
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Gambar 2.46. Pemodelan Penampang Kolom K40X70 
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Gambar 2.47. Modifikasi Kekakuan untuk K40X70 

Properti Tie Beam TB20/30 

Mutu Material   =  K-300 (fc’ = 25 MPa) 

Mutu Baja Tulangan  = BJTS420B 

Dia. Tulangan Geser, ds = 10 mm 

Dia. Tulangan Long., db = 16 mm 

Clear cover, cc   = 40 mm 

Cover to longitudinal bar = cc + ds + db 

    = 40 + 10 + 0,5*16 

    =  58 mm 

Faktor modifikasi kekakuan = 0,35 
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Gambar 2.48. Pemodelan Penampang TB20/30 
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 Gambar 2.49. Modifikasi Kekakuan untuk TB20/30 

G. PEMODELAN KOLOM K60X80 DAN K40X570 

Permodelan elemen kolom dilakukan dengan cara klik Draw → Draw 

Beam/Column/Brace Objects → Quick Draw Column. Akan muncul tampilan seperti di bawah 

ini. Tentukan Section Properties kolom yang akan digunakan dan arah Kolom. Pilih All Stories 

pada bagian pojok kanan bawah. 

 

Gambar 2.50. Kolom K60X80 yang Dimodelkan 

 

Gambar 2.51. Kolom K40X70 yang Dimodelkan 
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Masuk ke elevasi +1 di mana K60X80 dan K40X70 sebagai kolom pedestal akan 

berhenti, caranya dengan klik View → Set Plan View → Pilih +1. Lalu drag kursor di posisi di 

mana kolom dibutuhkan. 

 

 

Gambar 2.52. Masuk Ke Elevasi +1 

 

Gambar 2.53. Titik Kolom Pedestal K60X80 

Posisi 
kolom 
pedestal 
K60X80 
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Gambar 2.54. Titik Kolom Pedestal K40X70 

 

Gambar 2.55. Titik Kolom Pedestal yang Sudah Dimodelkan 

Di permodelan awal, secara default tumpuan kolom akan bertipe sendi (pinned). 

Tumpuan kolom perlu diubah menjadi tumpuan jepit dengan cara Select joint bawah dari kolom 

pedestal → Assign → Restraints → Fixed. 

Kolom 
pedestal 
K40X70 
(kuning) 

Kolom 
pedestal 
K60X80 
(hijau) 

Posisi 
kolom 
pedestal 
K40X70 
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Gambar 2.56. Select Joint Bawah Kolom Pedestal 

 

 

Gambar 2.57. Merubah Tumpuan Kolom Menjadi Jepit 
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H. PEMODELAN KOLOM WF.600X200X11/17 DAN KOLOM POST 

WF.450X200X9/14 

Untuk pemodelan kolom baja langkah pertama yang perlu dilakukan adalah masuk ke 

elevasi +9 dengan cara klik View → Set Plan View → Pilih +9. Dari view plan yang telah ada, 

kolom bisa langsung dimodelkan dengan opsi klik Draw → Draw Beam/Column/Brace Objects 

→ Quick Draw Column. 

 

 

Gambar 2.58. Masuk Ke Elevasi +9 

Adapun properti kolom yang dimodelkan perlu ditentukan saat opsi Quick Draw 

Column sudah diaktifkan. Properti WF.600X200X11/17 dan WF.450X200X9/14 disajikan 

sebagaimana gambar berikut. 

 

Gambar 2.59. Kolom WF.600X200X11/17 yang Dimodelkan 
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Gambar 2.60. Kolom WF.450X200X9/14 yang Dimodelkan 

  

Gambar 2.61. Titik Kolom WF.450X200X9/14 

 

Gambar 2.62. Titik Kolom WF.600X200X11/17 
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Gambar 2.63. Kolom Baja yang Telah Dimodelkan 

Pada model ini hubungan kolom baja ke kolom pedestal direncanakan menggunakan 

base plate bertipe jepit sehingga tidak diperlukan ‘release’ di bagian bawah kolom baja. 

Apabila base plate bertipe sendi maka diperlukan ‘release’ agar tidak terjadi momen di pangkal 

bawah kolom baja. 

 

Gambar 2.64. Tipikal Base Plate Bertipe Jepit 
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I. PEMODELAN RAFTER HC.675X200X9/14 

Sebelum memodelkan rafter, hal yang terlebih dahulu perlu dilakukan adalah mengatur 

elevation view di mana rafter akan dimodelkan. Hal tersebut dapat dilakukan dengan cara klik 

opsi View → Set Elevation View → Pilih 1, untuk menampilkan Frame Axis 1 (arah melintang). 

 

 

Gambar 2.65. Masuk Ke Grid 1 
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Gambar 2.66. Tampilan Grid 1 

Untuk memudahkan pemodelan, maka Snap Options perlu diatur agar frame dapat 

dimodelkan dari satu titik tertentu ke titik lain yang dikehendaki. Pengaturan Snap Options 

dapat dilakukan dengan cara klik Draw → Snap Options → aktifkan opsi snap yang diinginkan. 

 

 

Gambar 2.67. Pengaturan Snap Options 



82        Perencanaan Struktur Bangunan Industri dengan Crane 

Modelkan rafter dengan cara klik Draw/Column/Brace (Plan, Elev, 3D) → hubungkan 

rafter dari eaves ke apex (midpoint).  

 

Gambar 2.68. Draw/Column/Brace (Plan, Elev, 3D) 

 

Gambar 2.69. Properti Rafter yang Dimodelkan 

 

Gambar 2.70. Hubungkan Rafter HC.675X200X9/14 ke Bagian Tengah Atap 
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Gambar 2.71. Rafter HC.675X200X9/14 yang Telah Dimodelkan 

Kolom post WF.450X200X9/14 masih belum terhubung dengan rafter atas. Untuk 

menghubungkan kolom post WF.450X200X9/14 dengan rafter HC.675X200X9/14 dapat 

dilakukan dengan opsi ‘Extend Frame.’ Hal tersebut dapat dilakukan dengan cara klik blok 

joint atas dari kolom post → Select kolom post → Select rafter → Allign Joints/Frames/Edges 

→ Extend Frame Objects. 

 

Gambar 2.72. Select Joint Atas Kolom Post 
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Gambar 2.73. Select Frame Kolom Post WF.450X200X9/14 

 

Gambar 2.74. Select Frame Rafter HC.675X200X9/14 

 

Gambar 2.75. Edit → Align Joints/Frames/Edges 
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Gambar 2.76. Extend Frame Objects 

 

Gambar 2.77.  Kolom Post Sudah Terhubung dengan Rafter 

Untuk menggandakan rafter tersebut, select rafter yang akan digandakan → Edit → 

Replicate arah y (dy) → Apply → OK. Proses penggandaan dapat dilakukan baik pada arah x 

atau y maupun arah x dan y secara bersamaan. Hal yang perlu dimasukkan adalah jarak objek 

yang digandakan dari sumber aslinya serta jumlah penggandaan objek. 
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Gambar 2.78. Select Rafter 

 

Gambar 2.79. Edit → Replicate 

 

Gambar 2.80. Input Jarak Serta Jumlah Penggandaan 
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Gambar 2.81. Rafter yang Sudah Di-replicate 

J. PEMODELAN NOK ATAP (RIDGE) WF.300X150X6,5/9 DAN RING BEAM 

WF.300X150X6,5/9 

Nok atap atau biasa disebut ridge diperlukan untuk menghubungkan satu rafter dengan 

rafter yang lainnya. Nok atap dimodelkan menggunakan WF.300X150X6,5/9 dan dihubungkan 

secara sederhana (pinned) antar rafter. Hal ini dilakukan pertemuan nok atap dengan rafter 

dihubungkan melalui gusset plate yang hanya dapat menahan gaya geser dan tidak menahan 

momen. Pemodelan nok atap dapat dilakukan dengan mengatur View Plan terlebih dahulu 

dengan cara klik opsi View → Set Plan View → Pilih +11,65 (Top Atap). WF.300X150X6,5/9 

dapat dihubungkan dari satu titik pertemuan rafter dengan titik yang lain dengan cara klik 

Draw/Column/Brace (Plan, Elev, 3D) → Atur properti yang dikehendaki → Hubungkan frame 

dari satu titik ke titik yang lain. 

 

Gambar 2.82. Pemodelan Nok Atap WF.300X150X6,5/9 
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Pasca satu nok atap selesai dimodelkan, lakukan penggandaan untuk memodelkan nok 

atap pada keseluruhan bangunan dengan cara select ridge yang akan digandakan → Edit → 

Replicate → Input jarak dan jumlah penggandaan → Apply → OK. 

 

Gambar 2.83. Select Ridge → Replicate (dy) 

 

Gambar 2.84. Nok Atap WF.300X150X6,5/9 Berhasil Dimodelkan 

Untuk ring beam WF.300X150X6,5/9 dapat dimodelkan dengan cara yang sama dengan 

pemodelan nok atap. Langkah pertama yang perlu dilakukan adalah klik opsi View → Set Plan 

View → Pilih +9. Modelkan ring beam dengan cara klik Draw/Column/Brace (Plan, Elev, 3D) 

→ Atur properti yang dikehendaki → Hubungkan frame dari satu titik ke titik yang lain. 
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Gambar 2.85. Pemodelan Ring Beam WF.300X150X6,5/9 

Setelah ring beam termodelkan, lakukan penggandaan dengan opsi ‘Replicate.’ Opsi 

untuk menggandakan objek juga dapat dilakukan dengan cara Select objek yang akan 

digandakan → Ctrl + R → Input jarak dan jumlah penggandaan → Apply → OK.  
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Gambar 2.86. Replicate Ring Beam WF.300X150X6,5/9 Arah X 

 

 

Gambar 2.87. Replicate Ring Beam WF.300X150X6,5/9 Arah Y 



Perencanaan Struktur Bangunan Industri dengan Crane  91 

K. PEMODELAN PURLIN CNP.150X50X20X2,3 

Purlin merupakan elemen yang menjadi dudukan dari penutup atap. Meski di depan, 

beban tidak diaplikasikan pada purlin namun pada rafter, elemen purlin tetap perlu dimodelkan 

agar berat sendiri purlin tetap terhitung sebagai beban yang merangka pada rafter. Purlin 

dimodelkan sebagai simply supported beam dengan tipe koneksi sendi sehingga moment 

release perlu di-assign sebagai ‘Pinned.’ 

Untuk memudahkan pemodelan langkah pertama yang perlu dilakukan adalah membagi 

rafter menjadi beberapa bagian. Purlin akan dimodelkan setiap 1,2 m (jarak antar purlin 1,2 m), 

maka rafter akan dibagi sesuai perhitungan sebagai berikut: 

𝐽𝑢𝑚𝑙𝑎ℎ 𝑏𝑎𝑔𝑖𝑎𝑛 =
𝑃𝑎𝑛𝑗𝑎𝑛𝑔 𝑟𝑎𝑓𝑡𝑒𝑟

𝐽𝑎𝑟𝑎𝑘 𝑎𝑛𝑡𝑎𝑟 𝑝𝑢𝑟𝑙𝑖𝑛
 

𝐽𝑢𝑚𝑙𝑎ℎ 𝑏𝑎𝑔𝑖𝑎𝑛 =
15,2

1,2
= 12,69 ~ 13 𝑏𝑢𝑎ℎ 

Sebelum membagi rafter menjadi beberapa bagian, view perlu diatur terlebih dahulu 

dengan cara klik ikon 3D pada ribbon (Set 3D View) → klik ikon Perspective Toggle. 

 

Gambar 2.88. Set 3D View 

 

Gambar 2.89. Perspective Toggle 
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Adapun langkah-langkah untuk membagi rafter menjadi beberapa bagian dapat 

dilakukan dengan cara Select rafter yang akan dibagi → Edit → Edit Frames → Divide Frames 

→ Divide into 13 Frame Objects. 

 

Gambar 2.90. Edit → Edit Frames → Divide Frames 

    

Gambar 2. 91. Input Jumlah Bagian 
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Gambar 2.92. Rafter Terbagi Menjadi 13 Bagian 

Setelah rafter terbagi menjadi 13 bagian, masing-masing joint dari rafter yang telah 

dibagi perlu di-extrude menjadi frames yang merupakan CNP.150X50X20X2,3. Sebelum 

langkah tersebut dilakukan, terlebih dahulu perlu diatur bahwa joint akan di-extrude menjadi 

CNP.150X50X20X2,3. Hal tersebut dapat dilakukan dengan cara klik Draw 

Beam/Column/Brace (Plan, View, 3D) → Atur Properties of Object sesuai pada gambar di 

bawah → Tutup kembali Properties of Object. Dengan demikian joint akan dapat langsung di-

extrude menjadi CNP.150X50X20X2,3. 

 

 

Gambar 2.93. Pengaturan Properties of Object 

Rafter sudah 
terbagi menjadi 

13 bagian. 
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Langkah selanjutnya adalah melakukan ekstrusi joint. Hal tersebut dapat dilakukan 

dengan cara Select masing-masing joint pada rafter → Edit → Extrude → Extrude Joints to 

Frames. Opsi Extrude Joints to Frames dapat mengekstraksi object joint menjadi frames yang 

dikehendaki. Lalu masukkan panjang purlin yang diinginkan yaitu 6 meter pada arah y.  

 

 

Gambar 2.94. Select Joints pada Rafter 

 

Gambar 2.95. Edit → Extrude → Extrude Joints to Frames 

Select joints 
pada rafter 



Perencanaan Struktur Bangunan Industri dengan Crane  95 

 

Gambar 2.96. Input Data yang Dibutuhkan untuk Ekstrusi Joints Menjadi Frames 

Purlin didesain sebagai simply supported beam yang tidak menahan momen di daerah 

tumpuan. Atas dasar tersebut maka bagian pangkal dan ujung purlin perlu di-release dengan 

cara klik Select → Select → Properties → Frame Sections → CNP.150X50X20X2,3 → Assign 

→ Release Partial Fixity → Checklist Moment 22 dan Moment 33 → Apply → OK.  

 

Gambar 2. 97. Select → Select → Properties → Frame Sections 
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Gambar 2.98. Select CNP.150X50X20X2,3 

 

Gambar 2.99. Assign → Release Partial Fixity 
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Gambar 2. 100. Checklist Moment 22 dan Moment 33 

Setelah purlin berhasil dimodelkan pada satu sisi rafter, maka CNP.150X50X20X2,3 

perlu di-replicate secara mirror ke satu sisi yang lain. Hal tersebut dapat dilakukan dengan cara 

klik Ctrl+J untuk Select Previous → Klik Ctrl+R untuk Replicate → Klik Set Plan View pada 

ribbon atas → Select BASE → Lakukan Mirror pada opsi Replicate dengan cara Pick Two 

Points on Model → Hubungkan midpoint pada bagian tengah As 1 bangunan dengan midpoint 

pada bagian tengah As 2 bangunan → Apply → OK. 

 

Gambar 2.101. Klik Ctrl+J → Ctr+R 
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Gambar 2. 102. Set View Plan 

 

Gambar 2.103. Replicate → Mirror → Pick Two Points on Model 
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Gambar 2.104. Purlin Berhasil Dimodelkan pada Dua Sisi Rafter 

Setelah purlin dimodelkan, maka rafter yang sebelumnya dibagi untuk mempermudah 

pemodelan, perlu disatukan kembali dengan cara select rafter yang akan disambung → Edit → 

Edit Frames → Join Frames. 

 

Gambar 2.105. Select Frames Rafter yang Akan Digabungkan 

 

Gambar 2.106. Edit → Edit Frames → Join Frames 
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L. PEMODELAN BRACING 2L.70X70X7 

Pada bangunan industri bracing dibutuhkan untuk menjaga kesetimbangan pada arah 

longitudinal bangunan. Dengan menggunakan X-bracing, bangunan dapat berdiri dengan lebih 

stabil. X-bracing dihubungkan dengan kolom baja WF.600X200X11/17 dengan gusset plate 

sehingga dalam pemodelan hubungan antara X-bracing dan kolom WF.600X200X11/17 perlu 

di-release. Pemodelan X-bracing dapat dilakukan dengan cara mengatur Elevation View 

terlebih dahulu. Klik Set Elevation View pada ribbon bagian atas → Pilih Elevation View A. 

 

Gambar 2.107. Set Elevation View A 

 

Gambar 2.108. Elevation View A 

Modelkan X-bracing dengan cara klik Draw Beam/Column/Brace (Plan, Elev, 3D) pada 

ribbon bagian kiri → Atur Properties of Object sebagaimana gambar di bawah → Hubungkan 

secara diagonal bracing 2L.70X70X7. 
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Gambar 2.109. Draw Beam/Column/Brace (Plan, Elev, 3D) 

 

Gambar 2.110. Pemodelan X-bracing Diagonal Pertama 
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Gambar 2.111. Pemodelan X-bracing Diagonal Kedua 

Dari model X-bracing yang telah dibuat, perlu dilakukan penggandaan pada sisi lain 

dinding bangunan. Hal tersebut dapat dilakukan dengan cara Select X-bracing yang telah dibuat 

→ Klik Ctrl+R untuk Replicate → Klik Set Plan View pada ribbon atas → Select BASE → 

Lakukan Mirror pada opsi Replicate dengan cara Pick Two Points on Model → Hubungkan 

midpoint pada bagian tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 

bangunan → Apply → OK. 

 

Gambar 2.112. Replicate → Mirror → Pick Two Points on Model 
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Gambar 2. 113. X-bracing Sudah Termodel Di Kedua Sisi Bangunan 

X-bracing yang sudah termodelkan perlu direplikasi dengan jarak 12 m dari posisi 

semula searah y. Pilih X-bracing yang telah termodelkan terlebih dahulu. Hal tersebut dilakukan 

dengan cara Select → Select → Properties → Frame Sections → 2L.70X70X7 → Apply → OK.  

Setelah X-bracing yang sebelumnya sudah dimodelkan terpilih, klik Ctrl+R → Input jarak dan 

jumlah replikasi → Apply → OK. 

 

Gambar 2.114. Replicate X-bracing 
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Gambar 2.115. X-bracing Sudah Termodel pada Keseluruhan Bangunan 

M. Pemodelan Runway Beam Crane WF.500X200X10/16 

Runway beam crane didesain duduk di atas bracket kolom. Untuk memodelkan runway 

beam crane tersebut, terlebih dahulu diatur elevation view untuk memodelkan bracket. Klik Set 

Elevation View pada ribbon bagian atas → Pilih Elevation View 1. Buat titik bantuan untuk 

menentukan posisi bracket dengan cara klik Draw → Draw Joint Objects → Atur Properties of 

Object sesuai gambar di bawah → Klik pada top kolom pedestal Grid 1-A. 

 

 

Gambar 2.116. Pemodelan Titik Bantuan 6 m dari Top Pedestal 
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Buat titik bantuan kembali sejauh 0,5 m dari titik yang sebelumnya telah dimodelkan 

dengan cara klik Draw → Draw Joint Objects → Atur Properties of Object sesuai gambar di 

bawah → Klik pada titik bantuan yang dimodelkan sebelumnya. 

 

 

Gambar 2. 117. Pemodelan Titik Bantuan 0,5 m dari Titik yang Dimodelkan Sebelumnya 

Setelah itu modelkan bracket kolom dengan cara klik Draw Beam/Column/Brace (Plan, 

Elev, 3D) pada ribbon bagian kiri → Atur Properties of Object sebagaimana gambar di bawah 

→ Hubungkan antara satu titik dengan titik yang lain sebagaimana gambar di bawah. 

 

Gambar 2.118. Properties of Object Bracket 
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Gambar 2.119. Hubungkan Satu Titik Pangkal Bracket ke Titik yang Lain 

Dari model bracket yang telah dibuat, perlu dilakukan penggandaan pada sisi lain 

berlawanan bangunan. Hal tersebut dapat dilakukan dengan cara Select bracket yang telah 

dibuat → Klik Ctrl+R untuk Replicate → Klik Set Plan View pada ribbon atas → Select BASE 

→ Lakukan Mirror pada opsi Replicate dengan cara Pick Two Points on Model → Hubungkan 

midpoint pada bagian tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 

bangunan → Apply → OK. 

 

Gambar 2.120. Replicate → Mirror → Pick Two Points on Model 

 

Gambar 2.121. Bracket Berhasil Dimodelkan pada Kedua Sisi Bangunan 
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Bracket yang sudah termodelkan perlu direplikasi dengan jarak 6 m dari posisi semula 

searah y dengan jumlah 15 buah. Pilih bracket yang telah termodelkan terlebih dahulu. Hal 

tersebut dilakukan dengan cara drag kursor pada bracket yang telah dimodelkan.  

 

Gambar 2.122. Select Bracket 

Setelah bracket yang sebelumnya sudah dimodelkan terpilih, klik Ctrl+R → Input jarak 

dan jumlah replikasi → Apply → OK. 

 

Gambar 2. 123. Replicate Bracket 
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Gambar 2.124. Bracket Sudah Termodel pada Keseluruhan Bangunan 

Tampilkan bracket yang dimodelkan saja untuk memodelkan runway beam dengan cara 

klik Select → Select → Properties → Frame Sections → WF.500X200X10/16 → Klik kanan 

→ Select Selected Objects Only.  

 

Gambar 2.125.  Tampilan Bracket yang Sudah Dimodelkan dengan Objek Lain yang 

Disembunyikan 

Untuk memodelkan runway beam klik Draw Beam/Column/Brace (Plan, Elev, 3D) pada 

ribbon bagian kiri → Atur Properties of Object sebagaimana gambar di bawah → Hubungkan 

antara satu titik dengan titik yang lain sebagaimana gambar di bawah. 

 

Gambar 2.126. Properties of Object Runway Beam 
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Gambar 2.127. Hubungkan Satu Titik Bracket dengan Titik Bracket yang Lain 

Replikasi runway beam yang telah dibuat dengan cara Select runway beam → Klik 

Ctrl+R untuk Replicate → Klik Set Plan View pada ribbon atas → Select BASE → Lakukan 

Mirror pada opsi Replicate dengan cara Pick Two Points on Model → Hubungkan midpoint 

pada bagian tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 bangunan → 

Apply → OK. 

 

Gambar 2.128. Replicate → Mirror → Pick Two Points on Model 

Runway beam yang sudah termodelkan perlu direplikasi dengan jarak 6 m dari posisi 

semula searah y dengan jumlah 14 buah. Pilih runway beam yang telah termodelkan terlebih 

dahulu. Hal tersebut dilakukan dengan cara drag kursor pada runway beam yang telah 

dimodelkan.  

 

Gambar 2.129. Select Runway Beam 
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Setelah runway beam yang sebelumnya sudah dimodelkan terpilih, klik Ctrl+R → Input 

jarak dan jumlah replikasi → Apply → OK. 

 

Gambar 2.130. Replicate Runway Beam 

  

Gambar 2.131. Runway Beam yang Berhasil Dimodelkan 

Untuk mengantisipasi buckling di bagian top flange runway beam akibat lateral thrust 

dari crane, dipasang lateral truss dari 2L.50X50X5. Untuk memodelkan backing truss tersebut, 

terlebih dahulu runway beam WF.500X200X10/16 di As 1-A hingga 2-A. Divide runway beam 

tersebut menjadi 12 bagian (per bagian memiliki panjang 500 mm).  
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Gambar 2.132. Select Runway Beam 

 

Gambar 2.133. Divide Runway Beam Menjadi 12 Bagian 

Select joint-joint dari runway beam yang sudah terbagi tadi untuk melakukan ekstrusi. 

Terlebih dahulu diatur properti frame dengan cara klik Draw Beam/Column/Brace (Plan, Elev, 

3D) pada ribbon bagian kiri → Atur Properties of Object sebagaimana gambar di bawah → 

Close. Lakukan ekstrusi agar joint dapat berubah menjadi frame dengan cara klik Edit → 

Extrude → Extrude Joints to Frames → Input panjang dan arah ekstrusi → Apply → OK. 

 

Gambar 2.134. Properti dari 2L.50X50X5 yang Akan Diekstrusi 
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Gambar 2.135. Edit → Extrude → Extrude Joints to Frames 

 

Gambar 2.136. Input Jarak dan Jumlah Ekstrusi Backing truss 

Modelkan batang diagonal dan lateral dengan properti frame yang sama dengan cara 

klik Draw Beam/Column/Brace (Plan, Elev, 3D) pada ribbon bagian kiri → Atur Properties of 

Object → Hubungkan antar joint sebagaimana gambar di bawah. 

 

Gambar 2.137. Model Backing truss untuk Runway Beam 
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Gandakan backing truss pada bentang yang telah dibuat dengan cara Select backing 

truss 2L.50.50.5 yang telah dibuat → Klik Ctrl+R untuk Replicate → Klik Set Plan View pada 

ribbon atas → Select BASE → Lakukan Mirror pada opsi Replicate dengan cara Pick Two 

Points on Model → Hubungkan midpoint pada bagian tengah As 1 bangunan dengan midpoint 

pada bagian tengah As 2 bangunan → Apply → OK. 

 

Gambar 2.138. Replicate → Mirror → Pick Two Points on Model 

 

Gambar 2.139. Backing Truss Berhasil Di-Mirror 

Replicate backing truss yang sudah termodelkan dengan jarak 6 m dari posisi semula 

searah y dengan jumlah 14 buah. Pilih backing truss yang telah termodelkan terlebih dahulu 

dengan cara Select → Select → Properties → Frame Sections → 2L.50X50X5 → Apply → 

OK.  Setelah backing truss terpilih, klik Ctrl+R → Input jarak dan jumlah replikasi → Apply 

→ OK. 
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Gambar 2.140. Input Jarak dan Jumlah Replikasi Backing truss 

 

Gambar 2.141. Input Jarak dan Jumlah Replikasi Backing truss 

Untuk ring beam WF.300X150X6,5/9 sebagai penopang backing truss, dapat 

dimodelkan dengan cara yang sama dengan pemodelan frame yang lain. Modelkan ring beam 

dengan cara klik Draw/Column/Brace (Plan, Elev, 3D) → Atur properti yang dikehendaki → 

Hubungkan frame dari satu titik ke titik yang lain. 
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Gambar 2. 142. Pemodelan Ring Beam WF.300X150X6,5/9 Sebagai Penopang Backing Truss 

Mirror ring beam yang telah dibuat dengan cara Select WF.300X150X5,5/8 → Klik 

Ctrl+R untuk Replicate → Klik Set Plan View pada ribbon atas → Select BASE → 

Lakukan Mirror pada opsi Replicate dengan cara Pick Two Points on Model → Hubungkan 

midpoint pada bagian tengah As 1 bangunan dengan midpoint pada bagian tengah As 2 

bangunan → Apply → OK. 

 

Gambar 2.143. Replicate → Mirror → Pick Two Points on Model 

Lakukan penggandaan dengan opsi ‘Replicate’ untuk arah memanjang bangunan. 

Penggandaan objek dilakukan dengan cara Select WF.300X150X5,5/8 → Ctrl + R → Input 

jarak dan jumlah penggandaan → Apply → OK.  
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Gambar 2.144. Input Jarak dan Jumlah Replikasi Ring Beam Penopang Backing Truss 

N. PEMODELAN ROOF BRACING DENGAN ROD 25 MM 

Roof bracing dimodelkan pada bentang di mana X-bracing sudah dimodelkan. Roof 

bracing juga berfungsi sebagai ikatan angin. Roof bracing dimodelkan sebagai steel rod dengan 

diameter 25 mm sebagaimana yang dijelaskan sebelumnya. Pemodelan roof bracing dapat 

dilakukan dengan cara klik Draw Beam/Column/Brace (Plan, Elev, 3D) pada ribbon bagian kiri 

→ Atur Properties of Object sebagaimana gambar di bawah → Hubungkan secara diagonal 

bracing Rod 25 mm. 

 

Gambar 2.145. Properties of Object Rod 25 mm 
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Gambar 2.146. Draw Rod 25 mm Secara Diagonal dari Rafter ke Rafter 

Setelah model roof bracing dengan Rod 25 mm berhasil dibuat pada satu sisi atap, maka 

roof bracing tersebut perlu direplikasi ke sisi yang lain. Hal tersebut dapat dilakukan dengan 

cara Select roof bracing yang telah dibuat → Klik Ctrl+R untuk Replicate → Klik Set Plan 

View pada ribbon atas → Select BASE → Lakukan Mirror pada opsi Replicate dengan cara 

Pick Two Points on Model → Hubungkan midpoint pada bagian tengah As 1 bangunan dengan 

midpoint pada bagian tengah As 2 bangunan → Apply → OK. 

 

Gambar 2.147. Replicate → Mirror → Pick Two Points on Model 
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Gambar 2.148. Roof Bracing Sudah Termodel di Kedua Sisi Bangunan 

Roof bracing yang sudah termodelkan perlu direplikasi dengan jarak 12 m dari posisi 

semula searah y. Pilih roof bracing yang telah termodelkan terlebih dahulu. Hal tersebut 

dilakukan dengan cara Select → Select → Properties → Frame Sections → Rod 25 mm → 

Apply → OK.  Setelah roof bracing yang sebelumnya sudah dimodelkan terpilih, klik Ctrl+R 

→ Input jarak dan jumlah replikasi → Apply → OK. 

 

Gambar 2.149. Replicate Roof Bracing 



Perencanaan Struktur Bangunan Industri dengan Crane  119 

 

Gambar 2.150. Roof Bracing Sudah Termodel pada Keseluruhan Bangunan 

O. PEMODELAN TIE BEAM TB20/30 

Pemodelan elemen tie beam diperlukan agar berat sendiri tie beam ikut terhitung saat 

desain untuk struktur bawah. Pemodelan tie beam dapat dilakukan dengan mengatur View Plan 

terlebih dahulu dengan cara klik ikon Set Plan View pada Ribbon → Select BASE → Apply → 

OK.  

 

Gambar 2.151. View Plan BASE 

Pemodelan tie beam dilakukan dengan cara klik Draw Beam/Column/Brace Objects 

pada ribbon bagian kiri → Tentukan Section Properties Tie Beam → Drag kursor pada area di 

mana tie beam dibutuhkan.  
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Gambar 2.152. Section Properties Tie Beam TB20/30 

 

Gambar 2.153. Draw TB20/30 Di Area yang Dibutuhkan 

 

Gambar 2.154. TB20/30 yang Sudah Berhasil Dimodelkan 
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BAGIAN    

A. PEMBEBANAN PADA BANGUNAN INDUSTRI 

Dalam desain bangunan industri, beban diasumsikan terlebih dahulu berdasarkan 

pertimbangan-pertimbangan teknis yang matang. Beban-beban yang diperhitungkan di 

antaranya adalah beban mati, beban hidup, beban gempa, dan beban angin. Sebuah desain 

struktur dikatakan aman apabila memiliki kapasitas yang lebih besar dari beban yang ada 

sehingga struktur kuat menopang beban tersebut. 

B. PEMBUATAN LOAD PATTERN 

Load pattern (pola beban) merupakan distribusi spasial dari serangkaian gaya, 

perpindahan, suhu, dan pengaruh lain tertentu yang bekerja pada suatu struktur. Kombinasi 

sambungan dan elemen apa pun dapat dipengaruhi oleh kondisi pembebanan dan kinematik. 

Setiap pola beban diberi tipe desain (DEAD, SUPER DEAD, WIND, SEISMIC, dll.) yang 

mengklasifikasikan tipe beban yang diaplikasikan dan dikomputasikan sesuai tipe beban yang 

didefinisikan. Dalam ETABS, penentuan load pattern dapat dilakukan dengan cara klik Define 

– Load Patterns. Masukan semua jenis beban seperti gambar di bawah. 

 

 

Gambar 3.1. Load Pattern Definition 

3 
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C. PERHITUNGAN BEBAN MATI (DEAD LOAD) 

Beban mati tambahan merupakan beban yang bekerja pada seluruh atap. Beban ini 

terdiri dari beban mati, beban mati tambahan, berat sendiri struktur, berat finishing arsitektur 

dan berat ducting/kabel/pipa M/E dimasukkan serta beban lain yang diperhitungankan sebagai 

beban tetap pada struktur.  

Superimposed Dead Load (SIDL)       

Berat sendiri struktur      (Dihitung oleh program) 

Penutup atap (t = 0,55 mm + Insulasi)   = 6 kg/m2 

ME & Lampu       = 9 kg/m2 + 

         15 kg/m2 

Beban SIDL pada atap = 15 kg/m2 

Pada ETABS beban mati dalam hal ini berat sendiri struktur dapat dihitung secara 

otomatis begitu berat jenis material di-input saat pendefinisian material. Untuk beban kolateral 

atau beban mati tambahan, beban dapat di-input sebagai beban garis pada rafter. Beban area 

perlu dikonversi dahulu menjadi beban garis sebagaimana perhitungan di bawah. 

Untuk rafter di bagian tengah 

Jarak antar portal, a = 6  m 

Panjang rafter, b = 15,23 m 

 Area yang dilayani = a*b 

 Beban garis, q SIDL = (q*(a*b))/b 

    = q*a 

    = 15*6 

    = 90 kg/m 

Untuk rafter di bagian tepi 

Jarak antar portal, a = 3  m 

Panjang rafter, b = 15,23 m 

 Area yang dilayani = a*b 

 Beban garis, q SIDL = (q*(a*b))/b 

    = q*a 

    = 15*3 

    = 45 kg/m 

Secara sederhana konversi beban area ke beban garis dapat dilakukan dengan 

mengalikan beban area dan bentang portal untuk rafter tengah, serta beban area dan setengah 

bentang portal untuk rafter tepi. 

Untuk rafter di bagian tengah 

Jarak antar portal, a = 6  m 

Beban garis, q SIDL = q*a 

   = 15*6 

   =  90 kg/m 
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Untuk rafter di bagian tepi 

Jarak antar portal, a = 6  m 

Beban garis, q SIDL = q*0,5*a 

   = 15*0,5*6 

   =  45 kg/m 

Beban di-input sebagai beban garis pada ETABS dengan cara klik Select → Select → 

Properties → Frame Sections → HC.675X200X9/14 → Klik kanan → Show Selected Objects 

Only. 

 

 

Gambar 3.2. Select HC.675X200X9/14 
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Gambar 3.3. Show HC.675X200X9/14 Only 

Terlebih dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag kursor 

untuk memilih rafter yang akan diaplikasikan beban SIDL 90 kg/m. Setelah rafter terpilih maka 

klik Assign → Frame Load → Distributed → Load Pattern Name = SIDL → Uniform Load = 

90 kg/m. Lakukan hal yang sama terhadap rafter bagian tepi dengan Input besaran beban SIDL 

= 45 kg/m. 

 
Gambar 3.4. Assign → Frame Loads → Distributed 

 
Gambar 3.5. SIDL 90 kg/m untuk Rafter Tengah dan 45 kg/m untuk Rafter Tepi 

SIDL 45 kg/m 
untuk rafter 

tepi 

SIDL 90 kg/m 
untuk rafter 
tengah 
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Gambar 3.6. SIDL 90 kg/m untuk Rafter Tengah 

 

Select portal 
tengah 

Select portal 
tepi 
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Gambar 3.7. SIDL 45 kg/m untuk Rafter Tepi 

D. PERHITUNGAN BEBAN HIDUP ATAP (ROOF LIVE LOAD) 

Besaran beban hidup dan reduksi beban hidup mengikuti ketentuan SNI 1727-2020, 

Beban desain minimum dan kriteria terkait untuk bangunan gedung dan struktur lain. 

Beban hidup pada atap = 60 kg/m2 

Untuk beban hidup, beban dapat di-input sebagai beban garis pada rafter. Beban area perlu 

dikonversi dahulu menjadi beban garis sebagaimana perhitungan di bawah. 

Untuk rafter di bagian tengah 

Jarak antar portal, a = 6  m 

Panjang rafter, b = 15,23 m 

 Area yang dilayani = a*b 

 Beban garis, q Lr = (q*(a*b))/b 

    = q*a 

    = 60*6 

    = 360 kg/m 

Untuk rafter di bagian tepi 

Jarak antar portal, a = 3  m 

Panjang rafter, b = 15,23 m 

 Area yang dilayani = a*b 

 Beban garis, q Lr = (q*(a*b))/b 

    = q*a 

    = 60*3 

    = 180 kg/m 

Secara sederhana konversi beban area ke beban garis dapat dilakukan dengan mengalikan 

beban area dan bentang portal untuk rafter tengah, serta beban area dan setengah bentang 

portal untuk rafter tepi. 

Untuk rafter di bagian tengah 

Jarak antar portal, a = 6  m 

Beban garis, q Lr = q*a 

   = 60*6 

   =  360 kg/m 
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Untuk rafter di bagian tepi 

Jarak antar portal, a = 6  m 

Beban garis, q Lr = q*0,5*a 

   = 60*0,5*6 

   =  180 kg/m 

Sebagaimana aplikasi beban mati dan SIDL pada rafter, beban hidup di-input dengan 

cara yang sama dengan besaran yang berbeda pada rafter yang telah dimodelkan. Terlebih 

dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag kursor untuk memilih 

rafter yang akan diaplikasikan beban hidup 360 kg/m. Setelah rafter terpilih maka klik Assign 

→ Frame Load → Distributed → Load Pattern Name = Lr → Uniform Load = 360 kg/m. 

Lakukan hal yang sama terhadap rafter bagian tepi dengan input besaran beban hidup = 180 

kg/m. 

 

Gambar 3.8. Beban Lr 360 kg/m untuk Rafter Tengah dan 180 kg/m untuk Rafter Tepi 

 

Lr 180 kg/m 
untuk rafter 

tepi 

Lr 360 kg/m 
untuk rafter 
tengah 

Select portal 
tengah 
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Gambar 3.9. Beban Lr 360 kg/m untuk Rafter Tengah 

 

 

Gambar 3.10. Beban Lr 180 kg/m untuk Rafter Tepi 

 

 

 

Select portal 
tepi 
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E. PERHITUNGAN BEBAN HUJAN (RAIN LOAD) 

Beban akibat genangan air hujan dapat dihitung berdasarkan persamaan yang ada di 

bagian 2 dengan detail perhitungan sebagai berikut: 

Sudut atap, 𝛼  = 10 derajat 

Beban hujan, R = 40-0,8*10 

   = 32 kg/m^2 < 20 kg/m^2 

Maka beban akibat genangan air hujan diambil sebesar 20 kg/m^2. 

Secara sederhana konversi beban area ke beban garis dapat dilakukan dengan mengalikan 

beban area dan bentang portal untuk rafter tengah, serta beban area dan setengah bentang 

portal untuk rafter tepi. 

Untuk rafter di bagian tengah 

Jarak antar portal, a = 6  m 

Beban garis, q R = q*a 

   = 20*6 

   =  120 kg/m 

Untuk rafter di bagian tepi 

Jarak antar portal, a = 6  m 

Beban garis, q R = q*0,5*a 

   = 20*0,5*6 

   =  60 kg/m 

Sebagaimana aplikasi beban-beban sebelumnya pada rafter, beban hujan di-input 

dengan cara yang sama dengan besaran yang berbeda pada rafter yang telah dimodelkan. 

Terlebih dahulu akan diaplikasikan beban pada rafter bagian tengah, maka drag kursor untuk 

memilih rafter yang akan diaplikasikan beban hujan 120 kg/m. Setelah rafter terpilih maka klik 

Assign → Frame Load → Distributed → Load Pattern Name = R → Uniform Load = 120 kg/m. 

Lakukan hal yang sama terhadap rafter bagian tepi dengan input besaran beban hujan = 60 

kg/m. 

 

Gambar 3.11. Beban Hujan 120 kg/m untuk Rafter Tengah dan 60 kg/m untuk Rafter Tepi 

Rain 60 kg/m 
untuk rafter 

tepi 

Rain 120 kg/m 
untuk rafter 
tengah 
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Gambar 3.12. Beban Hujan 120 kg/m untuk Rafter Tengah 

 

Select portal 
tengah 

Select portal 
tepi 
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Gambar 3.13. Beban Hujan 60 kg/m untuk Rafter Tepi 

F. PERHITUNGAN BEBAN ANGIN (WIND LOAD) 

Perhitungan angin untuk struktur warehouse yang direncanakan dilakukan 

menggunakan metode yang disederhanakan untuk bangunan bertingkat rendah berdasarkan SNI 

1727-2020: 

Data-data Awal Bangunan 

Kec. Angin, V  = 39,1 m/s  (TPKB Jakarta) 

Kategori Risiko   = II  (Table 1.5-1 Risk Category) 

Kategori Eksposur = C  (Sect. 26.7) 

Tinggi Ujung Atap, hr = 11,65 m  (hr >= he) 

Tinggi dinding, he  = 9,00 m  (he <= hr) 

Lebar Bangunan = 30 m  (Tegak lurus nok atap) 

Panjang Bangunan  = 90 m  (Pararel terhadap nok atap) 

Faktor Topografi  = Gable  (Gable atau Miring Sepihak) 

Kzt    = 1,00  (Sect. 26.8 & Figure 26.8-1) 

Kd    = 0,85  (Table 26.6) 

Bangunan tertutup?  YA  (Sect. 26.2 & Table 26.11-1) 

Parameter dan Koefisien yang Digunakan 

Sudut atap, θ    = 𝑇𝐴𝑁−1 ∗ (
11,65−9

30

2

) 

= 10 derajat 

Rata-rata tinggi atap, h  = (h = (hr+he)/2, untuk sudut atap >10 derajat) 

     = h = he, untuk sudut atap <= 10 derajat 

     = 9  m 

Tinggi atap, h <= 60’ (18 m) = YA 

h <= L atau B   = YA 

Karena bangunan memenuhi dua kriteria di atas, maka bangunan termasuk kriteria bangunan 

low-rise. 
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Koefisien Tekanan Internal Positif & Negatif, GCpi (Table 26.13-1): 

 

Gambar 3.14. Penentuan Koefisien Tekanan Internal 

Tekanan internal positif, +Gcpi  = 0,18 

Tekanan internal positif, -Gcpi  = -0,18 

Koefisien eksposur tekanan velositas Kz: 

Bangunan masuk ke dalam kategori eksposur C, sehingga nilai α dan Zg, dapat diambil sebagai 

berikut: 

 

Gambar 3.15. Penentuan Koefisien Eksposur Tekanan Velositas 

α = 9,5 

Zg = 274,32 

Untuk 15 ft ≤ z ≤ zg = 𝐾𝑧 = 2,01 ∗ (
𝑧

𝑧𝑔
)

2

𝛼
 

= 𝐾𝑧 = 2,01 ∗ (
9

274,32
)

2

10
= 0,98 

Tekanan Velositas 

Tekanan velositas angin ditentukan berdasarkan parameter-parameter yang telah ditentukan 

sebelumnya dengan persamaan sebagai berikut: 

𝑞𝑧 = 0,613 ∗ 𝐾𝑧 ∗ 𝐾𝑧𝑡 ∗ 𝐾𝑑 ∗ 𝐾𝑒 ∗ 𝑉2 

𝑞𝑧 = 0,613 ∗ 0,98 ∗ 1 ∗ 0,85 ∗ 1 ∗ 39,12 = 779,84  𝑁/𝑚^2 

Lebar Zona Ujung Dinding dan Atap 'a' dan '2*a' 

Bentang minimum L atau B = 30,00 m 

0.1*(L atau B)   = 3,00 m 

0.4*h    = 4,13 m 

0.1*(L atau B) < 0,4.h  = 3,00 m 

0.04*(L, B)   = 1,20 m 

0.1*(L atau B) > 0.04*(L, B) = 3,00 m 

0.1*(L atau B) > 0.9 m  = 3,00 m 
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Maka zona ujung, a  = 3,00 m 

'2*a'     = 6,00 m 

Beban Angin 

Beban angin ditentukan dengan persamaan sebagai berikut: 

𝑝 =  𝑞ℎ ∗ [(𝐺𝐶𝑝𝑓) − (𝐺𝐶𝑝𝑖)] 

Dengan koefisien tekanan eksternal yang telah diperhitungkan, Gcpi dan Gcpf, sesuai pada 

Gambar 28.3-1 SNI 1727-2020, rekapitulasi perhitungan tekanan angin untuk masing-masing 

kasus dan sisi adalah sebagai berikut: 

Tabel 3.1. 

Beban Angin SPGAU untuk Kasus A dan B 

Beban Angin SPGAU for Kasus A Beban Angin SPGAU for Kasus B 

Permukaan GCpf 

p = Net 

Pressures 

(𝑁/𝑚^2) 

 Permukaan *GCpf 

p = Net 

Pressures 

(𝑁/𝑚^2) 

 

  (w/ +GCpi) (w/ -GCpi)   (w/ +GCpi) 
(w/ -

GCpi) 

Zona 1 0,44 205 486 Zona 1 -0,45 -491 -211 

Zona 2 -0,69 -678 -398 Zona 2 -0,69 -678 -398 

Zona 3 -0,41 -457 -177 Zona 3 -0,37 -429 -148 

Zona 4 -0,34 -403 -122 Zona 4 -0,45 -491 -211 

Zona 5 --- --- --- Zona 5 0,40 172 452 

Zona 6 --- --- --- Zona 6 -0,29 -367 -86 

Zona 1E 0,67 385 665 Zona 1E -0,48 -515 -234 

Zona 2E -1,07 -975 -694 Zona 2E -1,07 -975 -694 

Zona 3E -0,58 -595 -314 Zona 3E -0,53 -554 -273 

Zona 4E -0,50 -530 -249 Zona 4E -0,48 -515 -234 

Zona 5E --- --- --- Zona 5E 0,61 335 616 

Zona 6E --- --- --- Zona 6E -0,43 -476 -195 

 

 

 

Gambar 2.155. Beban Angin SPGAU Kasus A, Transversal 
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Gambar 2.156. Beban Angin SPGAU Kasus B, Longitudinal 

Beban angin baik untuk arah transversal maupun longitudinal di-input pada struktur 

sebagai beban garis dengan mengalikan tekanan angin dengan area tributari yang dilayani. Hal 

tersebut dapat dilakukan dengan cara klik rafter yang akan di-assign beban terpilih maka klik 

Assign → Frame Load → Distributed → Load Pattern Name = Wx(+)/Wx(-)/Wy(+)/Wy(-) → 

Uniform Load = Input besaran beban. Beban yang diaplikasikan pada struktur bangunan yang 

didesain ada pada gambar di bawah ini. 

 

Gambar 3.16. Beban Angin Transversal +GCpi 
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Gambar 3.17. Beban Angin Transversal -GCpi 

 

 

Gambar 3.18. Beban Angin Longitudinal +GCpi 
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Gambar 319. Beban Angin Longitudinal -GCpi 

Untuk beban servis, kecepatan angin yang dgunakan adalah 32 m/s. Dengan tata cara 

perhitungan yang sama dengan apa yang diuraikan sebelumnya, didapatkan beban tekanan 

angin SPGAU pada tabel di bawah. 

Tabel 3.2. 

Beban Angin SPGAU untuk Kasus A dan B (Kondisi Servis) 

Beban Angin SPGAU for Kasus A Beban Angin SPGAU for Kasus B 

Permukaan GCpf 

p = Net 

Pressures 

(𝑁/𝑚^2)   Permukaan *GCpf 

p = Net 

Pressures 

(𝑁/𝑚^2)   

    

(w/ 

+GCpi) 

(w/ -

GCpi) 
  (w/ +GCpi) 

(w/ -

GCpi) 

Zona 1 0,44 137 326 Zona 1 -0,45 -329 -141 

Zona 2 -0,69 -454 -266 Zona 2 -0,69 -454 -266 

Zona 3 -0,41 -306 -118 Zona 3 -0,37 -287 -99 

Zona 4 -0,34 -270 -82 Zona 4 -0,45 -329 -141 

Zona 5 --- --- --- Zona 5 0,40 115 303 

Zona 6 --- --- --- Zona 6 -0,29 -245 -57 

Zona 1E 0,67 258 446 Zona 1E -0,48 -345 -157 

Zona 2E -1,07 -653 -465 Zona 2E -1,07 -653 -465 

Zona 3E -0,58 -399 -211 Zona 3E -0,53 -371 -183 

Zona 4E -0,50 -355 -167 Zona 4E -0,48 -345 -157 

Zona 5E --- --- --- Zona 5E 0,61 225 413 

Zona 6E --- --- --- Zona 6E -0,43 -319 -131 
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BAGIAN 

 

A. PERHITUNGAN BEBAN GEMPA (SEISMIC LOAD) 

Beban gempa dihitung dan disesuaikan dengan tata cara perhitungan beban gempa yang 

terdapat pada uraian di Bagian 1. Beban gempa yang digunakan pada struktur ini merupakan 

bebam gempa statik yang dihitung berdasarkan gaya geser dasar bangunan. Tahapan-tahapan 

penentuan beban gempa akan disajikan pada Bagian 4 ini. 

B. KATEGORI RISIKO 

Kategori risiko bangunan ini ditentukan berdasarkan fungsi bangunan. Bangunan yang 

direncanakan berfungsi sebagai bangunan pabrik yang memiliki kategori risiko II. 

C. FAKTOR KEUTAMAAN GEMPA 

Setelah kategori risiko bangunan ditentukan berdasarkan jenis pemanfaatan bangunan. 

Maka, faktor keutamaan gempa sebagai salah satu parameter untuk menentukan besarnya beban 

gempa dapat ditentukan berdasarkan Tabel 4 SNI 1726-2019 tentang faktor keutamaan gempa. 

Faktor keutamaan gempa untuk bangunan yang direncanakan adalah 1,00. 

D. PENENTUAN KELAS SITUS 

Kelas situs ditentukan berdasarkan SNI 1726-2019 berdasarkan data penyelidikan tanah 

yang tersedia. Pada proyek ini, hanya diketahui satu jenis data penyelidikan tanah yang 

digunakan untuk menentukan kelas situs, yaitu berupa data N-SPT. Terdapat tiga data N-SPT 

yang dapat dilihat pada bagian lampiran. Berdasarkan SNI 1726-2019 apabila hanya 

memperhitungkan satu jenis data tanah, maka kelas situs yang digunakan adalah kelas situs 

yang paling rendah sesuai ketentuan yang terdapat pada SNI 1726- 2019. Namun pada 

perhitungan ini, penentuan kelas situs murni berdasarkan nilai yang diperoleh dari data N-SPT. 

Analisis data N-SPT untuk penentuan kelas situs disajikan pada tabel sebagai berikut. 

4 
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Gambar 4.1 Hasil Pengujian Tanah pada BH 1, BH 2, dan BH 3 
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Tabel 4.1. 

Klasifikasi Situs Berdasarkan BH-1 

Depth 

(m) 

N-

SPT 
Ni di di/Ni 

0 0       

    12,5 1,5 0,120 

1,5 25       

    24 1,5 0,063 

3 23       

    21,5 1,5 0,070 

4,5 20       

    20,5 1,5 0,073 

6 21       

    22,5 1,5 0,067 

7,5 24       

    24 1,5 0,063 

9 24       

    42 1,5 0,036 

10,5 60       

    48 1,5 0,031 

12 36       

    36 1,5 0,042 

13,5 36       

    33,5 1,5 0,045 

15 31       

    30,5 1,5 0,049 

16,5 30       

    28,5 1,5 0,053 

18 27       

    26 1,5 0,058 

19,5 25       

    26,5 1,5 0,057 

21 28       

    30,5 1,5 0,049 

22,5 33       

    31,5 1,5 0,048 

24 30       

    34 1,5 0,044 

25,5 38       

    49 1,5 0,031 

27 60       

    42,5 1,5 0,035 

28,5 25       

    28,5 1,5 0,053 

30 32       

Total 30 1,084 

Nrerata 27,7 
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Tabel 4.2. 

Klasifikasi Situs Berdasarkan BH-2 

Depth 

(m) 
N-SPT Ni di di/Ni 

0 0       

    6 1,5 0,250 

1,5 12       

    17 1,5 0,088 

3 22       

    18 1,5 0,083 

4,5 14       

    29,5 1,5 0,051 

6 45       

    32,5 1,5 0,046 

7,5 20       

    26,5 1,5 0,057 

9 33       

    37 1,5 0,041 

10,5 41       

    50 1,5 0,030 

12 59       

    49 1,5 0,031 

13,5 39       

    38 1,5 0,039 

15 37       

    39 1,5 0,038 

16,5 41       

    38,5 1,5 0,039 

18 36       

    39,5 1,5 0,038 

19,5 43       

    51,5 1,5 0,029 

21 60       

    60 1,5 0,025 

22,5 60       

    40,5 1,5 0,037 

24 21       

    24,5 1,5 0,061 

25,5 28       

    34,5 1,5 0,043 

27 41       

    42,5 1,5 0,035 

28,5 44       

    37,5 1,5 0,040 

30 31       

Total 30 1,102 

Nrerata 27,2 
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Tabel 4.3. 

Klasifikasi Situs Berdasarkan BH-3 

Depth 

(m) 
N-SPT Ni di di/Ni 

0 0       

    4 1,5 0,375 

1,5 8       

    15 1,5 0,100 

3 22       

    23 1,5 0,065 

4,5 24       

    31,5 1,5 0,048 

6 39       

    33 1,5 0,045 

7,5 27       

    34 1,5 0,044 

9 41       

    34,5 1,5 0,043 

10,5 28       

    35,5 1,5 0,042 

12 43       

    38,5 1,5 0,039 

13,5 34       

    35,5 1,5 0,042 

15 37       

    41 1,5 0,037 

16,5 45       

    47 1,5 0,032 

18 49       

    54 1,5 0,028 

19,5 59       

    59,5 1,5 0,025 

21 60       

    60 1,5 0,025 

22,5 60       

    48 1,5 0,031 

24 36       

    48 1,5 0,031 

25,5 60       

    60 1,5 0,025 

27 60       

    60 1,5 0,025 

28,5 60       

    42 1,5 0,036 

30 24       

Total 30 1,139 

Nrerata 26,3 

 

Berdasarkan analisis data N-SPT, diperoleh nilai tahanan penetrasi standar rata-rata 

tanah dalam lapisan 30 m paling atas (N̅) pada masing-masing titik bore log adalah sebagai 

berikut. 
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N̅1 = 27,7 

N̅2 = 27,2 

N̅3 = 26,3 

Dikarenakan nilai N̅ pada masing-masing titik bore log masih berada dalam rentang 15 

sampai dengan 50, maka dapat disimpulkan bahwa kelas situs pada lokasi proyek termasuk 

dalam kelas situs tanah sedang (SD). 

E. PERCEPATAN SPEKTRAL DESAIN 

Grafik respon spektrum didesain berdasarkan SNI 1726-2019, yaitu dengan bantuan 

software respon spektrum analisis yang dikembangkan oleh Kementrian PUPR. Data yang 

diperlukan untuk menjalankan software ini adalah lokasi proyek dan kelas situs pada lokasi 

proyek. Berdasarkan data yang diketahui, lokasi proyek berada pada garis bujur 

110.2530462715303° dan garis lintang -7.38552414668211°, sedangkan kelas situs pada lokasi 

proyek telah diketahui berdasarkan perhitungan di subbab sebelumnya, yaitu termasuk dalam 

kelas situs tanah sedang (SD). Sehingga, diperoleh grafik respon spektrum sebagai berikut. 

 

Gambar 4.2. Grafik Respon Spektrum pada Lokasi Proyek 

Selain grafik respon spektrum, software respon spektum analisis juga dapat 

mengeluarkan data-data lain yang mendukung perhitungan beban gempa. Data-data tersebut 

adalah sebagai berikut: 

SS = 0.774412 g 

S1 = 0.374278 g 

TL = 20 detik 

Fa = 1.190235 

Fv = 1.925722 

SMS = 0.921732 g 

SM1 = 0.720755 g 

SDS = 0.614488 g 

SD1 = 0.480504 g 

T0 = 0.156391 detik 

Ts = 0.781957 detik 
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F. PENENTUAN KATEGORI DESAIN SEISMIK 

Kategori desain seismik ditentukan berdasarkan Tabel 8 dan 9 SNI 1726-2019. 

Berdasarkan data yang telah diperoleh yang telah disesuaikan dengan ketentuan yang ada pada 

SNI 1726-2019, maka dapat disimpulkan bahwa struktur ini termasuk dalam Kategori Desain 

Seismik D (KDS D). 

 

 
Gambar 4.3. Pemilihan Kategori Desain Seismik 

G. SISTEM STRUKTUR 

Sistem struktur yang digunakan harus disesuaikan dengan Tabel 12 SNI 1726-2019. 

Pada bangunan industri, biasanya pada arah melintang digunakan sistem struktur rangka baja 

pemikul momen biasa, sementara pada arah memanjang digunakan sistem rangka baja dengan 

bresing konsentris biasa. Sistem rangka baja dengan bresing konsentris biasa mengandalkan 

rangka baja dengan kombinasi bracing menggunakan profil double angle. Namun tidak semua 

bentang arah memanjang menggunakan sistem rangka baja dengan bresing konsenstris biasa. 

Bentang yang tidak menggunakan sistem ini, bertugas untuk menahan beban gravitasi saja dan 

tidak ikut menahan gaya lateral. 

Untuk KDS D, penggunaan sistem struktur rangka baja pemikul momen biasa diizinkan 

berdasarkan Pasal 7.2.5.6. SNI 1726-2019 untuk struktur yang didesain 1 tingkat dengan beban 

tributari atap tidak lebih dari 0,96 kN/m^2. Ketinggian diizinkan untuk ditambahkan hingga 20 

m. Sementara itu penggunaan struktur sistem rangka baja dengan bresing konsentris biasa 

diizinkan pada bangunan satu tingkat hingga ketinggian 18 m dengan beban mati atap tidak 

melebihi 0,96 kN/m^2. 

 

 

Gambar 4.4. Pemilihan Sistem Struktur 
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Sistem Rangka Baja Pemikul Momen Biasa (Arah Transversal) 

Koefisien modifikasi respons (R) = 3,5 

Faktor kuat lebih (Ω0)   = 3 

Faktor pembesaran defleksi (Cd) = 3 

Sistem Rangka Baja dengan Bresing Konsentris Biasa (Arah Longitudinal) 

Koefisien modifikasi respons (R) = 3,25 

Faktor kuat lebih (Ω0)   = 2 

Faktor pembesaran defleksi (Cd) = 3,25 

H. PERHITUNGAN PERIODE FUNDAMENTAL STRUKTUR 

Periode hasil analisis struktur perlu dibatasi untuk perhitungan gaya geser dasar statik 

oleh beberapa koefisien dan parameter yang telah ditetapkan sesuai pada Tabel 17 dan 18 SNI 

1726-2019 Koefisien dan parameter yang dimaksud adalah sebagai berikut: 

Periode pada Arah Melintang (OMF) 

Cu = 1,4 

Ct = 0,0724 

x  = 0,8 

Perhitungan periode struktur dapat dijabarkan sebagai berikut: 

Tinggi bangunan (seismik)   h = 9 m 

Periode Fundamental Pendekatan Ta = Ct × hx 

      = 0,42 detik 

Periode maksimum   Tmax = Cu × Ta 

      = 0,588 detik 

Periode pada Arah Memanjang (OCBF) 

Cu = 1,4 

Ct = 0,0488 

x  = 0,75 

Perhitungan periode struktur dapat dijabarkan sebagai berikut: 

Tinggi bangunan (seismik)   h = 9 m 

Periode Fundamental Pendekatan Ta = Ct × hx 

      = 0,254 detik 

Periode maksimum   Tmax = Cu × Ta 

      = 0,355 detik 

Hasil perhitungan periode fundamental struktur perlu dibandingkan dengan hasil analisis 

periode fundamental melalui bantuan ETABS. Dari hasil analisis diperoleh periode sebagai 

berikut: 

Periode hasil analisis arah-x  Tc, x = 0,533 detik 

Periode hasil analisis arah-y  Tc, y = 0,637 detik 

Dikarenakan periode hasil analisis (Tc) lebih besar dari periode maksimum (Tmax), maka periode 

struktur yang digunakan adalah sebagai berikut: 

Periode pakai arah-x   Tx = 0,588 detik 

Periode pakai arah-y   Ty = 0,355 detik 
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I. PERHITUNGAN GAYA GESER DASAR SEISMIK 

Gaya geser dasar seismik dengan metode statik ekivalen (V) untuk arah-x dan arah-y 

dihitung berdasarkan pada Pasal 7.8. SNI 1726-2019. Gaya geser dasar seismik dihitung 

berdasarkan persamaan Persamaan 30 pada SNI 1726-2019. Massa seismik efektif struktur 

yang dihitung antara lain adalah sebagai berikut: 

1. Berat sendiri struktur  = Dihitung oleh program 

2. Beban SIDL (Atap + M/E) = 15  kg/m^2 

3. Dinding termasuk girt  = 15  kg/m^2 

4. Beban rel crane + M/E  = 70  kg/m’ 

5. Berat crane + trolley & hoist = 10966 + 839,1 kg 

= 11805,1 kg 

Perhitungan Koefisien Respon Seismik Arah Transversal (OMF) 

Koefisien respon seismik (CS)  =  SDS/(R/Ie) 

     =  0,614488/(3/1,25) 

     =  0,205 

Nilai CS perlu dicek terhadap batas atas batas bawah. Untuk batas atas dikarenakan nilai 

T kurang dari atau sama dengn TL, maka digunakan Persamaan 32 SNI 1726-2019. Sedangkan, 

untuk batas bawah dikarenakan nilai S1 lebih kecil dari 0,6. Maka, Persamaan 35 SNI 1726-

2019 tidak perlu diperhitungkan. 

Batas atas, CS max =  SD1/(T×(R/Ie) 

   =  0,271 

Batas bawah, CS min =  0,044×SDS×Ie >  0,01 

   =  0,027  >  0,01 

   =  0,027 

Dikarenakan nilai CS min < CS < CS max, maka nilai CS yang digunakan adalah sebagai berikut: 

Koefisien respon seismik pakai arah transversal, Cs  = 0,205 

Perhitungan Koefisien Respon Seismik Arah Longitudinal (OCBF) 

Koefisien respon seismik (CS)  =  SDS/(R/Ie) 

     =  0,614488/(3,35/1,25) 

     =  0,189 

Nilai CS perlu dicek terhadap batas atas batas bawah. Untuk batas atas dikarenakan nilai T 

kurang dari atau sama dengn TL, maka digunakan Persamaan 32 SNI 1726-2019. Sedangkan, 

untuk batas bawah dikarenakan nilai S1 lebih kecil dari 0,6. Maka, Persamaan 35 SNI 1726-

2019 tidak perlu diperhitungkan. 

Batas atas, CS max =  SD1/(T×(R/Ie) 

   =  0,251 

Batas bawah, CS min =  0,044×SDS×Ie >  0,01 

   =  0,027  >  0,01 

   =  0,027 

Dikarenakan nilai CS min < CS < CS max, maka nilai CS yang digunakan adalah sebagai berikut: 

Koefisien respon seismik pakai arah longitudinal, Cs = 0,189 
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Perhitungan Berat Seismik Efektif Arah Transversal 

Berat seismik efektif struktur dihitung berdasarkan massa efektif struktur yang diperoleh dari 

program dengan kombinasi 100% beban mati dan beban mati tambahan. Pada perhitungan berat 

seismik efektif untuk bangunan industri, beban dinding pada arah yang pararel terhadap arah 

yang ditinjau bisa diabaikan dengan asumsi bahwa dinding ikut menahan gaya lateral searah 

bidang. Selain itu dinding yang dihitung sebagai massa juga hanya separuh dari seluruh luasan 

yang dihitung. Pada proyek ini, beban dinding dihitung secara keseluruhan untuk memberikan 

gaya gempa yang lebih konservatif. Perhitungan berat seismik efektif struktur ditampilkan 

sebagai berikut. 

Perhitungan Berat Seismik Efektif untuk Portal Ujung 

Luas bangunan yang ditinjau   = (3+3)*30 (Portal ujung saja) 

       = 180  m^2 

Sudut atap, α     = 10  derajat 

Luas atap yang ditinjau    = Luas bangunan/Cos (α) 

       = 180/Cos (10) 

       = 182,8  m^2 

SIDL pada Atap     = 15  kg/m^2 

Total SIDL     = 15*182,8 

       = 2741,7  kg 

Berat dinding + girts (long.)   = Luas*Beratdinding + girts*nsisi 

= (6*9*0,5*15)*2 

       = 810  kg 

 

Berat dinding + girt (ujung)   = Luas*Beratdinding + girt*nsisi 

= ((30*9*0,5*15) + (2,65*30*0,5*15))*2 

       = 5242,5  kg 

Total berat dinding + girt   = 6052,5  kg 

Panjang runway beam    = 6  m 

Berat total rel + M/E    = 70*6 

= 420  kg 

Berat crane     = 11805,1 kg 

Berat crane + hoist untuk 2 portal  = (2/16)*11805,1 

       = 1475,6  kg 

Berat sendiri struktur untuk portal tepi  = 12802,6 kg 

Berat seismik efektif, W  = Dead Load + SIDL + Crane 

      = 12802,6 + (2741,7 + 6052,5 + 420) + 1475,6 

      = 23492,4 kg 

Gaya geser dasar seismik arah transversal, Vx = CS*W  

       = 0,205*23492,4   

       = 4815,9 kg 

       = 48,2 kN 

Jumlah portal yang ditinjau, nPortal  = 2 

Gaya geser dasar per portal, Vx   = 24,1 kN 
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Beban lateral gempa diaplikasikan pada dua titik yaitu pada bagian pangkal portal dan pada 

bagian ujung portal (As A dan As D). 

Beban diaplikasikan pada 2 titik   = 24,1/2  kN 

       = 12,0  kN 

Gaya lateral akibat gempa pada arah x untuk portal ujung di-input pada top kolom dengan 

cara Select joint kolom sebagaimana gambar di bawah → Assign → Joint Loads → Forces 

→ Input beban sebagaimana gambar di bawah → Apply → OK. 

 

Gambar 4.5. Assign → Joint Loads → Forces 

 

Gambar 4. 6. Beban Gempa pada Pangkal dan Ujung Portal Melintang Ujung (As 1 dan As 16) 
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Gambar 4.7. Input Beban Gempa Arah X untuk Portal Tepi 

Perhitungan Berat Seismik Efektif untuk Portal Tengah 

Luas bangunan yang ditinjau   = (90-6)*30 (Portal tengah saja) 

      = 2520  m^2 

Sudut atap, α     = 10  derajat 

Luas atap yang ditinjau   = Luas bangunan/Cos (α) 

      = 2520/Cos (10) 

      = 2558,9  m^2 

SIDL pada Atap    = 15  kg/m^2 

Total SIDL     = 15*2558,9 

      = 38383,1 kg 

Berat dinding + girt (long.)   = Luas*Beratdinding + girt*nsisi 

= (84*9*0,5*15)*2 

      = 11340  kg 

Panjang runway beam    = 84  m 

Berat total rel + M/E    = 70*84 

= 5880  kg 

Berat sendiri struktur untuk portal tengah = 98889,8 kg 

Berat crane     = 11805,1 kg 

Berat crane + hoist untuk 14 portal  = (14/16)*11805,1 

      = 10329,5 kg 

Berat seismik efektif, W = Dead Load + SIDL + Crane 

    = 98889,8 + (38383,1 + 11340 + 5880) + 10329,5 

    = 164822,4 kg 

Gaya geser dasar seismik arah transversal, Vx = CS*W  

       = 0,205*164822,4  

       = 33788,6 kg 

       = 337,9  kN 
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Jumlah portal yang ditinjau, nPortal   = 14 

Gaya geser dasar per portal, Vx   = 22,1 kN 

Beban lateral gempa diaplikasikan pada dua titik yaitu pada bagian pangkal portal dan pada 

bagian ujung portal (As A dan As D). 

Beban diaplikasikan pada 2 titik   = 24,1/2 kN 

       = 12,1 kN 

Gaya lateral akibat gempa pada arah y di-input pada top kolom dengan cara Select joint kolom 

sebagaimana gambar di bawah → Assign → Joint Loads → Forces → Input beban 

sebagaimana gambar di bawah → Apply → OK. 

 

Gambar 4.8.  Beban Gempa pada Pangkal dan Ujung Portal Melintang Tengah (As 2, 3, 4, 5, 6, 7, 

8, 9, 10, 11, 12, 13, dan 14) 

 

Gambar 4.9. Input Beban Gempa Arah X untuk Portal Tengah 
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Perhitungan Berat Seismik Efektif Arah Longitudinal 

Pada arah longitudinal beban yang diperhitungan adalah berat sendiri struktur secara 

keseluruhan, berat dinding secara keseluruhan, beban SIDL, serta beban crane. Perhitungan 

berat seismik efektif struktur ditampilkan sebagai berikut. 

Perhitungan Berat Seismik Efektif untuk Portal Arah Longitudinal 

Luas bangunan yang ditinjau   = 90*30  (Seluruh bangunan) 

       = 2700  m^2 

Sudut atap, α     = 10  derajat 

Luas atap yang ditinjau    = Luas bangunan/Cos (α) 

       = 2700/Cos (10) 

       = 2741,7  m^2 

SIDL pada Atap     = 15  kg/m^2 

Total SIDL     = 15*2741,7 

       = 41124,8 kg 

Berat dinding + girt (total)   = Luas*Beratdinding + girt*nsisi 

= 6052,5+11340,0 

= 17392,5 kg 

       = 5242,5  kg 

Panjang runway beam    = 90  m 

Berat total rel + M/E    = 70*90 

= 6300  kg 

Berat crane     = 11805,1 kg 

Berat sendiri struktur (keseluruhan)  = 111692,4 kg 

Berat seismik efektif, W = Dead Load + SIDL + Crane 

     = 111692,4 + (41124,8 + 17392,5 + 6300) + 11805,1 

     = 188314,7 kg 

Gaya geser dasar seismik arah long., Vy = CS*W  

       = 0,189* 188314,7 

       = 35591,5 kg 

       = 355,9  kN 

Jumlah portal yang ditinjau, nPortal  = 2 

Gaya geser dasar per portal, Vy   = 178,0  kN 

Beban lateral gempa diaplikasikan pada dua titik yaitu pada bagian pangkal portal dan pada 

bagian ujung portal (As 1 dan As 16). 

Beban diaplikasikan pada 2 titik  = 178,0/2  kN 

       = 89,0  kN 

Gaya lateral akibat gempa pada arah y di-input pada top kolom dengan cara Select joint kolom 

sebagaimana gambar di bawah → Assign → Joint Loads → Forces → Input beban sebagaimana 

gambar di bawah → Apply → OK. 

 

Gambar 4.10. Beban Gempa pada Pangkal dan Ujung Portal 
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Gambar 4.11. Input Beban Gempa Arah Y 

J. PENGECEKAN SIMPANGAN ANTAR TINGKAT 

Simpangan antar tingkat harus dicek berdasarkan pasa 7.12. SNI1726-2019. Batas 

simpangan antar tingkat sesuai dengan Tabel 20 SNI 1726-2019. Struktur yang didesain 

termasuk dalam KDS D, sehingga batasan simpangan antar tingkat harus dibagi dengan faktor 

redundansi yang diasumsikan sebesar 1.  

Tabel 4.4. 

Simpangan Antar Tingkat Izin Berdasarkan SNI 1726-2019 

 

Faktor pembesaran defleksi untuk masing-masing tipe struktur untuk arah tranversal dan 

longitudinal adalah sebagai berikut: 

Faktor pembesaran defleksi, Cd = 3, untuk portal arah transversal 

Faktor pembesaran defleksi, Cd = 3,25, untuk portal arah longitudinal 

Simpangan Inelastik untuk Portal Arah Transversal 

Berdasarkan hasil analisis struktur didapatkan bahwa akibat beban gempa arah x diperoleh 

simpangan elastik sebesar 9,603 mm. Simpangan tersebut perlu dicek terhadap batas izin yang 

berlaku berdasarkan SNI 1726-2019. Simpangan elastik tersebut perlu diamplifikasi dahulu 
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menjadi simpangan inelastik. Perhitungan simpangan inelastik antar tingkat dapat disajikan 

sebagai berikut: 

∆𝑥=  ∆𝑥𝑒 × (
𝐶𝑑

𝐼𝑒
) 

∆𝑥=  9,603 × (
3

1
) = 28,809 𝑚𝑚 

Deformasi pada ETABS, dapat dicek dengan melakukan running case terlebih dahulu dengan 

cara klik Analyze → Set Load Cases to Run → Run All → Run Now. Perilaku struktur setelah 

terkena beban gempa dapat dicek dengan cara klik Show Deformed Shape pada ribbon bagian 

atas → Atur case yang ingin ditampilkan → Atur perpindahan yang ingin ditampikan → Apply 

→ OK. 

 

Gambar 4.12. Analyze → Set Load Cases to Run 
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Gambar 4.13. Atur Perpindahan yang Ingin Ditampilkan 

 

Gambar 4.14. Simpangan Elastik Akibat Gempa Arah X 

Simpangan Inelastik untuk Portal Arah Longitudinal 

Berdasarkan hasil analisis struktur didapatkan bahwa akibat beban gempa arah y diperoleh 

simpangan elastik sebesar 1,537 mm. Simpangan tersebut perlu dicek terhadap batas izin yang 

berlaku berdasarkan SNI 1726-2019. Simpangan elastik tersebut perlu diamplifikasi dahulu 
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menjadi simpangan inelastik. Perhitungan simpangan inelastik antar tingkat dapat disajikan 

sebagai berikut: 

∆𝑦=  ∆𝑦𝑒 × (
𝐶𝑑

𝐼𝑒
) 

∆𝑦=  1,808 × (
3,25

1
) = 5,876 𝑚𝑚 

 

Gambar 4.15. Simpangan Elastik Akibat Gempa Arah Y 

Pengecekan Terhadap Simpangan Antar Tingkat Izin 

Simpangan antar tingkat yang sudah dihitung sebelumnya perlu dibandingkan dengan 

simpangan antar tingkat izin untuk memastikan bahwa struktur tidak mengalami simpangan 

antar tingkat yang berlebihan. Hasil pengecekan menunjukkan bahwa simpangan antar tingkat 

struktur masih di bawah batas yang diizinkan. 

Tabel 4.5. 

Pengecekan Terhadap Simpangan Antar Tingkat Izin 

 Δ (mm) 0,02hsx (mm) Cek 

Portal Arah Transversal 28,809 180 OK 

Portal Arah 

Longitudinal 
5,876 180 OK 

 

K. PENGECEKAN TERHADAP PENGARUH P-DELTA 

Pengaruh P-Delta pada struktur perlu diperhitungkan sesuai dengan Pasal 7.8.7. SNI 

1726-2019. Pengaruh P-Delta perlu dibandingkan terhadap nilai koefisien stabilitas (θ) yang 

dihitung berdasarkan Persamaan 45 SNI 1726-2019. Nilai koefisien stabilitas perlu dicek 

terhadap batasan koefisien stabilitas (θmax) yang dihitung berdasarkan Persamaan 46 SNI 1726-

2019 dan batasan pengaruh P-Delta sebesar 0,1.  

Perhitungan Koefisien Stabilitas Portal Arah Transversal 

Beban desain vertikal total, P  = 2377,9  kN 

Gaya geser seismik, Vx   = 337,9+ 48,2 

      = 386,0  kN 

Tinggi tingkat, hsx   = 9  m 

Faktor pembesaran defleksi, Cd  = 3 

Simpangan antar tingkat, ΔX  = 28,809  mm 

Koefisien stabilitas dihitung dengan persamaan sebagai berikut: 
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𝜃 =
𝑃𝑥 × ∆ × 𝐼𝑒

 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑
 

𝜃 =
2377,9 × 28,809 × 1

 386,0 × 9000 × 3
= 0,0066 

Perhitungan Koefisien Stabilitas Portal Arah Longitudinal 

Beban desain vertikal total, P  = 2377,9  kN 

Gaya geser seismik, Vy  = 355,9   kN 

Tinggi tingkat, hsx   = 9  m 

Faktor pembesaran defleksi, Cd = 3,25 

Simpangan antar tingkat, Δy  = 5,876  mm 

Koefisien stabilitas dihitung dengan persamaan sebagai berikut: 

𝜃 =
𝑃𝑥 × ∆ × 𝐼𝑒

 𝑉𝑥 × ℎ𝑠𝑥 × 𝐶𝑑
 

𝜃 =
2377,9 × 5,876 × 1

 355,9 × 9000 × 3,25
= 0,0013 

Perhitungan batasan koefisien stabilitas dapat dijabarkan sebagai berikut: 

Koefisien Stabilitas Maksimum untuk Portal Arah Transversal 

Rasio kebutuhan geser, β  =  1,0 

Faktor pembesaran defleksi, Cd =  3 

Batas koefisien stabilitas, θmax =  0,5/(β×Cd) < 0,25 

=  0,1667 

Koefisien Stabilitas Maksimum untuk Portal Arah Longitudinal 

Rasio kebutuhan geser, β  =  1,0 

Faktor pembesaran defleksi, Cd =  3,25 

Batas koefisien stabilitas, θmax =  0,5/(β×Cd) < 0,25 

=  0,1538 

Pengecekan Koefisien Stabilitas Terhadap Batas Izin 

Berdasarkan perhitungan di atas dapat dilihat bahwa nilai dari koefisien stabilitas pada tiap 

tingkat baik untuk arah-x maupun untuk arah-y masih memenuhi batasan nilai untuk koefisien 

stabilitas (θmax) dan nilai untuk batasan pengaruh P-Delta sebesar 0,1. Sehingga, dapat 

disimpulkan bahwa struktur tidak perlu memperhitungkan pengaruh dari P-Delta. 

Arah transversal 𝜃 = 0,0066 < 0,1667, 𝑂𝐾! 

Arah longitudinal 𝜃 = 0,0013 < 0,1538, 𝑂𝐾! 
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BAGIAN 

 

A. PERENCANAAN STRUKTUR CRANE 

Dalam perencanaan struktur runway beam crane, ketersediaan data crane menjadi 

sesuatu yang penting. Hal tersebut mencakup berat bridge crane, trolley dan hoist, serta 

kapasitas pengangkatan crane. Pada proyek ini, digunakan single girder crane tipe box steel 

girder dengan kapasitas pengangkatan 10 ton. 

Tabel 5.1. 

Data Single Girder Crane dengan Berbagai Bentang untuk SWL 10 t 

 

Pada proyek ini, digunakan single girder crane tipe box steel girder dengan kapasitas 

pengangkatan 10 ton. Berdasarkan informasi yang didapatkan dari vendor terkait, didapatkan 

beberapa data yang digunakan sebagai acuan desain sebagai berikut: 

Tipe crane yang digunakan      = Cab-operated 

Kapasitas crane, Plifted       = 100 kN 

Berat bridge crane, Pbridge      = 110 kN 

Berat trolley dan hoist, Pth      = 8,4 kN 

Reaksi maksimum roda (tanpa faktor impak) , Rmax   = 78 kN 

Berat rel, wrail        = 0,5 kN/m 

Berat mesin elektrikal dan clamp, wclamp + electrical   = 0,23 kN/m 

Bentang crane        = 30,0 m 

Bentang runway beam crane, Lsp     = 6,0 m 

5 
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Jarak antar roda, Swheel       = 2,0 m 

Faktor impak vertikal       = 25% 

Kelas Layanan Crane (CMMA)     = A 

Lendutan izin vertikal       = L/600 

Lendutan izin horizontal      = L/400 

Kuat lentur yang dibutuhkan runway beam crane didefinisikan menggunakan AISC 

Manual Tabel 3-23. 

 

Gambar 5.1. Kondisi Kritis untuk Bending Moment 

Jarak antar roda, a     = Swheel = 2,0 m 

Bentang runway beam crane, l   = Lsp = 6,0 m 

        0,586*l = 3,5 m 

Cek apakah a < 0,586l      = OK  

Momen maksimum pada runway beam crane  

𝑀𝑚𝑎𝑥 = (
𝑃

2 ∗ 𝑙
) ∗ (𝑙 − 0,5 ∗ 𝑎)2 = 2,1𝑃 𝑘𝑁𝑚 

Perhitungan defleksi akibat beban roda dilakukan menggunakan persamaan untuk 

simple beam sebagai berikut:  

 

Gambar 5.2. Kondisi Kritis untuk Defleksi 

Jarak dari tumpuan ke roda pertama, a  = (l-Swheel)/2 = 2,0 m 

Defleksi yang diizinkan pada runwah beam crane  

𝛥𝑚𝑎𝑥 = (
𝑃 ∗ 𝑎

24 ∗ 𝐸 ∗ 𝐼
) ∗ (3 ∗ 𝑙2 − 4 ∗ 𝑎2) =

38333,3𝑃

𝐼
𝑚𝑚 

Kelas layanan crane       = A, B, C 

a 
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B. KEBUTUHAN PROFIL BERDASARKAN DEFLEKSI VERTIKAL   

  

Bentang runway beam crane, L     = 6000 mm 

Defleksi vertikal maksimum yang dizinkan  = L/600 = 10 mm 

Inersia arah x yang dibutuhkan, Ixrequired  = 38333,4 P/Δmax 

        = 300188333,3 mm^4 

        = 30018,8 cm^4 

Digunakan profil untuk runway beam crane  = WF 500x200x10/16  

Inersia penampang yang digunakan, Ix   = 47800  cm^4 

Cek Ix > Ixrequired      = OK 

C. KEBUTUHAN PROFIL BERDASARKAN DEFLEKSI HORIZONTAL    

Beban lateral pada runway beam crane diambil sebesar 20% dari berat trolley dan hoist 

serta kapasitas angkat crane. Beban lateral disebar secara merata ke semua roda yang ada pada 

crane. Defleksi horizontal pada crane diasumsikan akan ditahan oleh backing truss dan akan 

dicek berdasarkan hasil analisis struktur melalui ETABS. 

D. PEMODELAN RUNWAY BEAM CRANE SECARA PARSIAL 

Runway beam dimodelkan secara parsial pada model terpisah dengan bentang 6 m dan 

tumpuan sendi-sendi. Berikut adalah tampilan dari runway beam yang dimodelkan secara 

parsial. 

 

Gambar 5.3. Model Runway Beam Parsial 

Setelah pemodelan runway beam selesai, perlu diaplikasikan beban yang terdiri dari 

berat sendiri crane, berat trolley dan hoist, kapasitas angkat crane, beban transversal, dan beban 

longitudinal. Beban diaplikasikan pada kondisi di mana beban dapat menghasilkan momen 

maksimum sebagaimana pada perhitungan di bawah. 

𝑥 =
𝐿

2
−

𝑠

4
= 2,5 𝑚 

Backing 
truss 
2L.50X50X5 

Ring beam 
penopang backing 
truss 
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Maka beban reaksi roda pertama diletakkan sejauh 2,5 m dari tumpuan. Sementara 

beban roda kedua diletakkan sejauh 4,5 m (x + jarak antar roda). Beban diaplikasikan sebagai 

beban point load yang dapat diaplikasikan dengan cara select frame yang akan diaplikasikan 

beban → Klik Assign → Frame Loads → Point → Aplikasikan beban sebagaimana gambar di 

bawah untuk masing-masing Load Pattern → Apply → OK. Adapun beban yang dimasukkan 

adalah sebagai berikut: 

Beban mati, Pdead  = (Pbridge/4+Pth/2) = 31,6 kN 

Beban hidup, Plive  = (Plifted/2)  = 50 kN 

Beban rel dan M/E, qdead     = 0,7 kN/m 

Beban transversal, Htransversal = 20%*((Plifted+Pth)/4) = 5,4 kN 

Beban long., Hlongitudinal  = 10%*(Pmax)  = 7,8 kN 

 

Gambar 5.4. Assign → Frame Load → Point 
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Gambar 5.5. Input Beban untuk Pdead 
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Gambar 5.6. Input Beban untuk qrel 
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Gambar 5.7. Input Beban untuk Plifted 

 

  



Perencanaan Struktur Bangunan Industri dengan Crane  163 

 

 

Gambar 5.8. Input Beban untuk Htransversal 
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Gambar 5.9. Input Beban untuk Hlongitudinal 

E. KOMBINASI BEBAN 

Faktor beban untuk analisis LRFD ditentukan berdasarkan rekomendasi dari Design Guide 7: 

Design Industrial Building, adalah sebagai berikut:    

Faktor beban untuk bridge crane    = 1,2 

Faktor beban untuk trolley and hoist    = 1,2 

Berat sendiri runway beam dan rel    = 1,2 

Lifted load       = 1,6 

Lateral thrust and longitudinal forces    = 1,6 

Untuk beban vertikal, beban perlu dikalikan lagi dengan faktor impak sebesar 25%. Atas 

dasar tersebut, kombinasi beban yang digunakan untuk mengecek kekuatan secara parsial 

adalah sebagai berikut: 

LRFD Crane – 1 = 1,2 Dead + (1,2*1,25) Crane Dead + (1,6*1,25) Crane Live 

LRFD Crane – 2 = 1,2 Dead + 1,6*Crane Lateral 

LRFD Crane – 3 = 1,2 Dead + 1,6*Crane Longitudinal 
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Struktur runway beam harus mampu menahan kombinasi beban-beban dari berbagai 

kondisi yang mungkin terjadi pada struktur yaitu kombinasi dari beban mati (dead load), beban 

hidup (live load), beban lateral, dan beban longitudinal. Langkah-langkah untuk membuat 

kombinasi beban adalah dengan cara klik Define → Load Combinations → Add New Combo 

→ Input kombinasi beban sebagaimana gambar di bawah → OK. 

 

Gambar 5.10. Kombinasi LRFD Crane - 1 

 

Gambar 5.11. Kombinasi LRFD Crane - 2 
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Gambar 5.12. Kombinasi LRFD Crane - 3 

F. DESAIN STRUKTUR RUNWAY BEAM 

Untuk melakukan desain struktur pada ETABS, lakukan running case terlebih dahulu 

dengan cara klik Analyze → Set Load Cases to Run → Run All → Run Now. 

 

Gambar 5.13. Run All Cases 

Atur Design Preferences untuk memilih standar yang akan digunakan dalam desain 

elemen struktur dengan cara klik Steel Frame Design pada ribbon bagian atas → View/Revise 

Preferences → Atur Design Preferences sebagaimana gambar di bawah. 



Perencanaan Struktur Bangunan Industri dengan Crane  167 

 

Gambar 5.14. Steel Frame Design → View/Revise Preferences 

 

Gambar 5.15. Design Preferences untuk Desain Elemen Struktur Runway Beam 

Atur kombinasi pembebanan yang akan digunakan dalam desain elemen struktur 

dengan cara klik Steel Frame Design pada ribbon bagian atas → Select Design Combinations 

→ Atur kombinasi pembebanan sebagaimana gambar di bawah. 
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Gambar 5.16. Kombinasi Pembebanan untuk Desain Elemen Struktur Runway Beam 

Setelah kombinasi pembebanan dan preferensi desain yang akan digunakan dalam 

desain elemen struktur diatur, lakukan desain dengan cara klik Steel Frame Design pada ribbon 

bagian atas → Start Check/Design. Cek stress ratio elemen struktur dengan cara klik Steel 

Frame Design → Display Design Info → Design Output → P-M Ratio Colors and Values. 

 

Gambar 5.17. Display Steel Frame Design Result untuk Elemen Struktur Runway Beam 

Dari hasil analisis diketahui bahwa stress ratio yang terjadi pada runway beam crane 

WF.500X200X10/16 adalah 0,699 < 1, OK. 
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Gambar 5.18. Stress Ratio Elemen Struktur Runway Beam 

G. PENGECEKAN LENDUTAN 

Lendutan akibat beban roda maksimum dan beban lateral perlu dicek terhadap batas 

yang diizinkan. Pengecekan terhadap lendutan dapat dilakukan dengan cara klik Show 

Deformed Shape pada ribbon bagian atas → Atur case yang ingin ditampilkan → Atur 

perpindahan yang ingin ditampikan → Apply → OK. Adapun kombinasi pembebanan yang 

digunakan untuk pengecekan lendutan vertikal dan horizontal adalah sebagai berikut: 

Kombinasi Service Vertikal = 1 Dead + 1 Crane Dead + 1 Crane Live 

Kombinasi Service Horizontal = 1 Crane Lateral 

 

Gambar 5.19. Kombinasi Pembeban untuk Lendutan Vertikal 
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Berdasarkan hasil analisis lendutan yang terjadi akibat beban roda maksimum adalah 

9,039 mm. Sementara lendutan horizontal yang terjadi akibat beban lateral adalah 0,263 mm. 

Lendutan yang terjadi perlu dicek terhadap batas yang diizinkan. Untuk lendutan vertikal, 

lendutan izin dibatasi pada L/600 untuk Kelas Layanan Crane A. Untuk lendutan horizontal, 

lendutan izin dibatasi pada L/400 untuk Kelas Layanan Crane A. 

Tabel 5.2. 

Pengecekan Terhadap Lendutan Izin 

 Δ (mm) 
δallowable 

(mm) 
Cek 

Lendutan Vertikal 9,039 10 OK 

Lendutan Horizontal 0,263 15 OK 

 

 

 

Gambar 5.20. Lendutan Vertikal Akibat Beban Roda Maksimum 

 

Gambar 5.21. Lendutan Horizontal Akibat Beban Lateral 
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H. DESAIN ELEMEN STRUKTUR RUNWAY BEAM DENGAN SNI 1729-2020 

Peraturan desain struktur baja di Indonesia mengacu pada SNI 1729-2020 yang 

merupakan adopsi identik dari AISC 360-16. Berikut ini disajikan perhitungan struktur runway 

beam yang mengacu pada SNI 1729-2020. 

Pengecekan pada Tension Flange Akibat Beban Terkombinasi 

Data awal runway beam crane diketahui sebagai berikut:     

Digunakan profil untuk runway beam crane  = WF 500x200x10/16  

Mutu baja, fy      = 240 MPa 

Tinggi profil, H      = 500 mm 

Lebar sayap, bf      = 200 mm 

Tebal sayap, tf      = 16 mm 

Tebal badan, tw      = 10 mm 

Luas profil, A      = 130,3 cm^2 

        = 13026 mm^2 

Momen inersia x, Ix     = 47800 cm^4 

Momen inersia y, Iy     = 2140 cm^4 

Radius girasi x, rx     = 19,2 cm 

Radius girasi y, ry     = 4,1 cm 

Modulus penampang elastis x, Sx   = 1910  cm^3 

        = 1910000 mm^3 

Modulus penampang elastis y, Sy   = 214  cm^3 

        = 214000 mm^3 

Modulus elastisitas, E     = 200000 MPa 

Tinggi bersih, h      = 468 mm 

Jarak antar titik berat sayap, ho    = 484 mm 

Tinggi bersih, h'      = 468 mm 

Cw       = 1253269600000 mm^6 

Pengecekan Rasio Tebal Terhadap Lebar Sayap 

𝜆𝑓 =
0,5 ∗ 𝑏𝑓

𝑡𝑓
= 6,3 

𝜆𝑟 = 1,0√
𝐸

𝑓𝑦
= 28,9 

𝜆𝑝 = 0,38√
𝐸

𝑓𝑦
= 11,0 

Karena λf < λp, maka sayap termasuk ke dalam penampang kompak. 

Pengecekan Rasio Tebal Terhadap Lebar Badan 

𝜆𝑤 =
ℎ

𝑡𝑤
= 46,8 

𝜆𝑟 = 5,70√
𝐸

𝑓𝑦
= 164,5 
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𝜆𝑝 = 3,76√
𝐸

𝑓𝑦
= 108,5 

Karena λw < λp, maka badan profil termasuk ke dalam kategori kompak. 

λf < λp dan λw < λp, dapat disimpulkan bahwa WF.500X200X10/16 merupakan profil kompak 

sehingga pasal F2 berlaku. 

Pengecekan Panjang Lp 

𝐿𝑝 = 1,76 ∗ 𝑟𝑦 ∗ √
𝐸

𝑓𝑦
= 2059,3 𝑚𝑚 

Pengecekan Panjang Lr 

𝐶𝑤 =
(ℎ𝑜)2 ∗ 𝑏𝑓

3 ∗ 𝑡

24
= 1253269600000 𝑚𝑚6 

 

𝐽 =
2 ∗ 𝑏𝑓 ∗ 𝑡3 + ℎ𝑜 ∗ 𝑡𝑤

3

3
= 707466,7 𝑚𝑚4 

𝑟𝑡𝑠 =  √
√𝐼𝑦 ∗ 𝐶𝑤

𝑆𝑥
= 52,1 𝑚𝑚 

c = 1 (Profil I simetris ganda) 

𝐿𝑟 = 1,95 ∗  𝑟𝑡𝑠 ∗
𝐸

0,7 ∗ 𝑓𝑦

√
𝐽 ∗ 𝑐

𝑆𝑥 ∗ ℎ𝑜
+ √(

𝐽 ∗ 𝑐

𝑆𝑥 ∗ ℎ𝑜
)

2

+ 6,76 (
0,7 ∗ 𝑓𝑦

𝐸
)

2

 = 6708,0 𝑚𝑚 

Perhitungan Kuat Lentur Pelelehan (Momen Plastis) 

Kapasitas momen plastis dapat dihitung berdasarkan persamaan sebagai berikut: 

Modulus penampang plastis, Zx = 2096360 mm^3 

Sehingga, 

𝑀𝑛 = 𝑀𝑝 = 𝑓𝑦 ∗ 𝑍𝑥 

𝑀𝑛 = 503126400 𝑁𝑚𝑚 = 503,1 𝑘𝑁𝑚 

Ø𝑀𝑛 = 452,8 𝑘𝑁𝑚 

Perhitungan Kuat Lentur Tekuk Torsi Lateral 

Lb (Panjang tidak diperkaku)  =  500  mm 

Lp     =  2059,3  mm 

Lr     =  6708,0  mm 

Karena Lb < Lp, maka termasuk bentang pendek sehingga kuat lentur tekuk torsi lateral dapat 

diabaikan. 

Pengecekan Stress Ratio Akibat Kombinasi LRFD Crane – 1 

Momen akibat beban terkombinasi, Mrx = 315,9 kNm 

𝑀𝑟𝑥

Ø𝑀𝑛𝑥 
+

𝑀𝑟𝑦

Ø𝑀𝑛𝑦 
=

315,9

452,8
+ 0 = 0,698 < 1, 𝑂𝐾! 

Berdasarkan hasil perhitungan, diperoleh nilai stress ratio yang relatif sama dengan hasil 

desain melalui ETABS. 
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Pengecekan pada Compression Flange Akibat Beban Terkombinasi 

Pengecekan Rasio Tebal Terhadap Lebar Sayap 

𝜆𝑓 =
0,5 ∗ 𝑏𝑓

𝑡𝑓
= 6,3 

𝜆𝑟 = 1,0√
𝐸

𝑓𝑦
= 28,9 

𝜆𝑝 = 0,38√
𝐸

𝑓𝑦
= 11,0 

Karena λf < λp, maka sayap termasuk ke dalam penampang kompak. Maka yang dihitung 

cukup momen plastis saja. 

Perhitungan Kuat Lentur Pelelehan (Momen Plastis) 

Kapasitas momen plastis dapat dihitung berdasarkan persamaan sebagai berikut: 

Modulus penampang plastis, Zy = 1356500 mm^3 

Sehingga, 

𝑀𝑛 = 𝑀𝑝 = 𝑓𝑦 ∗ 𝑍𝑦 ≤ 1,6 ∗ 𝑓𝑦 ∗ 𝑆𝑦 

𝑀𝑛 = 𝑀𝑝 = 325560000 𝑁𝑚𝑚 ≤ 82176000 𝑁𝑚𝑚 

𝑀𝑛 = 82176000 𝑁𝑚𝑚 = 82,2 𝑘𝑁𝑚 

Ø𝑀𝑛 = 73,95 𝑘𝑁𝑚 

Pengecekan Stress Ratio Akibat Kombinasi LRFD Crane – 2 

Momen akibat beban terkombinasi, Mrx = 5,1 kNm 

Momen akibat beban terkombinasi, Mry = 0,96 kNm 

𝑀𝑟𝑥

Ø𝑀𝑛𝑥 
+

𝑀𝑟𝑦

Ø𝑀𝑛𝑦 
=

5,1

452,8
+

0,96

73,95
= 0,024 < 1, 𝑂𝐾! 

Berdasarkan hasil perhitungan, diperoleh nilai stress ratio yang relatif sama dengan hasil 

desain melalui ETABS. 

Pengecekan Web Sidesway Buckling 

Gaya-gaya terpusat akibat beban terpusat crane sangat rawan untuk menimbulkan web 

sidesway buckling pada profil. Maka pengecekan untuk web sidesway buckling menjadi 

penting untuk mengantisipasi buckling pada web. Hal tersebut dilakukan pada perhitungan 

sebagai berikut: 

Data Teknis         

Profil yang digunakan    = WF 500x200x10/16  

Tinggi balok, H    = 500 mm 

Lebar flange, bf    = 200 mm 

Tebal flange, tf    = 16 mm 

Tebal web, tw     = 10 mm 

Fillet radius, r     = 20 mm 

Tinggi bersih pelat badan, hw   = H-2*tf-2*r  

= 428 mm 

Unbraced length, Lb    = 0,5 m 

Yield strength, Fy    = 240 MPa 

 



174        Perencanaan Struktur Bangunan Industri dengan Crane 

Jika sayap tekan ditahan melawan rotasi:       

Rasio tinggi bersih dan tebal web  = hw/tw = 42,8 

Rasio bentar tak terkekang dan lebar flange = Lb/bf = 2,5 

Cek      = (hw/tw)/(Lb/bf)  

= 17,120  

Kesimpulan, (hw/tw)/(Lb/bf) <= 2,3  = Tidak perlu dicek   

Berdasarkan hasil perhitungan, web sidesway buckling pada profil runway beam tidak 

perlu dicek. Adanya backing truss yang menopang top flange sekaligus sebagai pengaku lateral 

maka pengaruh web sidesway buckling dapat diantisipasi. Ini menunjukkan besarnya pengaruh 

backing truss sebagai pengaku lateral runway beam crane sekaligus untuk menjaga runway 

beam crane dari web sidesway buckling. 

 

Gambar 5.22. Ilustrasi Web Sidesway Buckling pada Profil Penampang 

I. DESAIN FATIK UNTUK RUNWAY BEAM 

Analisis terhadap fatik perlu dilakukan mengingat crane bergerak secara siklik dan 

dapat mengakibatkan tegangan lokal yang cukup kritis pada bagian-bagian tertentu dari 

komponen runway crane. Fisher. et. al. (2003) merekomendasikan panduan dalam melakukan 

desain fatik untuk runway beam. Beberapa item yang perlu dicek terhadap fatik untuk 

komponen runway beam antara lain adalah sebagai berikut: 

- Tegangan pada Tension Flange 

Untuk runway beam yang didesain dari pelat girder yang disusun menjadi suatu profil 

tertentu, kebutuhan akan fatik menjadi lebih tinggi. Untuk profil dari pelat girder kategori 

tegangan B pada Pasal 1 Tabel A-3.1. SNI 1729-2020 bisa digunakan. Sementara untuk 

profil gilas panas, kategori tegangan A pada pada Pasal 1 Tabel A-3.1. SNI 1729-2020 bisa 

digunakan. 

- Web to Flange Welds 

Untuk profil yang disusun dari pelat girder, crack rawan terjadi pada las antara web dengan 

flange. Penggunaan full penetration welds direkomendasikan untuk menghubungkan antara 

web dan flange untuk profil yang disusun dari pelat girder. Untuk las, kategori tegangan F 

pada pada Pasal 8.2. Tabel A-3.1. SNI 1729-2020 bisa digunakan. 

- Tiebacks 

Tiebacks disediakan di ujung girder di tiap bentang untuk mentransfer gaya lateral dari top 

flange ke kolom. Ketentuan fatik untuk tiebacks dapat bervariasi tergantung tipe tiebacks 

yang digunakan untuk menopang struktur runway beam. 
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- Bearing Stiffeners 

Pengaku tumpu diberikan dibagian ujung runway beam yang dibuat dari profil pelat girder. 

Crack akibat fatik dapat terjadi saatu bearing stiffener dilas fillet ke bawah top flange. Setiap 

beban roda crane dapat menyebabkan tegangan geser pada fillet welds dan perlu dicek 

terhadap beban fatik. 

- Intermediate Stiffeners 

Meski runway beam dominan terjadi lentur, apabila stiffener digunakan, pengecekan 

terhadap potensi fatik perlu dilakukan. Fatik perlu dicek pada posisi dimana stiffener 

bersinggungan dengan tension flange. 

- Channel Caps dan Cap Plates 

Profil channel atau cap plates biasa digunakan sebagai perkuatan pada bagian top flange dari 

runway beam. Perkuatan di bagian top flange runway beam dapat memberikan stablitas torsi 

lateral yang baik. Tegangan geser pada las antara profil perkuatan dengan runway beam 

ditentukan berdasarkan Pasal 8.2 SNI 1729-2020.  

- Pelat Cap pada Kolom Crane 

Untuk crane kelas berat yang didesain dengan beban ekstra, kolom tambahan dibutuhkan 

sebagai penopang runway beam. Pelat cap di bagian atas kolom tersebut perlu dicek terhadap 

fatik. Pembautan antara runway beam dengan cap plate harus bisa mengakomodir gaya 

longitudinal dari crane. 

- Laced Crane Girders atau Backing truss 

Untuk crane dengan beban lateral yang besar, backing truss sebagai perkuatan bagian top 

flange dari gaya lateral diperlukan. Sistem backing truss dapat didesain dengan berbagai 

macam profil utamanya profil siku. Pengecekan terhadap fatik perlu disesuaikan dengan 

sistem backing truss yang digunakan dan sesuai dengan SNI 1729-2020. 

- Tambatan Rel 

Rel yang ditambatkan pada runway beam perlu didesain terhadap potensi fatik. Untuk rel 

yang ditambatkan dengan las pada bagian top flange runway beam, tambatan rel perlu dicek 

berdasarkan Pasal 7.1. SNI 1729-2020. 

Pengecekan Tegangan Lentur pada Tension Flange 

Hanya momen akibat beban hidup yang digunakan untuk menentukan tegangan lentur. 

Momen akibat beban live load, Mlive    = 104,2 kNm 

        = 104200000 Nmm 

Tahanan momen profil, Sx     = 1910000 mm^3 

Tegangan lentur, fbx  = Mlive/Sx  = 54,6  MPa 

Konstanta Cf diambil dari kategori fatik B Pasal 1 Tabel A.3-1 SNI 1729-2020. 

Konstanta, Cf       = 25  

Klasifikasi crane      = A 

Jumlah fluktuasi rentang tegangan pada umur desain, nSR = 20000 

Ambang batas maksimum, Fth    = 165 MPa 

Design stress range, Fsr     = 6900*(
𝐶𝑓

𝑛𝑆𝑅
)

0,333

≥ 𝐹𝑡ℎ 

= 165 MPa 

Cek, Fsr > fbx       = OK! 
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Pengecekan pada Stiffener         

Momen akibat beban live load, Mlive    = 104,2  kNm 

        = 104200000 Nmm 

Jarak dari ujung stiffener ke garis netral, c   = 184  mm 

Inersia penampang, Ix      = 478000000 mm^4 

Tegangan lentur, fbx   = Mlive*c/Ix = 40,1 MPa 

Konstanta, Cf       = 44  

Klasifikasi crane      = A  

Jumlah fluktuasi rentang tegangan pada umur desain, nSR = 20000 

Ambang batas maksimum, Fth    = 165 MPa 

Design stress range, Fsr     = (
𝐶𝑓

𝑛𝑆𝑅
)

0,333

≥ 𝐹𝑡ℎ 

= 165 MPa 

Cek, Fsr > fbx       = OK! 

Pengecekan pada Top Flange Rail Clips 

Fatik yang terjadi pada top flange diakibatkan oleh tegangan akibat beban lateral. Beban 

vertikal akibat beban roda maksimum selalu mengakibatkan tegangan tekan pada bagian top 

flange. Retak fatik tidak terjadi pada daerah dengan tegangan tekan sehingga kombinasi beban 

antara beban minimum roda dan beban lateral maksimum akan diaplikasikan untuk mengecek 

adanya potensi fatik di bagian top flange. Kombinasi beban ini memungkinkan terjadinya 

tegangan tarik pada bagian top flange.  

Beban roda minimum, Pmin     = 26,5 kNm 

Beban roda minimum + impak, Pmin    = 31,9 kNm 

Momen arah x akibat beban roda maksimum     

+ 50% beban lateral, Mx     = 66,5 kNm 

Momen arah y akibat beban roda maksimum     

+ 50% beban lateral (50%), My/2    = 0,15 kNm 

Tahanan momen profil, Sx     = 1910000 mm^3 

Tegangan lentur sumbu kuat, fbx = Mx/Sx  = 34,8 MPa 

Jarak bagian belakang rail clip dengan top flange, c  = 133,4 mm 

Inersia sumbu lemah, Iy     = 21400000,0 mm^4 

Tegangan lentur sumbu kuat, fby = My*c/Iy = 0,9 MPa 

Cek   fbx > fby    = OK 

Tegangan pada sumbu kuat lebih besar daripada tegangan pada sumbu lemah sehingga 

tegangan lentur lebih mungkin terjadi pada tension flange tidak pada top flange. Pengecekan 

tegangan lentur pada tension flange sudah dilakukan dan tegangan lentur yang terjadi masih 

di bawah ambang batas maksimum yang disyaratkan. 

J. DETAIL RUNWAY BEAM 

Sesuai dengan perhitungan di atas, runway beam didesain dengan WF.500X200X11/16 

dengan backing truss siku ganda 2L.50X50X5. Sambungan antara backing truss, runway beam 

dan supporting beam didesain dengan gusset plate. Detail sambungan dapat dilihat pada gambar 

berikut. 
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Gambar 5.23. Detail Runway Beam 

K. DESAIN KOLOM YANG MENDUKUNG BEBAN CRANE 

Kolom yang mendukung beban crane harus didesain cukup kuat menahan beban yang 

ada. Terlebih beban crane merupakan beban yang akan menimbulkan momen eksentris karena 

tidak bekerja pada titik berat kolom. Beban crane memiliki beban gravitasi yang besar sehingga 

kombinasi pembebanan dengan tinjauan utama beban mati dan beban hidup akan menentukan. 

Satu portal bangunan akan ditinjau kekuatannya dengan melakukan Save As dari model yang 

telah dibuat sebelumnya. Hal tersebut dapat dilakukan dengan cara klik File → Save As → Beri 

nama baru dan letakkan pada folder yang diinginkan. 

 

Gambar 5.24. Beban Mati Akibat Crane pada Bracket 
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Sisakan satu portal rangka dan hapus portal yang lain sebagaimana gambar di bawah. 

Aplikasikan beban crane, beban angkat crane, serta berat sendiri runway beam di atas ujung 

bracket. Untuk pembebanan akibat beban crane disajikan pada perhitungan di bawah. Adapun 

berat sendiri runway serta backing truss diambil dari reaksi runway beam yang telah 

dimodelkan secara parsial sebagaimana gambar di bawah. Reaksi tersebut akan dimasukkan 

juga sebagai beban pada kolom untuk memberikan hasil yang konservatif saat desain kolom. 

 

Gambar 5.25. Portal yang Ditinjau 

 

 

Gambar 5.26. Berat Sendiri Runway Beam dan Backing Truss 

Kapasitas crane, Plifted      = 100 kN 

Berat bridge crane, Pbridge     = 110 kN 

Berat trolley dan hoist, Pth     = 8,4 kN 

Berat rel + M/E, qrail+M/E     = 0,7 kN/m 

Beban terpusat rel + M/E, Prail+M/E = 0,5*q*Lsp = 2,1 kN 

Bentang runway beam crane, Lsp    = 6,0 m 

Faktor impak    = 25%   
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Asumsi beban maksimum akibat beban crane di kolom bagian kiri.   

Beban pada bagian kiri kolom portal:      

Kapasitas crane, Plifted/2     = 50 kN + 

Diaplikasikan beban crane live + 25% beban impak, Plive = 62,5 kN 

 

Berat bridge crane, Pbridge/4     = 27,4 kN 

Berat trolley dan hoist, Pth/2     = 4,2 kN 

Beban terpusat rel + M/E, Prail+M/E    = 2,1 kN + 

Diaplikasikan beban crane dead +25% beban impak, Pdead = 42,1 kN  

 

Beban pada bagian kanan kolom portal: 

Kapasitas crane, Plifted/2     = 0 kN + 

Diaplikasikan beban crane live + 25% beban impak, Plive = 62,5 kN 

 

Berat bridge crane, Pbridge/4     = 27,4 kN 

Berat trolley dan hoist, Pth/2     = 0 kN 

Beban terpusat rel + M/E, Prail+M/E    = 2,1 kN + 

Diaplikasikan beban crane dead +25% beban impak, Pdead = 36,9 kN 

 

Beban-beban lain yang dipertimbangkan: 

Reaksi diujung runway beam     = 2,8 kN 

Reaksi diujung ring beam penunjang backing truss  = 1,3 kN 

Gaya lateral pada masing-masing kolom, H   = 5,4 kN 

Berat sendiri ring beam di top kolom (WF.300X150X6,5/9) = 1,1 kN 

 

Gambar 5.27. Berat Sendiri Runway Beam, Backing Truss, dan Ring Beam 

Berat sendiri ring 
beam 
WF.300X150X6,5/9 

Berat sendiri 
runway beam + 
backing truss 
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Gambar 5.28. Beban Mati Akibat Crane pada Bracket 

 

Gambar 5.29. Beban Hidup Akibat Crane pada Bracket 

 

Gambar 5.30. Beban Lateral pada Kolom Portal 

Kombinasi pembebanan yang digunakan: 

LRFD 1-1 = 1,4 Dead + 1,4 Pdead(crane) 

LRFD 2-1 = 1,2 Dead + 1,2 Pdead(crane) + 1,6 Plive(crane) + 1,6 Hcrane + 0,5 Lr 

LRFD 2-2 = 1,2 Dead + 1,2 Pdead(crane) + 1,6 Plive(crane) + 1,6 Hcrane + 0,5 R 
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Struktur yang sudah dimodelkan perlu di-run terlebih dahulu sebelum dilakukan desain. 

Running case untuk desain struktur portal dapat dilakukan dengan cara yang sama dengan 

desain untuk struktur runway sebelumnya. Atur kombinasi pembebanan yang akan digunakan 

dalam desain elemen struktur dengan cara klik Steel Frame Design pada ribbon bagian atas → 

Select Design Combinations → Atur kombinasi pembebanan sebagaimana gambar di bawah. 

 

Gambar 5.31. Kombinasi Pembebanan untuk Desain Elemen Struktur Portal Akibat Beban Crane 

Desain struktur portal yang menopang beban crane dapat dilakukan dengan cara yang 

sama dengan desain struktur runway beam. Dari hasil analisis diketahui bahwa stress ratio yang 

terjadi pada elemen kolom portal yang ditinjau akibat beban crane 0,497 < 1, OK. 

 

Gambar 5.32. Stress Ratio Kolom Portal 0,497 < 1, OK! 

Pengaruh beban crane terhadap bangunan secara keseluruhan sangat perlu untuk dicek. 

Beban crane dapat menghasilkan gaya paling kritis apabila roda pertama terletak tepat pada 

titik kolom. Karena beban crane merupakan beban bergerak (moving load), maka titik kritis 

beban crane pada bangunan perlu ditinjau dengan sekian skenario. Titik kritis tersebut tentu 

sangat ditentukan oleh konfigurasi bangunan. Beban crane yang terdiri dari beban vertikal, 
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transversal, dan longitudinal akan menghasilkan efek yang sangat signifikan terhadap 

bangunan.  

 

Gambar 5.33. Kemungkinan Titik Kritis Beban Crane Terhadap Kolom 

(Sumber: Design Guide 7 AISC: Industrial Building Design, 2019) 

Dari sekian skenario pembebanan crane pada bangunan yang didesain, lokasi paling 

kritis untuk portal rangka bangunan yang didesain terjadi saat roda pertama beban crane berada 

pada As 5. Akibat kombinasi pembebanan vertikal, transversal dan longitudinal crane, serta 

tambahan beban mati, dan beban hidup atap, stress ratio yang terjadi pada kolom 

WF.600X200X11/17 adalah 0,97 < 1, OK! 

 

Gambar 5.34. Pembebanan Crane pada Portal 3d 
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Gambar 5.35. Stress Ratio Kolom yang Mendukung Beban Crane Kondisi Model 3d 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Stress ratio 
kolom 0,97 

< 1, OK! 
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BAGIAN  

 

A. KOMBINASI PEMBEBANAN YANG DIGUNAKAN 

Oleh karena bangunan industri yang didesain juga memiliki crane, maka beban-beban 

akibat berat sendiri crane, kapasitas angkat crane, dan beban-beban terkait akan dimasukkan 

ke kombinasi pembebanan sesuai SNI 1727-2020. Berat sendiri crane (termasuk dengan hoist) 

didefinisikan sebagai Cds. Kapasitas angkat crane termasuk sebagai beban hidup dan 

didefinisikan sebagai Cvs. Gaya lateral crane didefinisikan sebagai Css.  Sementara gaya 

longitudinal crane didefinisikan sebagai Cls. Dengan Sds = 0,614488 dan faktor redudansi = 1, 

maka kombinasi beban yang digunakan adalah sebagai berikut: 

Tabel 6.1. 

Kombinasi Pembebanan yang Digunakan 

Nomor DL SIDL Cds Cvs Css Cls LL Lr R Wx(+) Wx(-) Wy(+) Wy(-) Ex Ey 

1 1,1 1,4 1,4 1,4                         

2 
2,1 1,2 1,2 1,2 1,6 1,6 1,6 1,6 0,5               

2,2 1,2 1,2 1,2 1,6 1,6 1,6 1,6   0,5             

3 

3,1 1,2 1,2 1,2 1 1 1 1 1,6               

3,2-1 1,2 1,2 1,2 1 1 1   1,6   0,5           

3,2-2 1,2 1,2 1,2 1 1 1   1,6     0,5         

3,3-1 1,2 1,2 1,2 1 1 1   1,6       0,5       

3,3-2 1,2 1,2 1,2 1 1 1   1,6         0,5     

3,4-1 1,2 1,2 1,2 1 1 1   1,6   0,38   0,38       

3,4-2 1,2 1,2 1,2 1 1 1   1,6     0,38   0,38     

3,5 1,2 1,2 1,2 1 1 1 1   1,6             

3,6-1 1,2 1,2 1,2 1 1 1     1,6 0,5           

3,6-2 1,2 1,2 1,2 1 1 1     1,6   0,5         

3,7-1 1,2 1,2 1,2 1 1 1     1,6     0,5       

3,7-2 1,2 1,2 1,2 1 1 1     1,6       0,5     

3,8-1 1,2 1,2 1,2 1 1 1     1,6 0,38   0,38       

3,8-2 1,2 1,2 1,2 1 1 1     1,6   0,38   0,38     

4 

4,1-1 1,2 1,2 1,2 1 1 1 1 0,5   1           

4,1-2 1,2 1,2 1,2 1 1 1 1 0,5     1         

4,2-2 1,2 1,2 1,2 1 1 1 1 0,5       1       

4,2-3 1,2 1,2 1,2 1 1 1 1 0,5         1     

4,5-1 1,2 1,2 1,2 1 1 1 1 0,5   0,75   0,75       

6 
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Nomor DL SIDL Cds Cvs Css Cls LL Lr R Wx(+) Wx(-) Wy(+) Wy(-) Ex Ey 

4,5-2 1,2 1,2 1,2 1 1 1 1 0,5     0,75   0,75     

4,3-1 1,2 1,2 1,2 1 1 1 1   0,5 1           

4,3-2 1,2 1,2 1,2 1 1 1 1   0,5   1         

4,4-1 1,2 1,2 1,2 1 1 1 1   0,5     1       

4,4-1 1,2 1,2 1,2 1 1 1 1   0,5       1     

4,6-1 1,2 1,2 1,2 1 1 1 1   0,5 0,75   0,75       

4,6-2 1,2 1,2 1,2 1 1 1 1   0,5   0,75   0,75     

5 

5,1-1 0,9 0,9               1           

5,1-2                     1         

5,2-1 0,9 0,9                   1       

5,2-2                         1     

5,3-1 0,9 0,9               0,75   0,75       

5,3-2                     0,75   0,75     

6  

6,1 1,32 1,32 1,32 
   

1 
      

1 0,3 

6,2 1,32 1,32 1,32 
   

1 
      

1 -0,3 

6,3 1,32 1,32 1,32 
   

1 
      

-1 0,3 

6,4 1,32 1,32 1,32 
   

1 
      

-1 -0,3 

6,5 1,32 1,32 1,32 
   

1 
      

0,3 1 

6,6 1,32 1,32 1,32 
   

1 
      

-0,3 1 

6,7 1,32 1,32 1,32 
   

1 
      

0,3 -1 

6,8 1,32 1,32 1,32 
   

1 
      

-0,3 -1 

7  

7,1 0,78 0,78 0,78 
          

1 0,3 

7,2 0,78 0,78 0,78 
          

1 -0,3 

7,3 0,78 0,78 0,78 
          

-1 0,3 

7,4 0,78 0,78 0,78 
          

-1 -0,3 

7,5 0,78 0,78 0,78 
          

0,3 1 

7,6 0,78 0,78 0,78 
          

-0,3 1 

7,7 0,78 0,78 0,78 
          

0,3 -1 

7,8 0,78 0,78 0,78 
          

-0,3 -1 

Di mana: 

Keterangan: 

DL =  Beban mati 

SIDL = Beban mati tambahan 

LL =  Beban hidup 

Lr =  Beban hidup atap 

R =  Beban hujan 

Wx(+) =  Beban angin arah x dengan Gcpi(+) 

Wx(-) =  Beban angin arah x dengan Gcpi(-) 

Wy(+) =  Beban angin arah ydengan Gcpi(+) 

Wy(-) =  Beban angin arah y dengan Gcpi(-) 

Ex =  Beban gempa arah x 

Ey =  Beban gempa arah y 

Cds = Beban mati akibat bridge crane dan trolley + hoist 

Cvs = Beban angkat crane 

Css = Beban lateral akibat beban crane 

Css = Beban longitudinal akibat beban crane 
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B. STRESS RATIO STRUKTUR 

1. Desain Elemen Struktur Rafter, Kolom dan Purlin 

Struktur perlu didesain aman terhadap beban terkombinasi yang telah 

diaplikasikan. Di awal, elemen struktur yang akan didesain adalah elemen rafter, purlin, 

dan kolom. Elemen X-bracing tidak didesain secara linear karena hanya dapat menahan 

tarik (tension-only brace). Analisis untuk desain X-bracing akan dilakukan di tahap 

selanjutnya. Berdasarkan hasil analisis didapatkan bahwa stress ratio struktur adalah 

sebagai berikut: 

 

Gambar 6.1. Stress Ratio Purlin > 1, NOT OK! 

Didapatkan bahwa beberapa elemen purlin dan rafter masih memiliki stress ratio 

> 1. Untuk elemen purlin, stress ratio yang masih di atas 1 terjadi karena panjang tak 

terbreising yang masih belum diatur. Setiap elemen purlin akan dipasang sag rod dengan 

jarak 1,2 m sehingga lebar tak terbreising dari elemen purlin tidaklah 6 m tapi menjadi 1,2 

m (1/5 dari bentang asli). Untuk mengatur panjang tak terbreising dari purlin dapat 

dilakukan dengan cara Select semua elemen purlin → Klik Steel Frame Design di ribbon 

bagian atas → View/Revise Overwrites → Atur parameter Unbraced Length Ratio (Minor) 

dan Unbraced Length Ratio (LTB) menjadi 0,2 (1/5 dari bentang asli) → OK. 

 

Gambar 6.2. Steel Frame Design → View/Revise Overwrites 
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Gambar 6.3. Atur LTB Sesuai Panjang Bentang Tak Terbreising 

Pasca panjang tak terbreising dari purlin CNP.150X50X20X2,3 diatur, lakukan 

desain elemen struktur kembali. Hasil desain elemen struktur menunjukkan bahwa setelah 

panjang tak terbreising dari purlin diatur, stress ratio purlin menjadi < 1, OK! 

 

Gambar 6.4. Stress Ratio Elemen Portal Utama < 1, OK 
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Bagian tumpuan dari rafter seringkali memiliki momen negatif yang lebih besar 

dibandingkan dengan posisi lain. Seringkali rafter mengalami kegagalan pada bagian 

tersebut. Di lapangan, rafter dipasang dengan tambahan eaves haunch dan apex haunch. 

Pemodelan haunch dapat meningkatkan modulus penampang plastis (Zx) dan dapat 

meningkatkan kapasitas momen mayor dari rafter. 

 

Gambar 6.5. Stress Ratio di Tumpuan Sebelum Pemodelan Haunch = 0,754 

Elemen haunch di pangkal rafter dapat dilakukan dengan opsi pemodelan 

Nonprismatic Section saat penentuan penampang profil. Elemen haunch ditentukan 

sebagai berikut: 

Tinggi haunch  = 1,5XWF.450X200X9/14 (Profil original dari HC) 

    =  1,5X450 

    = 225 mm 

Tinggi total haunch  = 675 + 225 

    = 900 mm 

Panjang haunch  = 2XWF.450X200X9/14 

= 900 mm 

Panjang total rafter  = 15232 mm 

Panjang haunch  = 0,06 ~ 6% dari panjang total rafter 

Panjang bersih rafter = 100% - 2*6% dari panjang total rafter 

    = 848% dari panjang total rafter HC.675X200X9/14 

Maka akan dipasang haunch dengan panjang 900 mm dan tinggi 900 mm di pangkal 

pertemuan rafter dengan kolom dan rafter dengan rafter. Hal yang terlebih dahulu perlu 

dilakukan adalah mendefinisikan penampang modifikasi untuk haunch pada rafter yaitu 

profil HC.900X200X9/14. Properti penampang HC.900X200X9/14 terlampir sebagaimana 

gambar di bawah. 
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Gambar 6.6. Profil Haunch HC.900X200X9/14 

Setelah properti haunch dapat didefinisikan, lakukan pemodelan penampang 

nonprismatis guna menggabungkan haunch dan rafter biasa. Modelkan penampang 

nonprismatis dengan cara klik Add New Property → Nonprismatic Section → Atur 

penampang nonprismatis rafter + voute sebagaimana gambar di bawah → OK. 

 

Gambar 6.7. Penampang HC.675X200X9/14 + Voute Di Pangkal Rafter 
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Gantikan semua penampang rafter HC.675X200X9/14 dengan properti rafter 

HC.675X200X9/14 yang telah dimodifikasi dengan tambahan haunch. Hal tersebut dapat 

dilakukan dengan cara Select elemen rafter WF.450X200X9/14 → Assign → Section 

Property → WF.450X200X9/14 + Voute. Maka penampang rafter dengan tambahan hauch 

di tumpuan dan di bagian tengah sudah berhasil dimodelkan. 

 

Gambar 6.8. Model Portal dengan WF.450X200X9/14 + Voute 

Setelah haunch tersebut berhasil dimodelkan, lakukan desain ulang terhadap rafter 

yang baru saja di-assign. Berdasarkan hasil terjadi peningkatan kapasitas momen plastis 

pada rafter, dan stress ratio berkurang menjad 0,625. 

 

Gambar 6.9. Stress Ratio Rafter HC.675X200X9/14 Menjadi Lebih Kecil = 0,625 

Pada proyek ini, purlin dimodelkan sebagai tambatan lateral untuk rafter. Dengan 

profil HC.675X200X9/14 yang cukup tinggi, maka dibutuhkan tambahan fly brace dari 

profil siku L.50X50X5. Detail purlin sebagai tambatan lateral bagi HC.675X200X9/14 

dapat dilihat sebagaimana gambar berikut. 
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Gambar 6.10. Detail Fly Brace 

2. Desain Elemen Struktur X-bracing 

X-bracing yang didesain hanya untuk menahan gaya tarik memiliki kapasitas aksial 

tekan yang sangat kecil sehingga didesain hanya untuk menahan gaya aksial tarik. Desain 

untuk X-bracing yang didesain untuk menahan gaya aksial tarik saja, perlu dilakukan 

secara nonlinear. Untuk memudahkan proses analisis, pemodelan dan desain X-bracing 

melalui model terpisah dari analisis dan desain elemen struktur lain sangat 

direkomendasikan. Pada kasus ini, model ETABS disimpan ulang terlebih dahulu. 

Sebelum melakukan analisis dan desain, hal yang perlu lebih dulu dilakukan adalah 

meniadakan kapasitas tekan dari X-bracing yang dimodelkan. Hal tersebut dapat dilakukan 

dengan cara select semua X-bracing 2L.70X70X7 dan Rod 25 yang ada pada arah 

longitudinal bangunan dan pada atap → Assign → Frame Tension/Compression Limits → 

Set kapasitas aksial tekan = 0 kN → OK. 
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Gambar 6.11. Pengaturan Compression Limit pada X-bracing 

Setelah kapasitas tekan dari X-bracing ditiadakan, maka kombinasi pembebanan 

linear yang sudah didefinisikan sebelumnya perlu dikonversikan menjadi nonlinear case. 

Hal tersebut dapat dilakukan dengan cara Define → Load Combination → Pilih kombinasi 

LRFD yang akan dikonversikan menjadi Nonlinear Case → OK!  

 

Gambar 6.12. Convert Combinations to Nonlinear Cases 

Semua kombinasi yang dikonversi menjadi nonlinear cases dapat dicek pada 

Define → Load Cases. Kombinasi beban akan terkonversi menjadi Nonlinear Static Case 

dengan faktor kombinasi LRFD yang sama dengan apa yang didefinisikan pada analisis 

nonlinear. Selain itu semua kombinasi yang sudah dikonversi, secara default akan langsung 

dikonversi menjadi kombinasi beban dengan Load Case Nonlinear sebagaimana hasil 

konversi dari kombinasi beban sebelumnya.   
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Gambar 6.13. Kombinasi yang Telah Dikonversi Menjadi Nonlinear Static Case 

 

Gambar 6.14. Kombinasi Beban dengan Nonlinear Load Case 
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Analisis nonlinear akan memakan waktu sedikit lebih lama dibanding analisis 

linear. Elemen X-bracing yang sebelumnya ikut mengalami beban aksial tekan, pasca 

analisis nonlinear akan mengalami beban aksial tarik saja. Hal tersebut bisa dilihat pada 

gambar di bawah yang menggambarkan perbedaan X-bracing pada kondisi linear dan 

nonlinear. 

 

 

Gambar 6.15. Perbandingan Gaya Aksial pada X-bracing 

Berdasarkan hasil analisis dan desain struktur didapatkan bahwa stress ratio pada 

X-bracing 2L.70X70X7 dan Rod 25 mm < 1, OK! 

 

 

 

 

 

Gaya aksial 
tekan akibat 
LRFD 1-1 
Linear 

Gaya aksial 
tekan = 0 kN 
akibat LRFD 
1-1 Nonlinear 
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Gambar 6.16. Stress Ratio X-bracing < 1, OK! 

C. DESAIN SAMBUNGAN 

Subbab ini menjelaskan beberapa tahapan dalam desain sambungan melalui software 

IdeaStatica. Terdapat tiga sambungan yang akan dijadikan contoh desain yaitu sambungan 

rafter dengan kolom, sambungan rafter dengan rafter, serta sambungan pelat dasar. Analisis 

dan desain sambungan mengacu pada SNI 1729-2020 yang merupakan adopsi identik dari 

AISC 360-16. 

1. Desain Sambungan Rafter dengan Kolom 

Sambungan antara rafter dengan kolom biasa disebut dengan eaves haunch. 

Sambungan tersebut akan didesain melalui IdeaStatica. Secara default sambungan antara 

rafter dengan kolom sudah tersedia di IdeaStatica namun perlu disesuaikan dengan dimensi 

profil, kebutuhan alat sambung dan alat bantu sambung. Pertama, buatlah sambungan 

antara rafter dan kolom sesuai dengan templat yang sudah disediakan IdeaStatica. 

 

Gambar 6.17. Templat Sambungan Rafter dengan Kolom 
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Properti kolom perlu diganti menjadi WF.600X200X11/17. Hal tersebut dilakukan 

dengan cara klik elemen C di bawah opsi Members di bagian kanan → Add New → Pilih 

profil dari H (Japan) karena profil di Indonesia mengadopsi dari profil JIS → 

H600X200X11 ~ (WF.600X200X11/17) → OK!  

 

Gambar 6.18. Tambahkan Profil Baru untuk Mendefinisikan WF.600X200X11/17 

 

Gambar 6. 19.  Pilih H.600X200X11 → WF.600X200X11/17 untuk Sebagai Kolom pada yang 

Akan Terhubung dengan Rafter 

Setelah properti kolom berhasil didefinisikan, lakukan hal yang sama terhadap 

rafter. Profil HC.675X200X9/14 perlu didefinisikan terlebih dahulu. Klik menu Materials 

pada ribbon bagian atas → Klik Cross Section untuk membuat penampang baru → Pilih I 

Sections sebagaimana pada gambar di bawah → Atur properti HC.675X200X9X14 

sebagaimana gambar di bawah. 
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Gambar 6.20. Tambahkan Profil Baru 

 

 

Gambar 6.21. Properti Penampang HC.675X200X9/14 

Setelah properti rafter HC.675X200X9/14 berhasil didefinisikan, ganti profil rafter 

eksisting dengan profil yang baru saja dibuat. 
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Gambar 6.22. Properti Penampang HC.675X200X9/14 

Secara default bagian cap plate didesain sebagai stiffener dengan kode operasi 

STIFF1. Properti STIFF1 perlu disesuaikan. Atur properti STIFF1 sesuai dengan gambar 

di bawah. 

 

Gambar 6.23. Properti STIFF1 

Utamanya, hubungan antara rafter HC.675X200X9/14 dan kolom 

WF.600X200X11/17 disambung dengan adanya end plate. Sambungan end plate juga 

didesain dengan tambahan haunch yang didefinisikan dengan operasi Widener. Properti 

end plate perlu dimodifikasi sedemikian rupa baik untuk ketebalan pelat, jumlah dan 

dimensi baut, serta ketebalan las. Jarak minimum antar baut ditetapkan sebesar 3d, 

sementara jarak tepi diatur dengan jarak 1,5*d. Properti EP1 dapat didefinisikan 

sebagaimana gambar di bawah. 
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Gambar 6.24. Properti EP1 

Haunch dapat didefinisikan dengan operasi ‘Widener.’ Haunch menghubungkan 

antara rafter dengan end plate. Ketebalan badan dari haunch sama dengan tebal badan dari 

profil rafter, begitu juga dengan ketebalan sayap dari haunch yang didesain sama tebal 

dengan sayap profil rafter. Properti WID1 dapat didefinisikan sesuai gambar di bawah. 

 

Gambar 6.25. Properti WD1 

Selanjutnya, atur properti pelat pengaku yang memberikan perkuatan tambahan di 

sayap bawah rafter. Pelat pengaku didefinisikan sebagai STIFF2. Properti pelat pengaku 

STIFF2 dapat didefinisikan sebagaimana gambar di bawah. 
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Gambar 6.26. Properti STIFF2 

Selanjutnya, atur properti pelat pengaku di bagian rafter yang dipasang di akhir 

haunch. Pelat pengaku tersebut didefinisikan sebagai STIFF3. Properti pelat pengaku 

STIFF3 dapat didefinisikan sebagaimana gambar di bawah. 

  

Gambar 6.27. Properti STIFF3 

Operasi Cut Member digunakan untuk memotong member kolom. Operasi Cut 

Member didefinisikan dengan kode CUT1. Properti CUT1 dapat dilihat pada gambar 

sebagaimana di bawah. 

 

Gambar 6.28. Properti CUT1 

Di akhir, beban perlu ditambahkan untuk menganalisis kekuatan dari sambungan 

eaves haunch yang telah didesain. Klik kanan pada Load Effects → New Load → Klik LE1 

di bawah menu Load Effects → Atur beban sebagaimana gambar di bawah. 
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Gambar 6.29. Pengaturan Beban untuk Desain Eaves haunch 

Desain dapat dilakukan dengan cara klik Calculate pada ribbon bagian atas. 

Seluruh elemen sambungan akan dicek baik elemen yang disambung, alat bantu sambung 

maupun alat penyambung. Hasil pengecekan menunjukkan bahwa sambungan yang 

didesain masih kuat untuk menahan beban struktur yang ada.  

 

Gambar 6.30. Hasil Analisis Sambungan Eaves Haunch 
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Gambar 6.31. Detail Sambungan Eaves Haunch 

2. Desain Sambungan Rafter dengan Rafter 

Hubungan antara rafter dengan rafter biasa disebut dengan apex haunch. 

Sambungan apex haunch akan didesain menggunakan IdeaStatica. Buat proyek sambungan 

baru dengan cara klik New → Pilih Blank. Setelah proyek baru berhasil dibuat profil baru 

dengan cara klik kanan pada opsi Members → New Member. Member yang baru dibuat 

tidak memiliki profil HC.675X200X9/14, maka profil tersebut perlu diatur terlebih dahulu. 

 

Gambar 6.32. Buat New Property → Pilih Blank 
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Gambar 6.33. Pembuatan Member Baru 

Klik menu Materials pada ribbon bagian atas → Klik Cross Section untuk membuat 

penampang baru → Pilih I Sections sebagaimana pada gambar di bawah → Atur properti 

HC.675X200X9X14 sebagaimana gambar di bawah. 

 

Gambar 6.34. Tambahkan Profil Baru 
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Gambar 6.35. Properti Penampang HC.675X200X9/14 

Setelah properti rafter HC.675X200X9/14 berhasil didefinisikan, ganti profil rafter 

eksisting dengan profil yang baru saja dibuat.  

 

Gambar 6.36. Properti Rafter HC.675X200X9/14 

Gandakan rafter yang telah dimodelkan dengan cara klik kanan pada M1 di bawah 

menu Members → Copy. 
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Gambar 6.37. Gandakan Rafter Pertama 

Atur properti rafter kedua sebagaimana gambar di bawah. 

 

Gambar 6.38. Properti Rafter Kedua 

Kedua rafter yang bertemu perlu dihubungkan dengan double end plate. Untuk 

menyambungkan antara kedua rafter tersebut, klik kanan pada Operations → pilih Plate 

to Plate.  
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Gambar 6.39. Plate to Plate untuk Menghubungkan Kedua Rafter 

Properti double end plate perlu diatur baik dari ketebalan pelat, jumlah baut serta 

dimensi pelat. Klik PP1 → Atur properti Plate to Plate sebagaimana gambar dibawah. 

 

Gambar 6.40. Properti Plate to Plate 

Tambahkan haunch di bagian bawah rafter dengan operasi Widener. Properti 

haunch: panjang haunch, kedalaman haunch, dan jumlah baut perlu diatur sebagaimana 

gambar di bawah.  
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Gambar 6. 41. Widener untuk Membentuk Haunch pada Pertemuan Rafter 

 

Gambar 6.42. Properti Haunch Bagian Kanan 

Di bagian ujung dari haunch perlu ditambahkan pelat pengaku. Hal tersebut dapat 

dilakukan dengan cara klik kanan pada Operations → Pilih Stiffener → Atur properti 

sebagaimana gambar di bawah.  
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Gambar 6.43. Stiffener Sebagai Tambahan Pelat Di Ujung Haunch 

 

Gambar 6.44. Properti Stiffener Bagian Kanan 
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Apex haunch yang sudah termodel pada satu sisi dapat digandakan pada sisi yang 

lain. Widener dapat digandakan dengan cara klik kanan pada WID1 → Copy. Setelah 

widener berhasil diganakan, atur properti WID2 sebagaimana gambar di bawah. 

 

Gambar 6.45. Properti Haunch Bagian Kiri 

Stiffener di bagian kanan rafter yang sudah termodel perlu digandakan pada sisi 

yang lain. Stiffener dapat digandakan dengan cara klik kanan pada STIFF1 → Copy. 

Setelah stiffener berhasil diganakan, atur properti STIFF2 sebagaimana gambar di bawah. 

 

Gambar 6.46. Properti Stiffener Bagian Kiri 

Terakhir, beban perlu ditambahkan untuk menganalisis kekuatan dari sambungan 

aped haunch yang telah didesain. Klik kanan pada Load Effects → New Load → Klik LE1 

di bawah menu Load Effects → Atur beban sebagaimana gambar di bawah. 
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Gambar 6.47. Beban untuk Desain Apex Haunch 

Analisis dan desain apex haunch dapat dilakukan dengan cara klik Calculate pada 

ribbon bagian atas. Seluruh elemen sambungan akan dicek baik elemen yang disambung, 

alat bantu sambung maupun alat penyambung. Hasil pengecekan menunjukkan bahwa 

sambungan yang didesain masih cukup kuat untuk menahan beban struktur yang ada. 

 

Gambar 6.48. Hasil Analisis Apex Haunch 

 
Gambar 6.49. Detail Sambungan Apex Haunch 
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3. Desain Sambungan Base Plate 

Sambungan antara kolom dengan rafter akan didesain melalui IdeaStatica. Langkah 

pertama dalam pemodelan sambungan adalah buat model berdasarkan template sambungan 

yang disediakan oleh IdeaStatica. Base plate didesain untuk menahan momen sehingga tipe 

yang digunakan adalah sambungan momen. 

 

Gambar 6.50. Base Plate dengan Tipe Sambungan Momen  

Sambungan antara kolom dengan rafter akan didesain melalui IdeaStatica. Langkah 

pertama dalam pemodelan sambungan adalah buat model berdasarkan template sambungan 

yang disediakan oleh IdeaStatica. Base plate didesain untuk menahan momen sehingga tipe 

yang digunakan adalah sambungan momen. Ubah dimensi profil kolom menjadi 

WF.600X200X11/17 dengan cara Select kolom → Add New → Pilih profil dari H (Japan) 

karena profil di Indonesia mengadopsi dari profil JIS → H600X200X11/17 ~ 

(WF.600X200X11/17) → OK!  

 

Gambar 6.51. Tambahkan Profil Baru untuk Mendefinisikan WF.600X200X11/17 
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Gambar 6.52.  Pilih H.600X200X11 → WF.600X200X11/17 untuk Sebagai Kolom pada  

Pelat Dasar  

Adapun dimensi pelat rib, angkur, dan elemen pendukung lain terlebih dahulu 

ditentukan sebagai berikut: 

Mutu angkur A307, fy  = 240 MPa 

Mutu beton, fc'   = 25 MPa 

Dimensi kolom pedestal  = K600X800 

Panjang angkur   = 400 mm 

Jumlah angkur    = 10M25 

Tebal pelat dasar   = 19 mm 

Tebal pelat rib   = 17 mm 

Atur mutu material untuk beton dengan cara klik Materials pada ribbon bagian atas 

→ Buat mutu beton baru → Edit mutu beton dengan properti sebagaimana di bawah. 
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Gambar 6.53. Pengaturan Mutu Beton K-300 

Setelah mutu material beton berhasil didefinisikan, properti pelat dasar: dimensi 

dan tebal pelat, ukuran dan kedalaman angkur, serta dimensi kolom perlu diatur. Klik BP1 

di bawah menu Operations terlebih dahulu → Atur properti pelat dasar sebagaimana 

gambar di bawah. 

  

Gambar 6.54. Pengaturan Properti Pelat Dasar 

Tambahkan 
material beton 

baru 

Atur properti 
material beton 

baru 
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Setelah itu, properti pelat pengaku seperti ketebalan pelat dan dimensinya, juga 

perlu untuk diatur. Klik WID1 di bawah menu Operations → Atur properti pelat pengaku 

sebagaimana gambar di bawah. 

 

Gambar 6.55. Pengaturan Properti Pelat Pengaku 

Untuk memperkuat sambungan antara kolom WF.600X200X11/17, perlu 

ditambahkan pelat rib yang menempel pada bagian badan kolom. Hal tersebut dapat 

dilakukan dengan cara klik kanan pada menu Operations → New Operation → Pilih Rib 

→ Atur properti RIB1 sebagaimana gambar di bawah. 

 

 

Gambar 6.56. Tambahkan Operasi Baru 
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Gambar 6.57. Pilih Rib 

 

 

Gambar 6.58. Pengaturan Properti Pelat Rib 
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Angkur lain perlu ditambahkan di perimeter kolom baja. Hal tersebut dapat 

dilakukan dengan cara klik kanan pada menu Operations → New Operation → Pilih Bolt 

or Grid Contact → Atur properti angkur tambahan sebagaimana gambar di bawah. 

 

Gambar 6.59. Pengaturan Properti Angkur Tambahan 

Terakhir, beban perlu ditambahkan untuk menganalisis kekuatan dari sambungan 

yang telah didesain. Klik LE1 di bawah menu Load Effects → Atur beban sebagaimana 

gambar di bawah. 

 

Gambar 6.60. Beban untuk Desain Pelat Dasar 

Beton di bawah pelat dasar diasumsikan tidak didesain untuk menahan tarik dan 

geser. Tahanan tarik dan geser akan ditugaskan pada ekstra tulangan yang akan 

ditambahkan pada tulangan pedestal. Untuk mengatur hal tersebut klik Code Setup di 

ribbon bagian atas → Concrete breakout resitance → None. 

 

Gambar 6.61. Pengaturan Concrete Breakout Resistance 
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Lakukan desain pelat dasar klik Calculate pada ribbon bagian atas. Seluruh 

elemen sambungan akan dicek baik elemen yang disambung, alat bantu sambung 

maupun alat penyambung. Hasil pengecekan menunjukkan bahwa sambungan yang 

didesain masih cukup kuat untuk menahan beban struktur yang ada. 

 

Gambar 6.62. Hasil Analisis Pelat Dasar 
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Gambar 6.63. Detail Base Plate 

D. PENGECEKAN KEMAMPULAYANAN STRUKTUR 

Lendutan yang terjadi pada struktur yang menopang atap harus dianalisis terhadap 

lendutan izin didasarkan pada Tabel 1 pada Design Guide 3: Serviceability Design for Steel 

Building yang mengadopsi IBC Tabel 1604.4. Pengecekan lendutan diperlukan untuk 

memastikan bahwa deformasi yang terjadi tidak menyebabkan kerusakan struktural maupun 

non struktural. Umumnya terdapat dua kondisi lendutan yang ditinjau yaitu lendutan akibat 

beban tetap dan lendutan akibat beban tambahan. Pengecekan lendutan untuk struktur yang 

ditinjau disajikan sebagaimana berikut: 

1. Lendutan pada Atap Akibat Lr       

Bentang yang diperhitungkan, L   = 30000 mm 

L/360, Δall     = 83,3 mm 

Lendutan seketika maksimum, Δmax  = 55,7 mm 

Cek, Δmax < Δall   = OK 

 

Gambar 6.64. Lendutan Akibat Beban Hidup Atap 
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2. Lendutan pada Atap Akibat Beban Layan (Beban Mati + Lr)    

Bentang yang diperhitungkan, L   = 30000 mm 

L/240, Δall      = 125 mm 

Lendutan seketika maksimumm, Δmax  = 89,7 mm 

Cek, Δmax < Δall   = OK 

 

Gambar 6.65. Lendutan Akibat Beban Layan (Beban Mati + Lr)  

3. Lendutan pada Atap Akibat Beban Angin (Beban Mati + 0,5Wx(+))   

Bentang yang diperhitungkan, H   = 9000 mm 

H/500, Δall      = 45 mm 

Lendutan yang terjadi, Δmax   = 5,4 mm 

Cek, Δmax < Δall   = OK 

 

Gambar 6.66. Lendutan Akibat Beban Angin Wx(+)  

4. Lendutan pada Atap Akibat Beban Angin (Beban Mati + 0,5Wx(-))   

Bentang yang diperhitungkan, H   = 9000 mm 

H/200, Δall      = 45 mm 

Lendutan yang terjadi, Δmax   = 4,96 mm 

Cek, Δmax < Δall   = OK 
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Gambar 6. 67. Lendutan Akibat Beban Angin Wx(-)  

5. Lendutan pada Atap Akibat Beban Angin (Beban Mati + 0,5Wy(+))   

Bentang yang diperhitungkan, H   = 9000 mm 

H/200, Δall      = 45 mm 

Lendutan yang terjadi, Δmax   = 17,8 mm 

Cek, Δmax < Δall   = OK 

 

Gambar 6.68. Lendutan Akibat Beban Angin Wy(-)  

6. Lendutan pada Atap Akibat Beban Angin (Beban Mati + 0,5Wy(-))   

Bentang yang diperhitungkan, H   = 9000 mm 

H/200, Δall      = 45 mm 

Lendutan yang terjadi, Δmax   = 20,7 mm 

Cek, Δmax < Δall   = OK 

 

Gambar 6.69. Lendutan Akibat Beban Angin Wy(-)  
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